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Bio-Rad avdeling for teknisk støtte
Bio-Rad-avdelingen for teknisk støtte i USA er åpen mandag til fredag fra kl. 05:00 til kl. 17:00, Pacific
Time.

Telefon: +1-800-424-6723, valg 2

E-post: Support@bio-rad.com (kun USA/Canada)

For teknisk assistanse utenfor USA og Canada kontakter du den lokale leverandøren av teknisk støtte
eller klikker på lenken Contact us (Kontakt oss) på www.bio-rad.com.

For teknisk assistanse kontakter du din lokale Bio-Rad-representant.
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Radpåtar seg intet ansvar for feil eller utelatelser, eller for eventuelle skader som følge av
applikasjonen eller bruken av denne informasjonen.

BIO-RAD er et varemerke for Bio-Rad Laboratories, Inc.

BIO-RAD, HARD-SHELL, og MICROSEAL er varemerker for Bio-Rad Laboratories, Inc. i visse
jurisdiksjoner.

SYBR er et varemerke for Thermo Fisher Scientific Inc. Bio-Rad Laboratories, Inc. er lisensiert til å
selge reagenser som inneholder SYBR Green I for bruk i sanntids PCR, kun for forskningsformål.

EvaGreen er et varemerke for Biotium, Inc. Bio-Rad Laboratories, Inc. er lisensiert av Biotium, Inc. til å
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Alle varemerker som brukes her er eiendommen til deres respektive eier.
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Tiltenkt bruk

Tiltenkt bruk
CFX96 Dx-systemet og CFX96 DeepWell Dx-systemet med CFX Manager Dx-programvaren er
beregnet på å utføre fluorescensbasert PCR for å påvise og kvantifisere nukleinsyresekvenser.
Systemene og programvaren er beregnet på in vitro-diagnostisk bruk av opplærte
laboratorieteknikere. Systemene er beregnet på bruk med tredjeparts diagnostiske nukleinsyretester
som har blitt produsert og merket til diagnostiske formål.

Symbolleksikon
Betydelige endringer er fremhevet!

Produsent Lottnummer

Bruk innen For in vitro diagnostisk bruk

Temperaturgrense Katalognummer

Se bruksanvisningen Antall tester

For use with Serial number

Kun reseptbelagt bruk Inneholder lateks
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CEMarking - Regulation
(EU) 2017/746 IVDR

Oversettelser
Produktdokumenter kan leveres på flere språk på elektroniske medier.
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Sikkerhet og overholdelse av krav
For å sikre trygg bruk av CFX96™Dx-systemet eller CFX96 DeepWell Dx-systemet med CFX
Manager™ Dx-programvaren, kalt CFX Dx-systemet i dette dokumentet, anbefaler Bio-Rad sterkt at du
følger sikkerhetsspesifikasjonene som er oppført i denne delen og i resten av håndboken.

Viktig: CFX96 Dx- og CFX96 DeepWell Dx-systemene er godkjent for bruk som in vitro-
diagnostisk (IVD) medisinsk utstyr.

Sikkerhetsmessige advarselsetiketter
Advarselsetiketter på instrumentet og i denne håndboken advarer deg om kilder til personskade eller
skade på utstyr. Tabell 1 gir en beskrivelse av hver sikkerhetsmessige advarselsetikett.

Ikon Betydning

Advarsel om risiko for skade på kropp eller utstyr
Bruk av CFX Dx-systemet før du har lest denne håndboken kan utgjøre en fare for
personskade. For å sikre trygg bruk må du ikke betjene dette instrumentet på en
måte som ikke er beskrevet i denne håndboken. Kun kvalifisert laboratoriepersonell
som har fått opplæring i trygg bruk av elektrisk utstyr, skal betjene dette
instrumentet. Du må alltid håndtere alle komponenter i systemet på en forsiktig måte
og med rene, tørre hender.

Advarsel om håndtering av smittefarlige biologiske materialer
Ved håndtering av smittefarlige biologiske prøver må du følge anbefalte
forholdsregler og retningslinjer og overholde lokale forskrifter og regler ved
laboratoriet.

Advarsel om risiko for brannskade
En termosykler genererer nok varme til å forårsake alvorlig brannskade. Bruk alltid
vernebriller eller annen øyebeskyttelse når du betjener instrumentet. Sørg alltid for
at prøveblokken har nådd hviletemperatur før du åpner lokket og fjerner prøver.
Sørg alltid for å opprettholde maksimal klaring for å unngå at du brenner deg.

Tabell 1. Betydning av sikkerhetsmessige advarselsetiketter
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Sikkerhet og overholdelse av krav

Ikon Betydning

Advarsel om risiko for eksplosjon
Prøveblokkene kan under normal drift bli så varme at de kan få væsker til å koke og
eksplodere.

Tabell 1. Betydning av sikkerhetsmessige advarselsetiketter, forts.

Spesifikasjoner og krav for trygg bruk
Tabell 2 inneholder en liste over spesifikasjoner om sikker bruk for Bio-Rads CFX Dx-systemer for
PCR-deteksjon i sanntid. De skjermede kablene som følger med, må brukes sammen med disse
instrumentene for å sikre overholdelse av FCC-grensene for klasse A.

Bruksaspekt Betingelser for sikker bruk

Inngangsstrøm 100–240 VAC, 50–60 Hz, 850 Wmaks.

Overspenningskategori II

Sikringer 10 A, 250 V, 5 x 20 mm, hurtig (antall 2)

Miljø Kun til innendørs bruk

Driftstemperatur 15–31 °C

Oppbevaringstemperatur –20 til 60 °C

Relativ luftfuktighet Opptil 80 % (ikke-kondenserende)

Høyde over havet Opptil 2 000 meter over havet

Forurensningsgrad 2

Tabell 2. Betingelser for sikker bruk

Overholdelse av krav
CFX Dx-systemet for PCR-deteksjon i sanntid er blitt testet og funnet å være i overensstemmelse med
alle gjeldende krav i følgende sikkerhetsmessige og elektromagnetiske standarder:

n IEC 61010-1:2010 (3. utgave), EN61010-1:2010 (3. utgave). Elektrisk utstyr til måling, kontroll og
laboratoriebruk – Del 1: Generelle krav
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Farer

n IEC 61010-2-010:2014, EN 61010-2-010:2014. Sikkerhetskrav for elektrisk utstyr til måling,
kontroll og laboratoriebruk. Del 2-010: Bestemte krav for laboratorieutstyr til oppvarming av
materialer

n IEC 61010-2-081:2015, EN 61010-2-081:2015. Sikkerhetskrav for elektrisk utstyr til måling,
kontroll og laboratoriebruk. Del 2-081: Bestemte krav for automatisk og semiautomatisk
laboratorieutstyr til analysering og andre formål (inklusive endring 1)

n IEC 61010-2-101:2015 (2. utgave). Sikkerhetskrav for elektrisk utstyr til måling, kontroll og
laboratoriebruk. Bestemte krav for medisinsk utstyr til in vitro-diagnostikk (IVD)

n IEC 61326-1:2012 (klasse A), EN 61326-1:2013 (klasse A). Elektrisk utstyr til måling, kontroll og
laboratoriebruk. EMC-krav, del 1: Generelle krav

n IEC 61326-2-6:2012, EN 61326-2-6:2013 (klasse A). Elektrisk utstyr til måling, kontroll og
laboratoriebruk. EMC-krav. Bestemte krav for medisinsk utstyr til in vitro-diagnostikk (IVD)

Viktig: Dette utstyret genererer, bruker og kan utstråle radiofrekvensenergi og kan, hvis det ikke
installeres og brukes i henhold til instruksjonene i medfølgende dokumentasjon, forårsake
skadelig interferens for radiokommunikasjon. Det er sannsynlig at bruk av systemene i et
boligområde kan forårsake skadelig interferens. I så fall må brukere korrigere interferensen for
egen regning.

Farer
CFX Dx-systemet for PCR-påvisning i sanntid er konstruert for sikker drift når utstyret brukes som
foreskrevet av produsenten. Hvis CFX Dx-systemet for PCR-påvisning i sanntid eller tilknyttede
komponenter brukes på andre måter enn foreskrevet av produsenten, kan de innebygde
sikkerhetsanordningene i instrumentet svikte. Bio-Rad Laboratories, Inc. er ikke ansvarlig for
personskader eller andre skader forårsaket av bruk av dette utstyret på en måte som ikke er
beskrevet, eller av modifikasjoner av instrumentet som ikke er utført av Bio-Rad eller en autorisert
representant. Service på CFX Dx-systemet for PCR-påvisning i sanntid skal kun utføres av kvalifisert
personell fra Bio-Rad.

Biologiske farer
CFX Dx PCR-påvisningsystemet i sanntid er et laboratorieprodukt. Hvis smittefarlige biologiske prøver
er til stede, må du imidlertid følge retningslinjene nedenfor og overholde lokale forskrifter og regler ved
laboratoriet.

Merknad: Det genereres ingen smittefarlige biologiske stoffer under normal drift av dette
instrumentet.
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Sikkerhet og overholdelse av krav

Generelle forholdsregler

n Bruk alltid laboratoriefrakk, laboratoriehansker og vernebriller med sideskjerming.

n Hold hendene unna munn, nese og øyne.

n Eventuelle kutt eller skrubbsår må dekkes fullstendig før håndtering av potensielt smittefarlige
materialer.

n Vask hendene grundig med såpe og vann etter håndtering av potensielt smittefarlige materialer,
før du forlater laboratoriet.

n Ta av armbåndsur og smykker før arbeid ved benken.

n Oppbevar alle smittefarlige eller potensielt smittefarlige materialer i uknuselige, lekkasjesikre
beholdere.

n Ta av verneklær før du forlater laboratoriet.

n Mens du har hansker på, må du ikke skrive, ta telefonen, slå på lyset eller berøre noen ting som
andre kan berøre uten hansker.

n Bytt hansker ofte. Ta av hanskene umiddelbart når de blir synlig kontaminert.

n Materialer som ikke kan dekontamineres på riktig vis, må ikke utsettes for potensielt smittefarlige
materialer.

n Ved fullførelse av en operasjon som involverer biologisk farlig materiale, må arbeidsområdet
dekontamineres med et egnet desinfeksjonsmiddel (for eksempel en 1:10-fortynning av
husholdningsklor).

Særskilte IVD-forholdsregler

n Alle pasientprøver er potensielt smittefarlige og skal håndteres deretter i henhold til allment
anerkjente forholdsregler.

n Det genereres ingen smittefarlige biologiske stoffer under normal drift av dette instrumentet.
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Farer

Dekontaminering av overflater

ADVARSEL: For å unngå elektrisk støt skal instrumentet alltid slås av og kontakten
trekkes ut før du utfører dekontaminering.

Følgende områder kan rengjøres med bakterie-, virus- og soppdrepende desinfiseringsmidler:

n Utvendig lokk og kabinett

n Reaksjonsblokkens innvendige overflater og brønner i reaksjonsblokken

n Kontrollpanel og skjerm

Se anvisningene fra produsenten for instruksjoner om preparering og bruk av desinfiseringsmiddelet.
Reaksjonsblokken og brønnene i reaksjonsblokken skal alltid skylles med vann flere ganger etter bruk
av desinfiseringsmiddel. Tørk reaksjonsblokken og brønnene i reaksjonsblokken grundig etter skylling
med vann.

Viktig: Ikke bruk skurende eller etsende rengjøringsmidler eller sterke alkaliske løsninger. Disse
midlene kan ripe overflatene og skade reaksjonsblokken, noe som fører til tap av presis termisk
kontroll.

Kassering av biologisk farlig materiale

Kasser følgende potensielt kontaminerte materialer i henhold til lokale, regionale og nasjonale
forskrifter for laboratorier:

n Kliniske prøver

n Reagenser

n Brukte reaksjonsbeholdere eller andre forbruksartikler som kan være kontaminert

Kjemiske farer
CFX Dx-systemet for PCR-deteksjon i sanntid inneholder ingen potensielt farlige kjemiske materialer.

Eksplosjonsfare eller brannfare
CFX Dx-systemet for PCR-deteksjon i sanntid utgjør ingen uvanlig risiko knyttet til brann eller
eksplosjon når det brukes på riktig måte som spesifisert av Bio-Rad Laboratories.
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Sikkerhet og overholdelse av krav

Elektriske farer
CFX Dx-systemet for PCR-deteksjon i sanntid utgjør ingen uvanlige elektriske farer for operatører hvis
det installeres og brukes på riktig måte uten fysiske modifikasjoner og kobles til en riktig spesifisert
strømkilde.

Transport
Utfør alltid dekontamineringsprosedyrer før flytting eller sending av CFX Dx-systemet for PCR-
deteksjon i sanntid , den optiske reaksjonsmodulen eller termosyklerbasen. Flytt eller send alltid CFX
Dx-systemet for PCR-deteksjon i sanntid og optiske reaksjonsmoduler i separate beholdere med
tilhørende emballasjemateriale for å beskytte instrumentet mot skade. Hvis det ikke er mulig å skaffe
egnede beholdere, kontakt din lokale Bio-Rad-forhandler.

Batteri
CFX Dx-systemets termosykler bruker et 3 V litium-metall-knappcellebatteri og en oppladbar 4,8 V
nikkel-metallhydrid-batteripakke for å bevare innstilling av klokkeslett og kjøringsdata i tilfelle
strømbrudd. Hvis klokkeslettet og/eller kjøringsdataene ikke forblir innstilt etter at enheten har blitt slått
av, kan det tyde på at batteriene begynner å bli svake. Hvis dette skjer, kontakter du teknisk støtte hos
Bio-Rad for å få hjelp.

Prøv ikke å bytte batteriene. Kontakt teknisk støtte hos Bio-Rad.

Kassering
CFX Dx-systemet for PCR-detektering i sanntid inneholder elektriske materialer, og disse skal
kasseres som usortert avfall og må samles inn separat i henhold til EU-direktiv 2012/19/EF, som
omhandler elektrisk og elektronisk avfall (WEEE-direktivet). Kontakt den lokale Bio-Rad-
representanten før du kasserer systemet, for å få instruksjoner som gjelder for ditt land.

Garanti
CFX Dx-systemet for PCR-deteksjon i sanntid og tilknyttet tilbehør dekkes av en standard Bio-Rad-
garanti. Kontakt din lokale Bio-Rad-forhandler for å få informasjon om garantien.
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Kapittel 1 Innledning
Bio-Rads CFX Dx-amplifiseringssystemer for sanntids-PCR for in vitro-diagnostikk (IVD) har de
nyeste teknologiske fremskrittene, sommuligjør PCR-kvantifisering med standardkurve,
genuttrykksanalyse, allelisk diskriminering og endepunktsanalyse.

CFX Dx-systemene består av to maskinvaremoduler og programvare:

n Optisk reaksjonsmodul (ORM) for CFX96™Dx eller CFX96 DeepWell Dx

n C1000™Dx-termosykler

n CFXManager™ Dx-programvare

Ved bruk med CFX Manager Dx-programvaren kan du

n generere umiddelbare resultater med oppstartsveiviseren

n legge inn eller redigere brønninformasjon før, under eller etter en kjøring

n tolke komplekse data og forstå genuttrykksundersøkelsen med verktøy som PrimePCR™-
kontrollanalysen og referansegenvelgeren

n lage omfattende rapporter basert på sanntids-PCR-data

CFX Dx PCR-deteksjonssystemer
Tabell 3 viser Bio-Rads IVD PCR-produkter som leveres med CFX Dx-systemet.

Merknad: Et CFX Dx-systemet leveres med CFX Manager Dx-programvare, C1000 Dx-
termosykler og enten CFX96 Dx eller CFX96 DeepWell Dx optisk reaksjonsmodul.

Katalognr. Beskrivelse

1845097-IVD CFX96 Dx ORM *

1844095-IVD CFX96 DeepWell Dx ORM

1841000-IVD C1000 Dx-termosykler

12007917 CFX Manager Dx-programvare versjon 3.1

Tabell 3. CFX IVD PCR-deteksjonssystemer

* Optisk reaksjonsmodul
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Kapittel 1 Innledning

Finne ut mer
Dette dokumentet forklarer hvordan du på trygg måte setter opp og bruker CFX96 Dx- og CFX96 Deep
Well Dx-systemene for PCR-deteksjon i sanntid – systemene bærer CE-IVD-merket. I dette
dokumentet kalles systemene CFX Dx-systemet. Dette dokumentet forklarer også hvordan du bruker
CFX Manager Dx-programvaren sammen med CFX Dx-systemet.

Tips: Klikk på Bio-Rad-logoen øverst til høyre i ethvert vindu i CFX Manager Dx-programvaren
for å åpne Bio-Rad-nettstedet. Dette nettstedet inkluderer koblinger til tekniske merknader,
håndbøker, produktinformasjon og teknisk støtte. Dette nettstedet har også mange tekniske
ressurser for en lang rekke metoder og bruksområder knyttet til PCR, sanntids-PCR og
genuttrykk.
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Kapittel 2 Sette opp C1000 Dx-termosykler
Dette kapitlet forklarer hvordan du setter opp CFX Dx-systemets C1000 Dx-termosykler på stedet ditt.

Tips: Før du setter opp termosykleren, må du gjøre deg kjent med termosykleren og dens optiske
reaksjonsmodul, porter og tilbehør.

Krav til stedet
Tabellene i dette avsnittet viser kravene til rommet, omgivelsene og strømtilførsel sommå være
oppfylt for installasjon og bruk av CFX Dx-systemets termosykler.

Merknad: Installer CFX Dx-systemets termosykler på en flat, tørr overflate med tilstrekkelig
tilførsel av kaldluft for korrekt funksjon.

Krav til benkeplass

Element Spesifikasjon

Inngangsstrøm Opptil 850 W, maksimalt

Frekvens 50–60 Hz, énfase

USB-porter 5 A, 1 B

Dimensjoner B: 13 in; 33 cm

D: 18 in; 46 cm

H: 14 in; 36 cm

Vekt 47 lb; 21 kg

Tabell 4. Krav til benkeplass for CFX Dx-systemets termosykler
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Kapittel 2 Sette opp C1000 Dx-termosykler

Krav til omgivelsene

Parameter Område Luftfuktighet

Driftsforhold 15–31 °C

59–87,8 °F

0–80 % relativ luftfuktighet,
ikke-kondenserende

Oppbevaringsforhold 15–31 °C

59–87,8 °F

0–80 % relativ luftfuktighet,
ikke-kondenserende

Tabell 5. Krav til omgivelsene for CFX Dx-systemets termosykler

Krav til strømtilførsel
Strømtilførselen til CFX Dx-systemets termosykler må være stabil og innenfor spesifikasjonene for å
sikre korrekt drift. Strømkabelen koblet til strøminngangen må være beregnet for 7 ampere eller mer.

Element Spesifikasjon

Nettstøm, inngangsspenning 100–240 Hz, 50–60 Hz, énfase

Maksimalt strømforbruk < 850 watt

Antall strømkontakter Minst 2 strømkontakter:

n 1 kontakt for termosykleren

n 1 kontakt for datamaskinen som kjører CFX Manager Dx-
programvaren

Tabell 6. Krav til strømtilførsel for CFX Dx-systemet
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Systemoversikt

Systemoversikt
Illustrasjonen i denne delen viser hovedkomponentene til C1000 Dx termosyklerbasen.

Sett forfra

1. Optisk reaksjonsmodul – inkluderer et optisk system for å samle inn fluorescensdata og
en termosyklerblokk. CFX Dx-systemer til PCR-deteksjon i sanntid støtter enten en
CFX96™Dx- eller CFX96 DeepWell Dx-modul.

2. Statusindikatorlampe – indikerer når blokken er i bruk.

3. Lokk-knapp – åpner eller lukker lokket på den optiske reaksjonsmodulen og forsegler
reaksjonskammeret.

4. C1000™ Dx-termosyklerbase – gir systemstrøm og -kommunikasjon, og har plass til
CFX96 Dx og CFX96 DeepWell optiske reaksjonsmoduler.

5. Frontpaneldisplay og -knapper – gjør det mulig å kontrollere systemet i stand-alone
modus.

Viktig: For å sikre dataintegriteten til IVD-genstudien støtter ikke CFX Manager Dx-
programvaren data generert av termosykleren i stand-alone modus.

6. Oppvarmet innvendig lokk – opprettholder temperaturen i lokket for å hindre
kondensering og fordampning.

7. Prøve-/reaksjonsblokk – har plass til reaksjonsbeholderen, inkludert rør og mikroplater.

FORKLARING
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Kapittel 2 Sette opp C1000 Dx-termosykler

Sett bakfra

1. Ethernet-port – kobler C1000 Dx-termosykleren til nettverket ditt.

2. USB-porter type B – kobler C1000 Dx-termosykleren til en datamaskin som kjører CFX
Manager Dx-programvare.

3. USB-porter type A – overfører data til og fra et USB-minne.

Viktig: For å sikre dataintegriteten til IVD-genstudien støtter ikke CFX Manager Dx-
programvaren data generert av termosykleren i stand-alone modus.

4. Serieport for testing – kun for servicerelatert testing.

5. Luftehull – avkjøler termosykleren.
Viktig: Ikke blokker luftehullene. For optimal drift må du sikre at luft kan sirkulere bak
termosyklerbasen.

6. Strøminntak – vekselstrøm fra strømnettet; bruk den medfølgende strømledningen.

7. Strømbryter – vippebryter for å slå termosykleren av og på.

8. Sikringer – se Spesifikasjoner og krav for trygg bruk på side 14 for informasjon om
sikringsspesifikasjoner.

FORKLARING
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Optiske reaksjonsmoduler

Optiske reaksjonsmoduler
C1000 Dx-termosykler er kompatibel med følgende Bio-Rad optiske reaksjonsmoduler for PCR i
sanntid.

n CFX96 Dx optisk reaksjonsmodul

n CFX96 DeepWell Dx optisk reaksjonsmodul

Den valgte CFX Dx optiske reaksjonsmodulen og termosykleren leveres i separate esker. CFX
Manager Dx-programvaren leveres med den optiske reaksjonsmodulen.

Viktig: Den optiske reaksjonsmodulen kalibreres med termosyklerbasen den ble levert med.
Derfor må den optiske reaksjonsmodulen ikke brukes sammen med noen andre
termosyklerbaser, og termosyklerbasen må ikke brukes sammen med noen andre optiske
reaksjonsmoduler.

Begge de optiske reaksjonsmodulene har et fullt justerbart oppvarmet lokk, som trygt kan kjøres på et
stort utvalg av reaksjonsbeholdere. Hver optiske reaksjonsmodul har kjølevifter for rask oppvarming
og nedkjøling.

Hver CFX Dx optiske reaksjonsmodul har følgende komponenter:

n Oppvarmet innvendig lokk – opprettholder temperaturen i lokket for å hindre kondensering og
fordampning.

n Prøve-/reaksjonsblokk – holder på reaksjonsbeholdere, inkludert rør og mikroplater.

n Knapp for lokket – åpner og lukker lokket og forsegler reaksjonen.

n Statuslampe – lyser når blokken er i bruk.

Anbefalte prøvevolumer
Ved bruk av C1000 Dx-termosykleren bestemmes det maksimale prøvevolumet av typen
reaksjonsmodul som brukes. Tabell 7 viser de anbefalte volumene for bruk med hver reaksjonsmodul.

Antall brønner Antall blokker
Anbefalt prøvevolum, µl

(øvre grense)

96 brønner 1 10–50

96 dype brønner 1 10–125

Tabell 7. Grenser for størrelse og volum for reaksjonsmoduler
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Kapittel 2 Sette opp C1000 Dx-termosykler

Installere C1000 Dx-termosykler
C1000 Dx-termosyklerbasen leveres i en separat eske fra den optiske reaksjonsmodulen. Pakken
inkluderer:

n C1000 Dx-termosyklerbase

n Strømledning

n 1 USB-kabel

Slik installerer du C1000 Dx-termosykleren:

1. Pakk ut og sett opp C1000 Dx-termosyklerbasen.

2. Monter reaksjonsmodulen på basen.

3. Fjern transportskruen.

Denne delen forklarer disse oppgavene i detalj.

Pakke ut og sette opp C1000 Dx-termosykler
Viktig: Før du bruker termosykleren, må du lese informasjonen i Sikkerhet og overholdelse av
krav på side 13 og Sikkerhetsmessige advarselsetiketter på side 13.

Tips: Under oppsettet må du forsikre deg om at du har nok plass ved siden av termosykleren til å
plassere en datamaskin som skal kjøre CFX Manager Dx-programvaren.

Pakke ut og sette opp termosyklerbasen

1. Finn pakken som inneholder termosyklerbasen.

2. Ta basen ut av emballasjen.

Tips: Ta vare på emballasjen for senere bruk. Kontakt det lokale Bio-Rad-kontoret dersom
deler mangler eller er skadd.

3. Plasser termosyklerbasen på en flat, tørr overflate med tilstrekkelig tilførsel av kaldluft for korrekt
funksjon.

4. Finn strømkabelen i transportemballasjen, og sett én ende inn i strøminngangen på baksiden av
termosykleren.

Viktig: Ikke slå på instrumentet på dette tidspunktet.

5. Monter IVD-reaksjonsmodulen på basen. Fortsett til Montere den optiske reaksjonsmodulen på
side 27.
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Installere C1000 Dx-termosykler

Montere den optiske reaksjonsmodulen
Bio-Rad leverer CFX96 Dx eller CFX96 DeepWell optisk reaksjonsmodul sammen med C1000 Dx-
termosyklerbase (men i en separat eske). Pakk forsiktig opp den optiske reaksjonsmodulen, og
kontroller at strømkabel og USB-kabel er vedlagt i transportesken.

Viktig: Hver optisk reaksjonsmodul kalibreres med termosyklerbasen den ble levert med. Derfor
må termosykleren ikke brukes sammen med noen andre termosyklerbaser.

Sørg for at C1000 Dx-termosyklerbasen plasseres på en flat, tørr overflate, og at den har tilstrekkelig
tilførsel av kaldluft for korrekt funksjon.

Slik monterer du reaksjonsmodulen på termosyklerbasen.

1. Sett C1000 Dx-termosykleren på et egnet sted, med låseskinnen vendt ned.

2. Løft den optiske reaksjonsmodulen etter håndtakene plassert over ventilasjonsåpningene på
sidene, og plasser modulen i monteringsnisjen på C1000 Dx-termosykleren. La det være 2 cm
ledig plass foran. Når den optiske modulen er på plass i nisjen, skal den dekke Bio-Rad-logoen
foran nisjen.

3. Trekk opp låseskinnen slik at den går i flukt med sidene på monteringsnisjen. Dette vil gjøre at
modulen flytter seg fremover og låses på plass.
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Kapittel 2 Sette opp C1000 Dx-termosykler

4. Kontroller at modulen er fullstendig og jevnt montert på C1000 Dx-termosyklerbasen. Det skal
ikke være mellomrommellom modulen og basen.

5. Koble til strømkabelen på baksiden av C1000 Dx termosyklerbasen og i en egnet stikkontakt.
Trykk deretter på strømbryteren på bakpanelet til C1000 Dx termosykleren for å starte systemet.

Fjerning av transportskruen
Viktig: Bio-Rads optiske reaksjonsmoduler leveres med en rød transportskrue, som er montert i
det innvendige lokket for å stabilisere den optiske reaksjonsmodulen under transport.
Transportskruen må fjernes før den optiske reaksjonsmodulen brukes.

Slik fjerner du transportskruen

1. C1000 Dx-termosykleren registrerer at transportskruen er montert i den optiske
reaksjonsmodulen og viser en melding som instruerer deg om å fjerne skruen.
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Installere C1000 Dx-termosykler

2. Følg instruksjonene for å fjerne transportskruen. Følgende diagram viser plasseringen av
transportskruen.

Merknad: Hvis du av en eller annen grunn må returnere reaksjonsmodulen, må du montere
transportskruen igjen. Oppbevar skruen på et sikkert og tilgjengelig sted.

Laste inn prøveplater
For å sikre jevn oppvarming og avkjøling av prøver må platene være i full kontakt med
reaksjonsblokken. Gjør som følger for å sikre god kontakt:

n Kontroller at blokken er ren før du laster inn prøver.

n Trykk enkeltrørene, rørstrimlene eller mikroplatene godt ned i brønnene i blokken.

n Når du bruker ett eller noen få rør, anbefales det at du bruker rørrammen (katalognr. 1849000
eller 1849001), eller at du laster inn minst ett tomt rør i hvert hjørne av blokken for å sikre at lokket
utøver et jevnt trykk på enkeltrør.
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Kapittel 2 Sette opp C1000 Dx-termosykler

Laste inn plater i den optiske reaksjonsmodulen

Viktig: Når du kjører CFX Dx-systemet, må du alltid balansere rørstrimlene eller tilføye rørlokk i
hjørnebrønnene for å sikre at det oppvarmede lokket har et jevnt trykk over hele blokken.

Slik laster du inn plater i den optiske reaksjonsmodulen

1. Velg én av følgende fremgangsmåter for å åpne det motoriserte lokket:

n Klikk på Open Lid (Åpne lokk) i ruten Detected Instruments (Detekterte instrumenter) i CFX
Manager Dx-programvaren.

n Klikk på Open Lid (Åpne lokk) i fanen Start Run (Start kjøring) i programvaren.

n Trykk på lokk-knappen foran på instrumentet.

2. Plasser mikroplaten, enkeltrør eller rørstrimler med forseglede lokk i blokken.

Viktig: Kontroller at rørene er helt forseglet for å unngå lekkasje.

Tips: For å sikre optimale resultater laster du inn prøvevolumer på 10–25 µl for CFX Dx-
systemet.

3. For å sikre en nøyaktig dataanalyse må du kontrollere at reaksjonene i blokken vender nøyaktig
samme vei som brønninnholdet i fanen Plate i CFX Manager Dx-programvaren.

Tips: Du kan redigere brønninnholdet ved hjelp av CFX Manager Dx-programvaren før,
under eller etter kjøringen.

4. Velg én av følgende fremgangsmåter for å lukke det motoriserte lokket:

n Trykk på lokk-knappen på instrumentet.

n Klikk på Close Lid (Lukk lokk) i ruten Detected Instruments (Detekterte instrumenter) i
programvaren.

n Klikk på Close Lid (Lukk lokk) i fanen Start Run (Start kjøring) i programvaren.

Viktig: Kontroller at ingenting blokkerer lokket når det lukkes. Selv om det finnes en
sikkerhetsmekanisme som forhindrer at lokket lukkes hvis det registrerer en hindring, må du
ikke plassere noe som kan forhindre at lokket lukkes.
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Installere C1000 Dx-termosykler

PCR-forbruksartikler i plast og reagenser

Du finner og bestiller anbefalte forbruksartikler i plast for CFX Dx-systemet ved å gå til Bio-Rad-
nettstedet. Du kan gå til dette nettstedet fra menyelementet Help > PCR Plastic Consumables
Web Site (Hjelp > Nettsted for PCR-forbruksartikler i plast) i CFX Manager Dx-programvaren. I tillegg
kan du bruke Plastics Selector (Plastvelger) og Reagents Selector (Reagensvelger) for å finne og
bestille forbruksartikler i plast og reagenser for din spesifikke maskinvare og PCR-behov.

Detektere tilkoblede instrumenter
Under installering vil installasjonsprogrammet for CFX Manager Dx-programvaren automatisk
installere instrumentdriverne på datamaskinen som kjører CFX Manager Dx-programvaren. CFX
Manager Dx detekterer tilkoblede instrumenter når du starter programvaren.

Viktig: Du må koble C1000 Dx-termosykleren fra datamaskinen med CFX Manager Dx før du
installerer programvaren. Du behøver ikke slå av termosykleren under installering av
programvaren.

Slik detekterer du tilkoblede instrumenter

1. Hvis det ennå ikke er gjort, setter du den firkantede (han)enden av den medfølgende USB type B-
kabelen inn i USB type B-porten som befinner seg bak på sokkelen til .

2. Sett den andre (port)enden inn i en USB-port på datamaskinen med CFX Manager Dx.

3. Hvis termosykleren ikke allerede kjører, trykker du på strømbryteren bak på instrumentet for å slå
det på.

4. Start CFX Manager Dx-programvaren.

Programvaren oppdager automatisk det tilkoblede instrumentet og viser instrumentets navn i ruten
Detected Instruments (Detekterte instrumenter) i startvinduet.

Merknad: Hvis instrumentet ikke vises i ruten Detected Instruments (Detekterte instrumenter),
må du kontrollere at USB-kabelen er satt inn riktig. Hvis du vil installere driverne på nytt, velger du
Tools > Reinstall Instrument Drivers (Verktøy > Installer instrumentdrivere på nytt) i startvinduet i
CFX Manager Dx-programvaren.
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Kapittel 2 Sette opp C1000 Dx-termosykler

Koble fra reaksjonsmodulen
Viktig: Slå av C1000 Dx-termosykleren før du kobler fra en reaksjonsmodul (se Slå av C1000 Dx-
termosykleren på side 32). Nedkjølingsblader i reaksjonsmodulen kan være varme umiddelbart
etter kjøring av en protokoll eller inkubasjon. Påse at bladene er kalde før du kobler fra
reaksjonsmodulen.

Koble fra den optiske reaksjonsmodulen fra termosyklerbasen

1. På baksiden av termosyklerbasen skyver du ned låseskinnen for å låse opp og frigi den optiske
reaksjonsmodulen.

2. Løft den optiske reaksjonsmodulen forsiktig ut av nisjen ved bruk av fordypningene på hver side
av håndtaket.

3. Sett den optiske reaksjonsmodulen på en ren, flat overflate der den ikke kan støtes inn i, skrapes
opp eller falle ned.

Slå av C1000 Dx-termosykleren
Slik slår du av termosykleren

1. Etter en kjøring trykker du på knappen for å åpne lokket foran på den optiske reaksjonsmodulen
for CFX, for å få tilgang til prøvene som er satt inn i blokken.

2. Fjern prøvene fra blokken, og trykk på knappen for å lukke lokket.

3. Trykk på strømbryteren bak på C1000 Dx-termosykleren for å slå av systemet.
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Kapittel 3 Installere CFX Manager Dx-
programvaren

Dette kapitlet forklarer hvordan man installerer CFX Manager™ Dx-programvaren.

CFX Manager Dx-programvaren er påkrevd for å analysere PCR-data i sanntid fra CFX96™Dx- og
CFX96 DeepWell Dx-systemene. Du kan også bruke denne programvaren til å styre disse systemene
i programvarestyrt modus.

For mer informasjon om å installere CFX Dx-systemet termosykler og optisk reaksjonsmodul, se Sette
opp C1000 Dx-termosykler på side 21.
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Kapittel 3 Installere CFX Manager Dx-programvaren

Systemkrav
Tabell 8 lister opp minimum og anbefalte systemkrav for datamaskinen som kjører CFX Manager Dx-
programvaren (også kalt CFX Manager Dx-datamaskinen).

System Minimum Anbefalt

Operativsystem Microsoft Windows 7 SP1
Pro

Et av følgende:

n Microsoft Windows 7 SP2 Pro (32- og 64-
bit)

n Microsoft Windows 10 Pro (kun 64-bit)

n Microsoft Windows 10 Enterprise (kun
64-bit)

Viktig: Secure Boot (Sikker oppstart) må være deaktivert på både Microsoft Windows 10 Pro og
Enterprise.

Porter 2 USB 2.0-porter med høy
hastighet

2 USB 2.0-porter med høy hastighet

Plass på harddisken 128 GB 128 GB

Prosessorhastighet 2,4 GHz, Dual Core 2,4 GHz, Quad Core

RAM 4 GB RAM 8 GB RAM

Skjermoppløsning 1024 x 768 med millioner
av farger (true-color)

1280 x 1024 med millioner av farger (true-
color)

PDF-leser Adobe PDF Reader eller Windows PDF
Reader fra en av de støttede Microsoft
Office-pakkene:

n 2007

n 2010

n 2013

Tabell 8. Datamaskinkrav for CFX Manager Dx-programvaren
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Installere CFX Manager Dx-programvaren
Viktig: Før du installerer eller oppgraderer programvaren må du koble fra eventuelle instrumenter
som er koblet til CFX Manager Dx-datamaskinen. Det er ikke nødvendig å slå av termosykleren
under programvareinstallasjonen. Kontroller at du har lagret alle kjøringer, og at ingen
eksperimenter pågår.

Merknad: Hvis du installerer CFX Manager Dx-programvaren påWindows 10, må du kontrollere
at Secure Boot (Sikker oppstart) er deaktivert før du starter installasjonsprosedyren.

Slik installerer du CFX Manager Dx-programvaren

1. Koble fra eventuelle instrumenter som er koblet til datamaskinen.

Finn instrumentets USB-kabel påCFX Manager Dx-datamaskinen, og koble den fra. Kabelenden
som er tilkoblet instrumentet, trenger ikke kobles fra.

2. Logg på CFX Manager Dx-datamaskinen som administrator.

3. Sett CD-en med CFX Manager Dx-programvaren i CD-stasjonen på datamaskinen.

4. Programvarens startside skal vises automatisk. Dobbeltklikk på Install Software (Installer
programvare) på programvarens startside.

Merknad: Hvis startsiden ikke vises automatisk, går du til CD-stasjonen og åpner mappen
CFX_Manager. Deretter dobbeltklikker du på setup.exe for å starte veiviseren for
programvareinstallasjon.

Tips: I installasjonsveiviseren klikker du på knappen Documentation (Dokumentasjon) for å
finne søkbare kopier av versjonsmerknader, instrumenthåndbøker og annen dokumentasjon.

5. Følg instruksjonene på skjermen for å fullføre installasjonen. Når installasjonen er ferdig, vises
ikonet for CFX manager-programvaren på skrivebordet på datamaskinen.

6. Når installasjonen er ferdig, kan du trygt ta ut CD-en.
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Detektere tilkoblede instrumenter
Installasjonsprogrammet for CFX Manager Dx-programvaren installerer automatisk
instrumentdriverne på CFX Manager Dx-datamaskinen under installering. CFX Manager Dx
detekterer tilkoblede instrumenter når du starter programvaren.

Slik detekterer du tilkoblede instrumenter

1. Hvis du ikke allerede har gjort det, setter du den firkantede (han)enden av den medfølgende
USB B-kabelen inn i USB B-porten på baksiden av instrumentets sokkel.

2. Sett den andre (port)enden inn i en USB-port på datamaskinen med CFX Manager Dx.

3. Hvis instrumentet ikke allerede kjører, trykker du på strømbryteren bak på instrumentet for å slå
det på.

4. Start CFX Manager Dx.

Programvaren detekterer automatisk det tilkoblede instrumentet og viser instrumentets navn i ruten
Detected Instruments (Detekterte instrumenter) i startvinduet.

Merknad: Hvis instrumentet ikke vises i ruten Detected Instruments (Detekterte instrumenter),
må du kontrollere at USB-kabelen er satt inn riktig. Hvis du vil installere driverne på nytt, velger du
Tools > Reinstall Instrument Drivers (Verktøy > Installer instrumentdrivere på nytt) i startvinduet i
CFX Manager Dx.

Programvarefiler
Tabell 9 inneholder en liste over filtypene for CFX Manager Dx-programvaren.

Filtype Filforlengelse Detaljer

Protokoll .prcl Inneholder detaljer om protokolloppsett for å utføre
en PCR-kjøring.

Plate .pltd Inneholder detaljer om plateoppsett for å utføre en
PCR-kjøring.

Data .pcrd Inneholder resultatene fra en eksperimentkjøring og
PCR-analyse.

PrimePCR™-kjøring .csv Inneholder protokoll- og plateoppsett for PrimePCR-
plater.

Tabell 9. Filtyper for CFX Manager Dx-programvaren
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Filtype Filforlengelse Detaljer

Genstudie .mgxd Inneholder resultater fra flere PCR-kjøringer og
genuttrykksanalyser.

LIMS .plrn Inneholder informasjon om plate- og
protokolloppsett som kreves for å utføre en LIMS-
kompatibel kjøring.

Tabell 9. Filtyper for CFX Manager Dx-programvaren, forts.

Anbefalte tiltak for nettsikkerhet
Bio-Rad anbefaler at du samarbeider med din IT-avdeling for å implementere tiltak for nettsikkerhet for
datamaskinen som brukes sammen med CFX96 Dx-systemet. For eksempel:

n Installer og konfigurer relevante antivirus- og brannmurprogrammer.

Viktig: Konfigurer virusskanninger slik at de utføres utenfor arbeidstiden eller når
instrumentet ikke kjører aktivt. Hvis en virusskanning initieres mens CFX Manager Dx kjører
et eksperiment, kan kjøringen bli avbrutt og dataene gå tapt.

n CFXManager Dx-programvaren har ingen tidsavbruddsfunksjon ved brukerinaktivitet.
Implementer Windows- eller tredjepartsbaserte sikkerhetstiltak for brukertilgang (for eksempel en
skjermsparer med påkrevd pålogging).

n Sikkerhet knyttet til uttakbare medier:

o Bruk passord og kryptering på USB-enheten for å beskytte data.

o Deaktiver funksjoner for automatisk kjøring og avspilling for alle uttakbare medieenheter.

o Pålegg USB-skanning hver gang det settes inn en minnepinne.

n Bruk en sikkerhetskopiløsning for å gjøre det enklere å gjenopprette data.
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Kapittel 4 Arbeidsområdet
CFXManager™ Dx-programvaren gir et grensesnitt for å sette opp plater, utvikle PCR-protokoller,
kjøre dem på CFX Dx-instrumenter og analysere data fra PCR-kjøringer.

CFX Manager Dx-programvaren har fem primære arbeidsområder:

n Startvinduet

n Startup Wizard (Oppstartsveiviser)

n Vinduet Protocol Editor (Protokollredigering)

n Vinduet Plate Editor (Plateredigering)

n Vinduet Data Analysis (Dataanalyse)

Hvert arbeidsområde vises og beskrives kort i dette kapittelet.
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Startvinduet
CFXManager Dx-programvaren åpnes i startvinduet og viser Startup Wizard (Oppstartsveiviser), som
du kan bruke til å sette opp et eksperiment, utføre eller gjenta en kjøring, eller analysere en
eksisterende kjøring. Fra startvinduet kan du også vise program- og instrumentlogger, opprette og
administrere brukere og få tilgang til mange nyttige verktøy. Hvis du vil ha mer informasjon, se Kapittel
5, Startvinduet.
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Startup Wizard (Oppstartsveiviser)
Bruk Startup Wizard (Oppstartsveiviser) for raskt å sette opp og kjøre brukerdefinerte eksperimenter
eller velge og kjøre et PrimePCR™-eksperiment. Du kan også bruke denne veiviseren for å gjenta en
kjøring eller for å analysere kjøringsdata.
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Vinduet Protocol Editor (Protokollredigering)
I vinduet Protocol Editor (Protokollredigering) kan du opprette, åpne, se gjennom og redigere en
protokoll. Du kan også modifisere lokktemperaturen for den åpne protokollen. Funksjonen Protocol
Editor (Protokollredigering) beskrives nærmere i Kapittel 6, Opprette protokoller.
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Vinduet Plate Editor (Plateredigering)

Vinduet Plate Editor (Plateredigering)
I Plate Editor (Plateredigering) kan du opprette, åpne, gjennomgå og redigere en plate. Funksjonene i
Plate Editor (Plateredigering) er nærmere beskrevet i Kapittel 7, Klargjøre plater.
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Vinduet Data Analysis (Dataanalyse)
I vinduet Data Analysis (Dataanalyse) kan du vise og sammenligne kjøringsdata, utføre statistiske
analyser, eksportere data og opprette rapporter klare til publisering. Funksjonen Data Analysis
(Dataanalyse) beskrives nærmere i Kapittel 9, Oversikt over dataanalyse. Se også Kapittel 10,
Detaljer om dataanalyse.
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Kapittel 5 Startvinduet
CFXManager™ Dx-programvaren gir et grensesnitt for å utvikle PCR-protokoller, kjøre dem på
CFXDx-systemer og analysere data fra PCR-kjøringer.

Dette kapittelet introduserer CFX Manager Dx-programvaren og beskriver funksjonene som er
tilgjengelige i startvinduet.
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Startvinduet
CFXManager Dx åpnes i startvinduet og viser Startup Wizard (Oppstartsveiviser), der du kan sette
opp en kjøring, utføre eller gjenta en kjøring, eller analysere en eksisterende kjøring. Fra startvinduet
kan du også vise program- og instrumentlogger, opprette og administrere brukere samt åpne flere
nyttige verktøy.

1. Programvarens tittellinje viser navnet på programvaren og brukeren som er pålogget.

2. Denne menylinjen gir rask tilgang til menykommandoene File (Fil), View (Vis), Users
(Brukere), Run (Kjør), Tools (Verktøy), Window (Vindu) og Help (Hjelp).

3. Kommandoene på verktøylinjen gir rask tilgang til menyalternativer.

4. Venstre rute viser instrumentene som er tilkoblet CFX Manager Dx-datamaskinen, og den
har knapper som kan brukes til å betjene lokket og vise status for instrumentene.

5. Hovedruten viser arbeidsvinduet. Startup Wizard (Oppstartsveiviser) på startskjermbildet er
standard arbeidsvindu.

6. Statuslinjen viser navnet på de tilkoblede instrumentene og brukeren som er pålogget.

FORKLARING

46 | CFX96 Dx- og CFX96 DeepWell Dx-systemet



Startvinduet

Kommandoer i menyen File (Fil)
New (Ny) – åpner en dialogboks der du kan velge å opprette en ny protokoll, plate eller genstudie.

Open (Åpne) – åpner en dialogboks der du kan velge å navigere til og åpne en eksisterende protokoll,
plate, datafil, genstudie, LIMS-fil, eller PrimePCR™-kjørefil.

Recent Data Files (Nylige datafiler) – viser en liste over nylig åpnede PCR-filer.

Repeat a Run (Gjenta en kjøring) – åpner Windows Utforsker til plasseringen med lagrede PCR-filer,
der du kan finne kjøringen som skal gjentas.

Exit (Avslutt) – lukker CFX Manager Dx.

Kommandoer i menyen View (Vis)
Application Log (Applikasjonslogg) – viser en logg over bruken av programvaren, fra første
installasjon til i dag.

Run Reports (Kjøringsrapporter) – viser en liste over kjøringsrapporter.

Startup Wizard (Oppstartsveiviser) – viser Startup Wizard (Oppstartsveiviser) i hovedruten.

Run Setup (Kjøringsoppsett) – viser vinduet Run Setup (Kjøringsoppsett) i hovedruten.

Instrument Summary (Instrumentsammendrag) – viser vinduet Instrument Summary
(Instrumentsammendrag) i hovedruten.

Detected Instruments (Detekterte instrumenter) – viser/skjuler tilkoblede instrumenter i ruten til
venstre. Som standard viser programvaren tilkoblede instrumenter i ruten til venstre.

Toolbar (Verktøylinje) – viser/skjuler verktøylinjen øverst på skjermen. Som standard viser
programvaren verktøylinjen.

Status Bar (Statuslinje) – viser/skjuler statuslinjen nederst på skjermen. Som standard viser
programvaren statuslinjen.

Show (Vis) – åpner en dialogboks hvor du kan

n vise eller blokkere statusloggen

n åpne og vise datamappen for CFX Manager Dx
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n åpne og vise brukerens datamappe

n åpne og vise LIMS-filmappen

n åpne og vise PrimePCR-mappen

n vise kjøringshistorikken

n vise egenskapene for alle tilkoblede instrumenter

Kommandoer i menyen User (Bruker)
Select User (Velg bruker) – åpner skjermbildet Login (Logg på), der du kan velge en bruker fra
rullegardinmenyen User Name (Brukernavn) og logge på programmet.

Change Password (Endre passord) – åpner dialogboksen Change Password (Endre passord), der
brukerne kan endre CFX Manager Dx-programvaren-passordet sitt.

User Preferences (Brukerpreferanser) – åpner dialogboksen User Preferences (Brukerpreferanser),
der brukere kan endre standardinnstillingene for

n Sende og motta e-postvarsel ved fullført kjøring

n Lagre datafiler

n Opprette protokoller via Protocol Editor (Protokollredigering) eller Protocol AutoWriter
(Automatisk protokollskriving)

n Opprette plater

n Analysere data

n Utføre analyse av genuttrykk

n Bestemme datakvaliteten

n Eksportere CFX Dx-instrumentdata

User Administration (Brukeradministrasjon) – åpner dialogboksen User Administration
(Brukeradministrasjon), der administratorer kan opprette brukere, endre rolletillatelser og tilordne
roller til brukere.

Bio-Rad Service Login (Servicepålogging) – kun til bruk av Bio-Rad teknisk servicepersonell. Ikke
velg denne kommandoen.
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Kommandoer i menyen Run (Kjøring)
User-defined Run (Brukerdefinert kjøring) – åpner vinduet Run Setup (Kjøringsoppsett) der du kan
sette opp en brukerdefinert protokoll og plate, og deretter kjøre et PCR-eksperiment på valgte
instrumenter.

PrimePCR Run (PrimePCR-kjøring) – åpner fanen Start Run (Start kjøring) i vinduet Run Setup
(Kjøringsoppsett) med standard PrimePCR-protokoll og plateoppsett lastet inn basert på det valgte
instrumentet.

End-Point Only Run (Kjøring med kun endepunkt) – åpner fanen Start Run (Start kjøring) i vinduet
Run Setup (Kjøringsoppsett) med standard endepunktprotokoll og plateoppsett lastet inn basert på
det valgte instrumentet.

Qualification Run (Kvalifikasjonskjøring) – åpner fanen Start Run (Start kjøring) i vinduet Run Setup
(Kjøringsoppsett) med standard Bio-Rad-kvalifikasjonsprotokoll og plateoppsett lastet inn basert på
det valgte instrumentet.

Kommandoer i menyen Tools (Verktøy)
Master Mix Calculator (Mastermiks-kalkulator) – åpner Master Mix Calculator (Mastermiks-
kalkulator), der du kan opprette en reaksjonsmiks og skrive ut beregningene.

Protocol AutoWriter (Automatisk protokollskriving) – åpner dialogboksen Protocol AutoWriter
(Automatisk protokollskriving), der du enkelt kan opprette en ny protokoll.

Ta Calculator (Ta-kalkulator) – åpner Ta Calculator (Ta-kalkulator), der du enkelt kan beregne
hybridiseringstemperaturen til primere.

Dye Calibration Wizard (Veiviser for fargekalibrering) – åpner veiviseren Dye Calibration Wizard
(Veiviser for fargekalibrering), der du kan kalibrere et instrument for en ny fluorofor.

Reinstall Instrument Drivers (Installer instrumentdrivere på nytt) – installerer driverne som styrer
kommunikasjonen med Bio-Rads systemer for PCR i sanntid, på nytt.

Zip Data and Log Files (Komprimer data og loggfiler) – åpner en dialogboks der du kan velge filer du
vil komprimere og lagre i en komprimert fil for å oppbevare den eller sende den i en e-post.

Batch Analysis (Batchanalyse) – åpner dialogboksen Batch Analysis (Batchanalyse), der du kan
angi parametere for analysering av mer enn én datafil om gangen.

Options (Alternativer) – åpner en dialogboks der du kan

n konfigurere innstillinger for e-postserver

n konfigurere eksportinnstillinger for LIMS eller andre datafiler
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Kommandoer i menyen Help (Hjelp)
Tips: Menyen Help (Hjelp) er tilgjengelig på menylinjen i alle vinduer i CFX Manager Dx-
programvaren.

Open Operation Manual (Åpne brukerhåndbok) – åpner en PDF med denne håndboken.

Gene Expression Gateway Web Site (Portalnettsted for genuttrykk) – åpner Bio-Rad-hjemmesiden
for CFX Dx-systemet.

PCR Reagents Web Site (Nettsted for qPCR-reagenser) – åpner Bio-Rad-nettstedet for PCR-
reagenser, hvor du kan bestille PCR-reagenser, supermikser, fargestoffer og kit.

PCR Plastic Consumables Web Site (Nettsted for qPCR-forbruksartikler i plast) – åpner Bio-Rad-
nettstedet for PCR-forbruksartikler i plast, hvor du kan bestille PCR-rør, plateforseglinger, rør og
korker, og annet tilbehør av plast.

Software Web Site (Nettsted for programvare) – åpner Bio-Rad-nettstedet for PCR-
analyseprogramvare, hvor du kan bestille oppdaterte versjoner av Bio-Rads CFX Manager Dx-
programvaren.

About (Om) – viser informasjon om opphavsrett og versjon for CFX Manager Dx.

Kommandoer på verktøylinjen

– åpner Windows Utforsker, der du kan navigere til og åpne en datafil eller en genstudiefil.

– åpner Master Mix Calculator (Mastermiks-kalkulator).

– åpner vinduet Run Setup (Kjøringsoppsett).

– åpner vinduet Run Setup (Kjøringsoppsett) med den standard PrimePCR-protokollen og
plateoppsettet lastet inn basert på det valgte instrumentet.

– åpner Startup Wizard (Oppstartsveiviser).
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Startup Wizard (Oppstartsveiviser)
Når CFX Manager Dx starter, vises Startup Wizard (Oppstartsveiviser) i arbeidsruten. Fra Startup
Wizard (Oppstartsveiviser) kan du

n velge et instrument fra detekterte instrumenter og sette opp en brukerdefinert kjøring eller en
PrimePCR-kjøring

n åpne og gjenta en kjøring

n åpne en datafil for å analysere resultatene fra én enkelt kjøring eller en genstudiefil for resultatene
fra flere kjøringer av genuttrykk

Disse oppgavene forklares nærmere i de følgende kapitlene.

Statuslinje
På venstre side av statuslinjen nederst i programvarens hovedvindu vises gjeldende status for de
detekterte instrumentene. På høyre side av statuslinjen vises navnet på gjeldende bruker samt dato
og klokkeslett.
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Ruten Detected Instruments (Detekterte instrumenter)
Ruten Detected Instruments (Detekterte instrumenter) viser alle instrumenter som er koblet til CFX Manager
Dx-datamaskinen. Som standard vises hvert instrument som et ikon, og instrumentets serienummer vises
som dets navn.

For eksempel viser følgende bilde fire detekterte instrumenter:

n To C1000™-termosyklere med CFX96™DeepWell-reaksjonsmoduler (CFX96DW1 og
CFX96DW2)

n To C1000™-termosyklere med CFX96™-reaksjonsmoduler (CFX96l01 og CFX96l02)

Fra denne ruten kan du gjøre følgende:

n Vise egenskaper og kalibrerte fargestoffer for et valgt instrument.

Se Vise egenskapene til et instrument på side 56 for mer informasjon om instrumentegenskaper.

n Vise status for et tilkoblet instrument.

n Åpne det motordrevne lokket på det valgte instrumentet.

n Lukke det motordrevne lokket på det valgte instrumentet.

n Vise status for alle tilkoblede instrumenter.
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Slik viser du status for et tilkoblet instrument

u Velg ønsket instrument i ruten Detected Instruments (Detekterte instrumenter), og gjør ett av
følgende:

n Klikk på View Status (Vis Status) i delen Selected Instrument (Valgt instrument).

n Høyreklikk og velg View Status (Vis status) på menyen som åpnes.

Dialogboksen Run Details (Kjøringsdetaljer) åpnes og viser fanen Run Status (Kjøringsstatus).
Status for det valgte instrumentet vises under ruten for kjøringsstatus, som for eksempel:

Slik åpner eller lukker du lokket på et instrument.

u Velg ønsket instrument i ruten Detected Instruments (Detekterte instrumenter), og gjør ett av
følgende:

n Klikk på Open Lid (Åpne lokk) eller Close Lid (Lukk lokk) i delen Selected Instrument (Valgt
instrument).

n Høyreklikk og velg ønsket handling på menyen som åpnes.

n Åpne dialogboksen Run Details (Kjøringsdetaljer), velg fanen Run Status (Kjøringsstatus) og
klikk på Open Lid (Åpne lokk) eller Close Lid (Lukk lokk).
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Slik viser du status for alle detekterte instrumenter

u Gjør ett av følgende:

n Klikk på View Summary (Vis sammendrag) i delen All Instruments (Alle instrumenter) i ruten
Detected Instruments (Detekterte instrumenter).

n Velg View > Instrument Summary (Vis > Instrumentsammendrag) på menylinjen.

Dialogboksen Instrument Summary (Instrumentsammendrag) åpnes:

Tips: Hvis systemet detekterer kun ett tilkoblet instrument, vises ikke delen All Instruments
(Alle instrumenter) i ruten Detected Instruments (Detekterte instrumenter). Velg View >
Instrument Summary (Vis > Instrumentsammendrag) for å vise instrumentsammendraget for
ett enkelt instrument.
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Kontroller på verktøylinjen Instrument Summary (Instrumentsammendrag)

Tabell 10 viser kontrollene og funksjonene på verktøylinjen Instrument Summary
(Instrumentsammendrag).

Knapp Navn på knapp Funksjon

Create a new Run (Opprett
en ny kjøring)

Oppretter en kjøring for den valgte
blokken ved å åpne vinduet Run
Setup (Kjøringsoppsett).

Stop (Stopp) Stopper den pågående kjøringen på
valgte blokker.

Pause (Sett på pause) Setter den pågående kjøringen på
valgte blokker på pause.

Resume (Gjenoppta) Gjenopptar den pågående kjøringen
på valgte blokker.

Flash Block Indicator
(Blokkindikatorlampe)

Gjør at indikatorlampen på logget på
valgte blokker blinker.

Open Lid (Åpne lokk) Åpner det motordrevne lokket på den
valgte blokken.

Close Lid (Lukk lokk) Lukker det motordrevne lokket på den
valgte blokken.

Hide Selected Blocks (Skjul
valgte blokker)

Skjuler de valgte blokkene på listen
Instrument Summary
(Instrumentsammendrag).

Show All Blocks (Vis alle
blokker)

Viser de valgte blokkene på listen
Instrument Summary
(Instrumentsammendrag).

Show (Vis) Velg hvilke blokker som skal vises på
listen. Velg ett av alternativene for å
vise alle detekterte blokker, alle
inaktive blokker, alle blokker som
kjører med gjeldende bruker eller alle
blokker som kjører.

Tabell 10. Kontroller på verktøylinjen Instrument Summary (Instrumentsammendrag)
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Vise egenskapene til et instrument
Fra ruten Detected Instruments (Detekterte instrumenter) kan du vise detaljer om et valgt instrument,
inkludert egenskapene, status for transportskruen og en liste over kalibrerte fargestoffer (fluoroforer).

Slik viser du instrumentegenskaper

u I ruten Detected Instruments (Detekterte instrumenter) høyreklikker du på ønsket instrument og
velger Properties (Egenskaper) i menyen som vises.

Fanen Properties (Egenskaper)

Fanen Properties (Egenskaper) viser tekniske detaljer om det valgte instrumentet, inkludert modellen,
serienummeret til komponentene og fastvareversjoner. Standardnavnet på instrumentet
(serienummeret) vises mange steder, blant annet i ruten Detected Instruments (Detekterte
instrumenter) og i tittellinjen i dialogboksen Instrument Properties (Instrumentegenskaper). Du kan
endre navnet på instrumentet for å gjøre det enklere å identifisere det.

Slik endrer du navn på et instrument

u I fanen Instrument Properties (Instrumentegenskaper) skriver du inn et navn i boksen Rename
(Endre navn) øverst i fanen Properties (Egenskaper) og klikker på Rename (Endre navn).

Det nye navnet vises i raden Nickname (Kallenavn) i fanen Properties (Egenskaper) samt i
tittellinjen i Instrument Properties (Instrumentegenskaper) og i ruten Detected Instruments
(Detekterte instrumenter).

56 | CFX96 Dx- og CFX96 DeepWell Dx-systemet



Startvinduet

Fanen Shipping Screw (Transportskrue)

Fanen Shipping Screw (Transportskrue) viser gjeldende status for transportskruen til det valgte
instrumentet (Removed (Fjernet) eller Installed (Installert)). Fanen inneholder også instruksjoner for
installasjon eller fjerning av den røde transportskruen.

Tips: Hvis programvaren registrerer transportskruen, åpnes dialogboksen Instrument Properties
(Instrumentegenskaper) automatisk i fanen Shipping Screw (Transportskrue). Følg
instruksjonene for å fjerne skruen.

Merknad: Du må fjerne transportskruen før du kan bruke instrumentet. Hvis du vil ha mer
informasjon, se Fjerning av transportskruen på side 28.

Fanen Calibrated Dyes (Kalibrerte fargestoffer)

Fanen Calibrated Dyes (Kalibrerte fargestoffer) viser de kalibrerte fluoroforene og platene for det
valgte instrumentet.

Hvis du vil ha mer informasjon om en kalibrering, klikker du på knappen Info i kolonnen Detail
(Detaljer).
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Før du begynner

Angi brukerpreferanser
Tips: Det er ikke nødvendig å utføre disse handlingene for å kunne bruke CFX Manager Dx-
programvaren. Du kan trygt hoppe over dette avsnittet eller utføre handlingene når som helst
senere.

I CFX Manager Dx kan du tilpasse arbeidsmiljøet. Hvis administratoren har opprettet
programvarebrukere, kan hver enkelt bruker tilpasse sitt eget arbeidsmiljø. Hvis administratoren ikke
har opprettet brukere, gjelder preferanseendringene for alle som logger på CFX Manager Dx. (For
informasjon om å opprette brukere i CFX Manager Dx, se Vedlegg B, Administrere brukere og roller i
CFX Manager Dx.)

I menyen Users > User Preferences (Brukere > Brukerpreferanser) kan du for eksempel gjøre
følgende:

n Sette opp e-postvarsling av fullførte kjøringer

n Endre standardinnstillingene for

o hvor filer skal lagres

o filene for kjøringsoppsett

o prefiks ved navngiving av fil

n Angi standardparameterne som skal brukes når det opprettes en ny protokoll og plate

n Angi standardparameterne for dataanalyse og genuttrykk

n Tilpasse standardparameterne for kvalitetskontroll

n Tilpasse parameterne for dataeksport

I menyen Tools (Verktøy) kan du gjøre følgende:

n Opprette en mastermiks

n Kalibrere fargestoffer for et bestemt instrument

Merknad: Mastermiksen og fargestoffkalibreringen er tilgjengelig for alle som logger på CFX
Manager Dx.

Dette avsnittet forklarer hvordan disse oppgavene utføres i detalj.
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Sette opp e-postvarsling

CFXManager Dx kan kobles til serveren for utgående e-post for å sende e-postvarslinger om fullførte
kjøringer til en brukerliste. Du kan også velge å legge ved en datafil og en analyserapport til
brukerlisten. Se Koble CFX Manager Dx til en SMTP-server på side 60 for mer informasjon om
hvordan du setter opp en tilkobling mellom CFX Manager Dxog SMTP-serveren.

Merknad: Hvorvidt en bruker kan sette opp e-postfunksjoner avhenger av brukergruppen og
rettighetene tildelt av administrator. Se Administrere brukere på side 255 for mer informasjon om
administrering av brukere og roller.

Slik setter du opp e-postvarslinger

1. Velg Users > User Preferences (Brukere > Brukerpreferanser) for å åpne dialogboksen User
Preferences (Brukerpreferanser).

Dialogboksen User Preferences (Brukerpreferanser) åpnes, og fanen Email (E-post) vises.

Merknad: Hvis systemet registrerer at du ikke har satt opp en gyldig SMTP-server for CFX
Manager Dx, får du et varsel om dette. Klikk på Configure Outgoing Email (Konfigurer
utgående e-post) for å åpne dialogboksen Options (Alternativer) og konfigurere SMTP-
serveren. Se Koble CFX Manager Dx til en SMTP-server på side 60 for mer informasjon.

2. I tekstboksen To (Til) skriver du inn e-postadressen til alle brukere du ønsker skal få et varsel om
fullført kjøring. Alle mottakere mottar en e-post når kjøringen er fullført.

Merknad: Du må skrive inn hver e-postadresse på en egen linje. Trykk på Enter eller Retur
etter hver adresse.

3. (Valgfritt) I tekstboksen cc (Kopi) skriver du inn e-postadressen til alle brukere du ønsker skal
motta en kopi av varselet om fullført kjøring.

4. (Valgfritt) Som standard mottar alle brukere en kopi av datafilen som vedlegg. Fjern merkingen i
denne avmerkingsboksen hvis du ikke vil legge ved en kopi av datafilen.
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5. (Valgfritt) Velg Attach Analysis Report (Legg ved analyserapport) for å legge ved en PDF av
analyserapporten i e-posten.

6. Klikk på OK for å lagre endringene og lukke dialogboksen User Preferences (Brukerpreferanser).

Slik redigerer du e-postadressen til en mottaker

u Modifiser e-postadressen etter behov, og klikk på OK.

Slik fjerner du en e-postmottaker

1. Velg e-postmottakeren og trykk på tasten Delete (Slett).

2. Klikk på OK for å lagre endringene og lukke dialogboksen.

Viktig: Hvis du klikker på Restore Defaults (Gjenopprett standarder) i dialogboksen User
Preferences (Brukerpreferanser), tilbakestilles alle preferansene i alle faner til de opprinnelige
fabrikkinnstillingene. Utvis forsiktighet når du klikker på denne knappen.

Koble CFX Manager Dx til en SMTP-server

Viktig: Visse leverandører av nettbaserte e-posttjenester (som Yahoo! og Gmail) har økt e-
postsikkerheten. Hvis du bruker disse kontoene, må du aktivere innstillingen Allow less secure
apps (Tillat mindre sikre apper) i kontoinnstillingene for å gjøre det mulig for CFX Manager Dx å
sende e-post. Se sikkerhetsinformasjonen fra leverandøren av din nettbaserte e-posttjeneste for
mer informasjon.

Du må opprette en tilkobling fra CFX Manager Dx til e-postserveren før programvaren kan sende e-
postvarslinger.

Slik kobler du CFX Manager Dx til en e-postserver

1. Gjør ett av følgende:

n Velg User > User Preferences (Bruker > Brukerpreferanser) og klikk på Configure Outgoing
Email (Konfigurer utgående e-post) på fanen Email (E-post).

n Velg Tools > Options (Verktøy > Alternativer).

Dialogboksen Options (Alternativer) vises med fanen Email (E-post).
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2. Oppgi følgende informasjon for institusjonen din:

n SMTP Server Name (SMTP-servernavn) – navnet på serveren for utgående e-post på
institusjonen din.

n Port – portnummeret for SMTP-serveren. Dette er vanligvis 25.

n Use SSL (Bruk SSL) – alternativ for Secure Sockets Layer (SSL). Noen SMTP-servere
krever denne innstillingen. Fjern haken fra avmerkingsboksen hvis det ikke kreves på
institusjonen din.

n Use Default “From” Address (Bruk standard Fra-adresse) – navnet på e-postserveren på
institusjonen din. Noen SMTP-servere krever at all e-post som sendes, har en Fra-adresse
som er fra et bestemt domene, for eksempel navn@InstitusjonenDin.com. I så fall fjerner du
haken fra denne avmerkingsboksen og oppgir en gyldig e-postadresse.

n Authentication Required (Autentisering kreves) – hvis institusjonen din krever
kontoautentisering, må du sjekke at denne avmerkingsboksen er merket.

n User Name (Brukernavn) – navnet på den autentiserte kontoen. Dette er påkrevd kun
dersom Authentication Required (Autentisering kreves) er valgt.

n Password (Passord) – passordet for den autentiserte kontoen. Dette er påkrevd kun dersom
Authentication Required (Autentisering kreves) er valgt.

3. Skriv inn en gyldig e-postadresse i tekstboksen Test Email Address (Test e-postadresse) og klikk
på Test Email (Test e-post) for å verifisere at SMTP-serverinnstillingene er riktige.

Merknad: Noen SMTP-servere tillater ikke vedlegg, og andre tillater kun vedlegg opptil en
bestemt størrelse. Hvis du planlegger å sende datafiler og/eller rapporter via e-post ved bruk
av CFX Manager Dx, velger du Test Attachment (Test vedlegg) og stiller Attachment Size
(Vedleggsstørrelse) til 5 megabyte (MB) eller mer.

4. Klikk på OK for å lagre endringene og lukke dialogboksen.
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Endre Default File Settings (Standard filinnstillinger)

I fanen Files (Filer) i dialogboksen User Preference (Brukerpreferanse) kan du endre følgende:

n Standardplasseringen for lagring av CFX Manager Dx-filer

n Standardfilene for kjøringsoppsett

n Standardparameterne for filnavngiving

Slik endrer du standard filinnstillinger

1. Velg Users > User Preferences (Brukere > Brukerpreferanser) for å åpne dialogboksen User
Preferences (Brukerpreferanser).

2. I dialogboksen User Preferences (Brukerpreferanser) velger du fanen Files (Filer).

3. I standardmappen for delen File Creation (Filopprettelse) navigerer du til og velger en
standardmappe som du vil lagre nye filer i. Du kan velge forskjellig plassering for hver filtype:

n Protocol (Protokoll)

n Plate

n Data File (Datafil)

n Gene Study (Genstudie)
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4. I delen File Selection for Run Setup (Filvalg for kjøringsoppsett) navigerer du til og velger
målprotokollen og platefilene som skal vises når du åpner vinduet Experiment Setup (Oppsett av
eksperiment).

5. I delen Data File (Datafil) definerer du prefiks og/eller suffiks for datafiler. Velg en ny verdi fra
rullegardinlisten for hver del. Du kan også oppgi egendefinerte prefiks- og suffiksverdier i
tekstboksene Prefix (Prefiks) og Suffix (Suffiks).

CFX Manager Dx viser en forhåndvisning av filnavnet under valgboksene.

6. Klikk på OK for å lagre endringene og lukke dialogboksen.

Viktig: Hvis du klikker på Restore Defaults (Gjenopprett standarder) i dialogboksen User
Preferences (Brukerpreferanser), tilbakestilles alle preferansene i alle faner til de opprinnelige
fabrikkinnstillingene. Utvis forsiktighet når du klikker på denne knappen.

Angi standardparametere for protokoll

Slik stiller du inn standardparametere for protokoll for Protocol Editor
(Protokollredigering) og Protocol AutoWriter (Automatisk protokollskriving)

1. Velg Users > User Preferences (Brukere > Brukerpreferanser) for å åpne dialogboksen User
Preferences (Brukerpreferanser).

2. Velg fanen Protocol (Protokoll) i dialogboksen User Preferences (Brukerpreferanser).
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3. I delen Protocol Editor (Protokollredigering) spesifiserer du verdier for følgende innstillinger som
vises i Protocol Editor (Protokollredigering):

n Sample volume (Prøvevolum) – volumet av hver prøve i brønnene (i µl).

n Lid Shutoff temperature (Lokk-avstengingstemperatur) – temperaturen i ºC der
lokkvarmeren slås av under en kjøring.

4. I delen Protocol AutoWriter (Automatisk protokollskriver) spesifiserer du verdier for følgende
innstillinger som vises i Protocol AutoWriter (Automatisk protokollskriver):

n Annealing temperature (Hybridiseringstemperatur) – temperaturen i ºC for eksperimenter
som bruker iProof™ DNA-polymerase, iTaq™DNA-polymerase eller andre polymeraser.

n Amplicon length (Amplikonlengde) – lengden av amplikonet i basepar (bp).

5. Klikk på OK for å lagre endringene og lukke dialogboksen.

Viktig: Hvis du klikker på Restore Defaults (Gjenopprett standarder) i dialogboksen User
Preferences (Brukerpreferanser), tilbakestilles alle preferansene i alle faner til de opprinnelige
fabrikkinnstillingene. Utvis forsiktighet når du klikker på denne knappen.

Angi standardparametere for plate

Endringer du gjør i fanen Plate, er tilgjengelig for alle brukere av programvaren. Endringer du gjør
under plateoppsettet, er tilgjengelig for alle brukere etter at du har lagret og lukket platefilen.

I dialogboksen User Preferences (Brukerpreferanser) kan du gjøre følgende:

n Angi standardparametere for plate.

n Legge til nye navn på mål og prøver i deres respektive biblioteker.

n Slette navn på mål og prøver fra deres respektive biblioteker.

Slik angir du plateparametere

1. Velg Users > User Preferences (Brukere > Brukerpreferanser) for å åpne dialogboksen User
Preferences (Brukerpreferanser).

2. I dialogboksen User Preferences (Brukerpreferanser) velger du fanen Plate.
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3. Angi verdier for følgende innstillinger for en ny platefil. Disse verdiene vises i vinduet Plate Editor
(Plateredigering):

n Plate type (Platetype)

n Plate size (Platestørrelse)

n Units (Enheter) – konsentrasjonen på start-templatet for brønner som inneholder
standarder.

CFX Manager Dx bruker disse enhetene til å opprette en standardkurve i fanen Data
Analysis Quantification (Dataanalyse for kvantifisering).

n Scientific notation (Vitenskapelig notasjon) – når denne er valgt, viser CFX Manager Dx
konsentrasjonsenhetene i vitenskapelig notasjon.

n Scan mode (Skannemodus) – antall eller type kanaler som skal skannes under en kjøring.

n Fluorophores (Fluoroforer) – standardfluoroforene som vises i kontrollene for brønnfylling i
Plate Editor (Plateredigering).

n Libraries (Bibliotek) – navn på mål og prøver du vanligvis bruker i eksperimentene:

o Target names (Målnavn) – navn på målgener og sekvenser.

o Sample names (Prøvenavn) – navn på eksperimentprøver eller identifiserende
egenskaper for prøvene (for eksempel Mouse1, Mouse2, Mouse3).

4. Klikk på OK for å lagre endringene og lukke dialogboksen.
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Slik legger du til et nytt navn på mål eller prøve

u I den tilsvarende biblioteksboksen skriver du inn navnet formålet eller prøven og klikker på OK.

Slik sletter du et navn på mål eller prøve

u I den tilsvarende biblioteksboksen velger du navnet, trykker på tasten Delete (Slett) og klikker
deretter på OK.

Viktig: Navn du fjerner fra biblioteket, fjernes fra programvaren og er ikke lenger tilgjengelig for
brukere. Klikk på Restore Default (Gjenopprett standarder) for å gjenopprette standard CFX
Manager Dx-navn. Hvis du klikker på Restore Defaults (Gjenopprett standarder) i dialogboksen
User Preferences (Brukerpreferanser), tilbakestilles alle preferansene i alle faner til de
opprinnelige fabrikkinnstillingene. Utvis forsiktighet når du sletter standard CFX Manager Dx-
navn og når du klikker på denne knappen.
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Angi standardparametere for dataanalyse

Slik angir du standardparametere for dataanalyse

1. Velg Users > User Preferences (Brukere > Brukerpreferanser) for å åpne dialogboksen User
Preferences (Brukerpreferanser).

2. I dialogboksen User Preferences (Brukerpreferanser) velger du fanen Data Analysis
(Dataanalyse).

3. I delen Analysis Mode (Analysemodus) velger du modusen du vil bruke til å analysere dataene
(enten Fluorophore (Fluorofor) eller Target (Mål)).

4. I delen PCR Quantification (PCR-kvantifisering) angir du standardparametere for følgende
alternativer:

n Baseline Setting (Baselinjeinnstilling) – baselinjemetoden for analysemodus.

n Cq Determination Mode (Cq-bestemmelsesmodus) – modusen der Cq-verdier beregnes for
hver fluorescenskurve (enten regresjon eller enkel terskel).
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n Threshold Calc. Mode (Modus for terskelberegning) – mengden av endepunktmål.

Standardverdien er Auto (Automatisk). Det vil si at programvaren beregner endepunktmålet
automatisk. Når du vil angi en bestemt terskel, fjerner du merkingen i avmerkingsboksen
Auto (Automatisk) og legger inn endepunktmengden, beregnet i relative fluorescensenheter
(eller RFU). Maksimumsverdien er 65 000,00 RFU. Datafiler for etterfølgende kjøringer vil
bruke denne terskelinnstillingen.

n Baseline Calc. Mode (Modus for baselinjekalkulator) – baselinjeverdien for alle kurver.

Standardverdien er Auto (Automatisk). Det vil si at programvaren beregner baselinjen for alle
kurver automatisk. Når du vil angi en spesifikk baselinjeverdi, fjerner du merkingen i
avmerkingsboksen Auto (Automatisk) og legger inn minimums- og maksimumsverdiene for
syklusområdet (1 til 9999). Datafiler for etterfølgende kjøringer vil bruke dette syklusområdet.

n Log View (Loggvisning) – bestemmer hvordan programvaren viser amplifiseringsdataene:

o On (På) – amplifiseringsdataene vises på en halvlogaritmisk graf.

o Off (Av) – (standard) amplifiseringsdataene vises på en lineær graf.

5. I delen End Point (Endepunkt) velger du antall endesykluser som skal brukes til å finne
gjennomsnitt under beregning av endepunktberegningene:

n PCR – antall endesykluser som skal brukes til å finne gjennomsnitt for kvantifiseringsdata
(standard er 5).

n End Point Only run (Kjøring av kun endepunkt) – antall endesykluser som skal brukes til å
finne endepunktdata (standard er 2).

6. I delen Melt Curve (Smeltekurve) velger du typen topp som skal detekteres (enten positiv eller
negativ).

7. I delen Well Selector (Brønnvelger) velger du hvordan du vil vise brønnetiketter (etter prøvetype,
målnavn eller prøvenavn).

8. Klikk på OK for å lagre endringene og lukke dialogboksen.

Viktig: Hvis du klikker på Restore Defaults (Gjenopprett standarder) i dialogboksen User
Preferences (Brukerpreferanser), tilbakestilles alle preferansene i alle faner til de opprinnelige
fabrikkinnstillingene. Utvis forsiktighet når du klikker på denne knappen.
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Angi standardparametere for datafil for genuttrykk

Slik angir du standardparametere for en ny datafil for genuttrykk

1. Velg Users > User Preferences (Brukere > Brukerpreferanser) for å åpne dialogboksen User
Preferences (Brukerpreferanser).

2. Velg fanen Gene Expression (Genuttrykk) i dialogboksen User Preferences (Brukerpreferanser).

3. Spesifiser verdiene for følgende innstillinger:

n Relative to (I forhold til) – lagrer en graf av genuttrykksdataene i forhold til enten en kontroll
(utgangspunkt 1) eller null:

o Zero (Null) – programvaren ignorerer kontrollen. Dette er standarden når ingen
kontrollprøve er tilordnet i vinduet Experiment Settings (Eksperimentinnstillinger).

o Control (Kontroll) – programvaren beregner dataene i forhold til kontrollprøven tilordnet
i vinduet Experiment Setup (Eksperimentoppsett).

n X-axis (X-akse) – lager en graf av prøven eller målet på x-aksen.

n Y-axis (Y-akse) – lager en graf for lineær, log2- eller log10-skala på y-aksen.

n Scaling (Skalering) – skaleringsalternativet for grafen (standardalternativet er ikke-skalert):

o Highest (Høyest) – programvaren skalerer grafen til det høyeste datapunktet.
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o Highest (Lavest) – programvaren skalerer grafen til det laveste datapunktet.

o Unscaled (Ikke-skalert) – programvaren presenterer dataene som ikke er skalert i
grafen.

n Mode (Modus) – analysemodusen, enten relativ kvantitet (∆Cq) eller normalisert uttrykk
(∆∆Cq).

n Error Bar (Feilsøyle) – datavariabilitet presentert som enten standardavvik (Std. Dev.) eller
standardfeil av gjennomsnitt (Std. Error Mean).

n Error Bar Multiplier (Feillinjemultiplikator) – standardavvikmultiplikatoren som brukes for å
lage en graf av feilsøylene (standard er 1).

Du kan øke multiplikatoren til enten 2 eller 3.

n Sample Types to Exclude (Prøvetyper som skal utelukkes) – prøvetypene som skal
utelukkes fra analysen.

Du kan velge én eller flere prøver som skal utelukkes fra analysen. Du utelukker alle
prøvetyper ved å fjerne eventuelle merker i avmerkingsboksene for valgte prøvetyper.

4. Klikk på OK for å lagre endringene og lukke dialogboksen.

Viktig: Hvis du klikker på Restore Defaults (Gjenopprett standarder) i dialogboksen User
Preferences (Brukerpreferanser), tilbakestilles alle preferansene i alle faner til de opprinnelige
fabrikkinnstillingene. Utvis forsiktighet når du klikker på denne knappen.

Tilpasse regler for kvalitetskontroll

I CFX Manager Dx kan du angi kvalitetskontrollregler som skal brukes på data i vinduet Data Analysis
(Dataanalyse). Programvaren validerer dataene basert på reglene du angir.

Merknad: Alle kvalitetskontrollregler er aktivert som standard.

Tips: I vinduet Data Analysis (Dataanalyse) kan du enkelt utelukke brønner som ikke består en
kvalitetskontrollparameter, fra analysen i QC-modulen.

Slik tilpasser du kvalitetskontrollregler

1. Velg Users > User Preferences (Brukere > Brukerpreferanser) for å åpne dialogboksen User
Preferences (Brukerpreferanser).

2. Velg fanen QC (Kvalitetskontroll) i dialogboksen User Preferences (Brukerpreferanser).

70 | CFX96 Dx- og CFX96 DeepWell Dx-systemet



Før du begynner

der:

n NTC – ikke-templatkontroll

n NRT – uten revers transkriptasekontroll

n Efficiency (Effektivitet) – reaksjonseffektivitet

n Std Curve R^2 (Standardkurve R^2) – R-kvadratverdien for standardkurven

n Replicate group Cq Std Dev (Replikatgruppe Cq standardavvik) – standardavvik beregnet
for hver replikatgruppe

3. Velg én av følgende fremgangsmåter for hver kvalitetskontrollregel:

n Hvis du vil bruke standardverdien, gjør du ingenting.

n Hvis du vil endre verdien, klikker du i tekstboksen Value (Verdi), skriver inn en ny verdi og
trykker på Enter-tasten.

n Hvis du vil deaktivere regelen, fjerner du merket i avmerkingsboksen Use (Bruk).

4. Klikk på OK for å lagre endringene og lukke dialogboksen.

Viktig: Hvis du klikker på Restore Defaults (Gjenopprett standarder) i dialogboksen User
Preferences (Brukerpreferanser), tilbakestilles alle preferansene i alle faner til de opprinnelige
fabrikkinnstillingene. Utvis forsiktighet når du klikker på denne knappen.
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Tilpasse parametere for dataeksport

Du kan eksportere CFX Manager Dx-data i følgende format:

n Tekst (.txt)

n CSV (.csv)

n Excel 2007 (.xlsx)

n Excel 2003 (.xls)

n XML (.xml)

n HTML (.html)

Du kan spesifisere hvilken type data du vil eksportere, og tilpasse utdataene for de eksporterte
dataene.

Slik egendefinerer du parametere for dataeksport

1. Velg Users > User Preferences (Brukere > Brukerpreferanser) for å åpne dialogboksen User
Preferences (Brukerpreferanser).

2. I dialogboksen User Preferences (Brukerpreferanser) velger du fanen Custom Export (Tilpasset
eksport).
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3. I rullegardinmenyen Export Format (Eksportformat) velger du hvilket format du vil eksportere
dataene i.

4. I delen Data to Export (Data som skal eksporteres) merker du avmerkingsboksene eller fjerner
merkingen i avmerkingsboksene for datatypen(e) som skal eksporteres. De valgte elementene
vises i listeboksen Exported Columns (Eksporterte kolonner).

Merknad: Kjøringsinformasjonen er som standard inkludert i toppteksten. Fjern merkingen i
denne avmerkingsboksen hvis du ikke vil inkludere kjøringsinformasjonen.

5. Du kan endre rekkefølgen for hvordan de valgte elementene skal vises i eksportfilen.

I listeboksen Exported Columns (Eksporterte kolonner) merker du elementet og klikker deretter
på pilknappene til venstre for listen for å flytte elementet opp eller ned.

6. Du kan også endre kolonnenavnene for de valgte elementene i den eksporterte filen.

a. Klikk på Customize Column Names (Tilpass kolonnenavn).

Dialogboksen Column Name Customizer (Tilpasning av kolonnenavn) åpnes.

b. For hvert standardkolonnenavn du vil endre, skriver du inn det nye navnet i feltet Custom
Name (Egendefinert navn).

c. Gjør ett av følgende:

n Klikk på OK for å lagre endringene og gå tilbake til fanen Custom Export (Tilpasset
eksport). Det nye navnet vises i parenteser ved siden av standardkolonnenavnet i
listeboksen Exported Columns (Eksporterte kolonner).

n Klikk på Cancel (Avbryt) for å forkaste endringene og gå tilbake til fanen Custom Export
(Tilpasset eksport).

7. Klikk på OK for å lagre endringene og lukke dialogboksen.

Viktig: Hvis du klikker på Restore Defaults (Gjenopprett standarder) i dialogboksen User
Preferences (Brukerpreferanser), tilbakestilles alle preferansene i alle faner til de opprinnelige
fabrikkinnstillingene. Utvis forsiktighet når du klikker på denne knappen.

Opprette en reaksjonsmastermiks
Ved hjelp av CFX Manager Dxs Master Mix Calculator (Mastermiks-kalkulator) kan du enkelt beregne
det påkrevde volumet for hver komponent i mastermiksen. Du kan skrive ut tabellen med
mastermiksberegninger på standardskriveren, og lagre beregningene for hvert mål til senere bruk.

Slik oppretter du en reaksjonsmastermiks ved hjelp av Master Mix Calculator
(Mastermiks-kalkulator)

1. Velg én av følgende fremgangsmåter for å åpne Master Mix Calculator (Mastermiks-kalkulator):
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n Velg Tools > Master Mix Calculator (Verktøy > Mastermiks-kalkulator).

n Klikk på Master Mix Calculator (Mastermiks-kalkulator) på verktøylinjen.

Master Mix Calculator (Mastermiks-kalkulator) vises.

2. I delen Reaction (Reaksjon) velger du en påvisningsmetode:

n SYBR®Green/EvaGreen

n Probes (Prober)

3. Hvis du vil opprette et nytt mål, klikker du på Create New (Opprett ny) i delen Target (Mål). Et nytt
målnavn vises i rullegardinmenyen for mål.

4. (Valgfritt) Slik endrer du standard målnavn:

a. Uthev målets navn i rullegardinmenyen for mål.

b. Skriv inn et nytt målnavn i boksen Target (Mål).

c. Trykk på Enter-tasten.
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5. Juster start- og sluttkonsentrasjonen for forward- og reversprimeren og eventuelle prober.

6. I delen Master Mix Setup (Mastermiks-oppsett) justerer du verdiene for:

n Number of reactions (Antall reaksjoner) som skal kjøres

n Reaction volume per well (Reaksjonsvolum per brønn)

n Template volume (Templatvolum) per brønn

n Supermix concentration (Supermiks-konsentrasjon) per brønn

n Excess reaction volume (Ekstra reaksjonsvolum) per brønn

7. (Valgfritt) Utfør trinn 2–6 for nødvendig antall mål.

8. I delen Choose Target to Calculate (Velg mål som skal beregnes) velger du målet som skal
beregnes.

Tips: Du kan beregne kun ett, flere eller alle mål samtidig.

De beregnede volumene av de påkrevde komponentene for hvert mål som er valgt, vises i
mastermikstabellen.

9. Klikk på Set as Default (Angi som standard) for å angi kvantitetene som er lagt inn i delene Target
(Mål) og Master Mix Setup (Mastermiks-oppsett), som nye standarder.

10. Klikk på OK for å lagre innholdet i dialogboksen Master Mix Calculator (Mastermiks-kalkulator).

Slik skriver du ut tabellen med mastermiksberegninger

u Klikk på Print (Skriv ut) for å skrive ut tabellen med mastermiksberegninger.

Tabellen med beregninger skrives ut på standardskriveren.

Slik lagrer du tabellen med mastermiksberegninger som en PDF

u Endre standardskriveren til en PDF-driver og klikk på Print (Skriv ut) i Master Mix Calculator
(Mastermiks-kalkulator).

Slik sletter du mål

u Velg målet i rullegardinmenyen for mål og klikk på Remove (Fjern).

Viktig: Når du fjerner et mål fra mållisten, fjernes det også fra alle mastermiksberegninger
det er blitt brukt i. Utvis forsiktighet når du sletter et mål.
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Kalibrere nye fargestoffer
CFX96™Dx-systemene kalibreres på fabrikken for vanlige fluoroforer i plater med hvite og
gjennomsiktige brønner. Tabell 11 viser fluoroforene og kanalen som hvert instrument er kalibrert for.

Merknad: CFX96-systemene har også en kanal som er dedikert til FRET-kjemi. Denne kanalen
krever ikke kalibrering for bestemte fargestoffer.

Fluoroforer Kanaler Eksitasjon, nm Påvisning, nm

FAM, SYBR® Green I 1 450–490 515–530

VIC, HEX, CAL Fluor Gold 540, Cal
Fluor Orange 560

2 515–535 560–580

ROX, Texas Red, CAL Fluor Red 610,
TEX 615

3 560–590 610–650

CY5, Quasar 670 4 620–650 675–690

Quasar 705, Cy5.5 5 672–684 705–730

Tabell 11. Fabrikkalibrerte fluoroforer og kanaler

Slik kalibrerer du nye fargestoffer for CFX-systemene

1. Velg et målinstrument i ruten Detected Instruments (Detekterte instrumenter) i startvinduet.

2. Velg Tools > Calibration Wizard (Kalibreringsveiviser) for å åpne veiviseren for Dye Calibration
(Kalibrering av fargestoff).

Fluoroforer som allerede er kalibrert for målinstrumentet, vises i tabellen Calibrated Fluorophores
(Kalibrerte fluoroforer).

76 | CFX96 Dx- og CFX96 DeepWell Dx-systemet



Før du begynner

3. Velg fluoroforen du vil kalibrere fra rullegardinmenyen i delen Calibrate New (Kalibrer nytt) eller
Existing Fluorophores (Eksisterende fluoroforer).

Hvis fluorofornavnet ikke står på listen, skriver du det inn i tekstboksen for å legge det til på listen.

4. Velg platetypen for fluoroforen.

Hvis platetypen ikke står på listen, skriver du det inn i tekstboksen for å legge den til på listen.

5. Velg en kanal for fluoroforen.

6. Velg en platekolonne for fluoroforen.

7. (Valgfritt) Skriv inn en farge som skal knyttes til fluoroforen.

8. Klikk på Add to Plate (Legg til i plate) for å legge til fluoroforen.

9. (Valgfritt) Gjenta trinn 3–8 for å legge til hvert av fluoroforene du skal kalibrere for platen.

10. Når du er ferdig å legge til fluoroforer, klikker du på View Plate (Vis plate) for å åpne vinduet Pure
Dye Plate Display (Visning av ren fargestoffplate).

Bruk dette vinduet som en veiledning for å tilsette fargestoffene i platene.

11. Klargjør en 96-brønnplate for fargestoffkalibrering:

a. Pipetter fargestoffløsning i hver brønn, og følg mønsteret vist i vinduet Pure Dye Plate
Display (Visning av ren fargestoffplate).

b. For hvert fluorofor fyller du 50 µl (96-brønnplate) 300 nm fargestoffløsning i fire brønner. Vær
oppmerksom på at minst halve platen inneholder blanke brønner.

c. Forsegle platen ved bruk av forseglingsmetoden du vil bruke i eksperimentet.

12. Sett kalibreringsplaten i blokken og lukk lokket.

13. Klikk på Calibrate (Kalibrer) i veiviseren for Dye Calibration (Kalibrering av fargestoff), og klikk
deretter på OK for å bekrefte at platen er i blokken.

14. Når CFX Manager Dx-programvaren fullfører en kalibreringskjøring, vises en dialogboks. Klikk på
Yes (Ja) for å fullføre kalibreringen og åpne Dye Calibration Viewer (Visningsprogram for
fargestoffkalibrering).

15. Klikk på OK for å lukke vinduet.
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En protokoll er et sett med trinn som utføres i en bestemt sekvens. I CFX Manager™ Dx-
programvaren er alle trinnene tilknyttet alternativene på instrumentet. For eksempel gir trinnene
instruksjoner til instrumentet om å kontrollere blokk- og lokktemperatur, bruke en temperaturdifferanse
over hele blokken, utføre en plateavlesning eller utføre en smeltekurveanalyse. Hvert alternativ angis
for ulike plate- og kjøringstyper.

CFX Manager Dx har to alternativer for oppretting av protokoller: Protocol Editor (Protokollredigering)
og Protocol AutoWriter (Automatisk protokollskriving).

Protocol Editor (Protokollredigering) har følgende:

n standardprotokoller for rask oppretting av protokoller

n mulighet til raskt å beregne en gradient for valgt antall rader

n mulighet til raskt å beregne kjøretid for valgt platetype

n mulighet til å redigere protokolltrinn

n mulighet til å lagre protokoller for gjenbruk

n mulighet til å skrive ut protokollen på en standardskriver

I henhold til parameterne du angir, genererer Protocol AutoWriter (Automatisk protokollskriving)
automatisk en tilpasset PCR-protokoll med varmstart, innledende denaturering, hybridisering og
forlengelsestrinn. Du kan deretter se en grafisk representasjon av den foreslåtte protokollen og
redigere, kjøre eller lagre protokollen.
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Vinduet Protocol Editor (Protokollredigering)
Bruk Protocol Editor (Protokollredigering) til å opprette, åpne, se gjennom og redigere en protokoll.
Som standard åpnes Protocol Editor (Protokollredigering) og viser en generell 2-trinns
sanntidsprotokoll for en plate med 96 brønner.

1. Menylinjen gir hurtigtilgang til menykommandoene File (Fil), Settings (Innstillinger) og Tools
(Verktøy).

2. Verktøylinjen gir hurtigtilgang til funksjoner for når du vil lagre og skrive ut protokollen,
bestemme hvor du skal sette inn et trinn, angi prøvevolum og vise estimert kjøretid for
protokollen.

3. Hovedruten viser en grafisk fremstilling av protokollen.

4. Den nedre ruten viser protokollutkastet.

5. Venstre rute viser protokollkontroller du kan legge til for å tilpasse protokollen.

FORKLARING
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Kommandoer i menyen File (Fil)
Save (Lagre) – lagrer den gjeldende protokollen.

Save As (Lagre som) – lagrer den gjeldende protokollen med et nytt navn eller på en ny plassering.

Close (Lukk) – Lukker Protocol Editor (Protokollredigering).

Kommandoer i menyen Settings (Innstillinger)
Lid Settings (Lokkinnstillinger) – åpner dialogboksen Lid Settings (Lokkinnstillinger), der du kan
endre eller angi lokktemperaturen.

Kommandoer i menyen Tools (Verktøy)
Gradient Calculator (Gradientkalkulator) – åpner en dialogboks, der du kan velge blokktype for et
gradienttrinn. Standard er 96 brønner.

Run time Calculator (Kjøretidskalkulator) – åpner en dialogboks, der du kan velge platetype og
skannemodus for å beregne estimert kjøretid i vinduet Run Setup (Kjøringsoppsett). Standard er 96
brønner, alle kanaler.

Kommandoer på verktøylinjen

– lagrer den gjeldende protokollfilen.

– skriver ut det valgte vinduet.

– bruk denne kommandoen til å velge hvor du vil sette inn trinn i forhold til det
valgte trinnet.

– bruk denne kommandoen for å legge inn et prøvevolum i µl.
Prøvevolumene varierer etter blokktype:

n For en blokk med 96 dype brønner er området 0–125 µl.

n For en blokk med 96 brønner er området 0–50 µl.
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– viser estimert kjøretid basert på protokolltrinnene, rampehastigheten og
valgt blokktype.

– viser informasjon om protokoller.

Kontroller for protokollredigering
Venstre rute i vinduet Protocol Editor (Protokollredigering) består av kontroller du kan bruke til å
opprette protokoller.

Hver kontroll består av et sett parametere som representerer et trinn i protokollen. Du kan modifisere
hver parameter og legge til eller fjerne dem for å tilpasse protokollen. Dette avsnittet beskriver
alternativene i hver av kontrollene.

n Insert Step (Sett inn trinn) – setter inn et trinn før eller etter det valgte
trinnet. Du kan redigere verdiene for temperatur og holdetid, i
protokollens grafiske visning eller i protokollutkastet.

n Insert Gradient (Sett inn gradient) – setter inn et gradienttrinn basert
på typen brønnblokk valgt i gradientkalkulatoren. Du kan redigere
gradientområdet i ruten Gradient, som vises når du setter inn et
gradienttrinn.

n Insert GOTO (Sett inn Gå til) – setter inn et syklustrinn (sløyfe), som
informerer programvaren om å gjenta spesifikke trinn i sekvensen for
et angitt antall sykluser. Gjentakelsene starter når den første
syklusen er fullført. Du kan for eksempel informere programvaren om

å utføre 39 gjentakelser av trinn 2–4. Etter den siste gjentakelsen har programvaren utført trinn 2–
4 totalt 40 ganger. Du kan redigere gå-tilbake-til (GOTO (Gå til)-trinnet og antall sykluser i
protokollens grafiske visning eller i protokollutkastet.

n Insert Melt Curve (Sett inn smeltekurve) – setter inn et trinn for avlesning av smeltekurve.

n Insert Plate Read to Step (Sett inn plateavlesning i et trinn) – legger til en kommando for
plateavlesning i det valgte trinnet. En plateavlesning måler mengden fluorescense på slutten av
en syklus. Trinnet for plateavlesning er vanligvis det siste trinnet i en GOTO (Gå til)-sløyfe.

Tips: Når du har lagt til en plateavlesningskommando i et trinn, endres knappen til Remove
Plate Read (Fjern plateavlesning) når du velger trinnet.
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n Remove Plate Read (Fjern plateavlesning) – fjerner en kommando for plateavlesning i det valgte
trinnet.

Tips: Når du har fjernet en plateavlesningskommando i et trinn, endres knappen til Add Plate
Read (Legg til plateavlesning) når du velger trinnet.

n Step Options (Trinnalternativer) – åpner dialogboksen Step Options (Trinnalternativer) og viser
de tilgjengelige alternativene for det valgte trinnet. Se Step Options (Trinnalternativer) på side 83
for detaljert informasjon om trinnalternativene.

Tips: Du kan også åpne Step Options (Trinnalternativer) ved å høyreklikket på trinnet i den
grafiske visningen.

n Delete Step (Slett trinn) – sletter det valgte trinnet fra protokollen.

Step Options (Trinnalternativer)

Åpne dialogboksen Step Options (Trinnalternativer) for å vise alternativene du kan legge til, endre
eller fjerne fra et trinn.

n Plate Read (Plateavlesning) – når dette alternativet er valgt, legges det til en plateavlesning i
trinnet.

n Temperature (Temperatur) – angir måltemperaturen for det valgte trinnet.

n Gradient – angir gradientområdet for trinnet. Området er 1–24 °C.

Merknad: En gradient kjøres med lavest temperatur fremst i blokken (i dette bildet, rad H) og
høyest temperatur bakerst i blokken (i dette bildet, rad A).
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n Increment (Inkrement) – hvor mye temperaturen skal økes (eller reduseres) med i det valgte
trinnet. Denne verdien legges til måltemperaturen i hver syklus. Området er ±0,1–10 °C.

Merknad: Hvis du vil redusere temperaturen, skriver du inn et minustegn (–) foran den
numeriske verdien (for eksempel –5 °C).

n Ramp Rate (Rampehastighet) – rampehastigheten for det valgte trinnet. Området avhenger av
blokkstørrelsen.

n Time (Tid) – holdetiden for det valgte trinnet.

n Extend (Utvid) – tidsperioden (i sekunder) som det valgte trinnet skal utvides eller reduseres
med. Dette alternativet legges til holdetiden i hver syklus. Området er 1–60 sek.

n Beep (Pip) – når dette alternativet er valgt, høres det et pip når trinnet er ferdig.

Tips: Når du legger inn et tall som er utenfor alternativets område, vil programvaren endre
tallet til det nærmeste tallet innenfor området.
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Opprette en protokoll i Protocol Editor (Protokollredigering)
Du kan bruke Protocol Editor (Protokollredigering) til å opprette egendefinerte protokollfiler. Du kan
også redigere og lagre tidligere lagrede protokollfiler eller prøveprotokollfiler som leveres sammen
med CFX Manager Dx-programvaren.

Du oppretter en ny protokollfil på følgende måte:

n Åpne en protokollfil i Protocol Editor (Protokollredigering).

Tips: Du kan åpne en ny eller eksisterende protokoll i Protocol Editor (Protokollredigering)

n Sett opp den nye protokollen.

n Legg til trinn i protokollen via ruten for protokollkontroller.

n Rediger egenskapene for trinnene.

n Lagre protokollen.

Tips: Se Åpne en eksisterende protokoll i Protocol Editor (Protokollredigering) på side 87 for å
opprette en ny protokoll fra en tidligere lagret protokollfil eller en prøveprotokollfil.

Åpne en ny protokollfil i Protocol Editor (Protokollredigering)
CFXManager Dx har flere alternativer for å åpne en ny protokollfil:

n Fra startvinduet

n Fra dialogboksen Startup Wizard (Oppstartsveiviser)

n Fra dialogboksen Run Setup (Kjøringsoppsett)

Slik åpner du en ny protokollfil fra startvinduet

u Velg File > New > Protocol (Fil > Ny > Protokoll).

Vinduet Protocol Editor (Protokollredigering) åpnes og viser standardprotokollfilen.

Tips: For informasjon om innstilling av standardprotokoll, se Endre Default File Settings
(Standard filinnstillinger) på side 62.

Brukerhåndbok | 85



Kapittel 6 Opprette protokoller

Slik åpner du en ny protokollfil fra Startup Wizard (Oppstartsveiviser)

1. Gjør ett av følgende i startvinduet for å åpne Startup Wizard (Oppstartsveiviser) hvis den ikke
vises:

n Velg View > Startup Wizard (Vis > Oppstartsveiviser).

n Klikk på Startup Wizard (Oppstartsveiviser) på verktøylinjen.

Som standard viser Startup Wizard (Oppstartsveiviser) fanen Run (Kjøring) med CFX96™-
instrumenttypen valgt.

2. Velg om nødvendig instrumenttypen fra rullegardimenyen.

3. Klikk på User-defined (Brukerdefinert) som kjøringstypen.

Dialogboksen Run Setup (Kjøringsoppsett) åpnes og viser fanen Protocol (Protokoll), som viser
standardprotokollfilen.

4. Klikk på Create New (Opprett ny).

Vinduet Protocol Editor (Protokollredigering) åpnes og viser standardprotokollen for sanntid.

Slik åpner du en ny protokoll fra dialogboksen Run Setup (Kjøringsoppsett)

1. I startvinduet gjør du ett av følgende for å åpne dialogboksen Run Setup (Kjøringsoppsett):

n Velg Run > User-defined Run (Kjøring > Brukerdefinert kjøring).

n Klikk på User-defined Run Setup (Brukerdefinert kjøringsoppsett) på verktøylinjen.

Dialogboksen Run Setup (Kjøringsoppsett) åpnes og viser fanen Protocol (Protokoll), som viser
standardprotokollfilen.

2. Klikk på Create New (Opprett ny).

Vinduet Protocol Editor (Protokollredigering) åpnes og viser standardprotokollen for sanntid.
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Åpne en eksisterende protokoll i Protocol Editor
(Protokollredigering)
CFXManager Dx inneholder prøveprotokollfiler som du kan redigere og lagre som nye egendefinerte
protokoller. Du kan også opprette en ny protokoll fra en eksisterende egendefinert protokoll.

Slik åpner du en prøveprotokollfil

1. Velg File > Open > Protocol (Fil > Åpne > Protokoll) i startvinduet.

Windows Utforsker åpnes som standard i mappen CFX Manager Dx Sample files (Prøvefiler).

2. Åpne mappen Sample files (Prøvefiler). Mappen inneholder følgende undermapper:

n ConventionalProtocols (Konvensjonelle protokoller) – inneholder eksempelprotokollfiler for
tradisjonell PCR-analyse.

n DataFiles (Datafiler) – inneholder eksempeldatafiler som du kan bruke til å utforske CFX
Manager Dxs funksjoner.

n MeltCalibration (Smeltekalibrering) – inneholder eksempelprotokollfiler for bruk med Bio-
Rads Precision Melt Analysis-programvare.

n Plates (Plater) – inneholder eksempelplatefiler.

n RealTimeProtocols (Sanntidsprotokoller) – inneholder eksempelprotokollfiler for sanntids
PCR-analyse.

3. Åpne protokollmappen for kjøringstypen du har tenkt å utføre, dvs. enten ConventionalProtocols
(Konvensjonelle protokoller) eller RealTimeProtocols (Sanntidsprotokoller).

4. Velg protokollen du vil bruke og klikk på Open (Åpne).

Prøveprotokollen åpnes i vinduet Protocol Editor (Protokollredigering).

5. Velg File > Save As (Fil > Lagre som) og lagre protokollen med et nytt navn eller i en annen
mappe.
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Slik åpner du en eksisterende protokoll

1. Gjør ett av følgende i startvinduet:

n Velg File > Open > Protocol (Fil > Åpne > Protokoll), naviger til og velg ønsket protokoll, og
klikk på Open (Åpne).

n Åpne Startup Wizard (Oppstartsveiviser) og gjør ett av følgende:

o Hvis du vil redigere protokollen som vises, klikker du på Edit Selected (Rediger valgte)

o Hvis du vil redigere en annen eksisterende protokoll, klikker du på Select Existing (Velg
eksisterende) og navigerer til ønsket fil.

Protokollen åpnes i vinduet Protocol Editor (Protokollredigering).

2. Velg File > Save As (Fil > Lagre som) og lagre protokollen med et nytt navn eller i en annen
mappe.

Sette opp en ny protokoll
Tips: Hvis protokollfilen inkluderer de nødvendige parametere (for eksempel hvis du redigerer en
eksisterende platefil), kan du hoppe over denne delen. Fortsett til Legge til trinn i en protokoll på
side 90.

Nye protokollfiler krever følgende parametere:

n Block type (Blokktype)

n Scan mode (Skannemodus) for den valgte blokktypen

n Lid temperature (Lokktemperatur)

n Sample volume (Prøvevolum)

Angi Block Type (Blokktype)

CFXManager Dx beregner automatisk temperaturøkninger for gradienttrinn basert på blokktypen.

Merknad: Platetypen som angis i Protocol Editor (Protokollredigering), må være den samme som
platen i reaksjonsmodulen.

Slik angir du blokktype

u I vinduet Protocol Editor (Protokollredigering) velger du Tools > Gradient Calculator (Verktøy >
Gradientkalkulator). Velg deretter relevant platetype i rullegardinmenyen som vises.

Velge Scan Mode (Skannemodus) for valgt Block Type (Blokktype)

For å bestemme kjøretiden for protokollen velger du ønsket blokktype og skannemodus.
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Slik velger du blokktype og skannemodus

u I vinduet Protocol Editor (Protokollredigering) velger du Tools > Run time Calculator (Verktøy >
Kjøretidskalkulator). Velg deretter relevant platetype og skannemodus i rullegardinmenyen som
vises.

Justere lokktemperaturen

CFXManager Dx bruker en standard lokktemperatur på 105,0 °C.

Du kan endre standardinnstillingene eller slå av lokkvarmeren avhengig av hva som kreves av
protokollen.

Tips: Du kan endre standard lokktemperatur i dialogboksen User Preferences
(Brukerpreferanser). Se Angi standardparametere for protokoll på side 63.

Slik justerer du lokktemperaturen

1. I vinduet Plate Editor (Plateredigering) velger du Settings > Lid Settings (Innstillinger >
Lokkinnstillinger).

Dialogboksen Lid Settings (Lokkinnstillinger) vises.

2. Gjør ett av følgende:

n Velg User Defined (Brukerdefinert) og legg inn en temperaturverdi i tekstboksen.

n Velg Turn Off Lid Heater (Slå av lokkvarmer).

3. Klikk på OK for å bekrefte endringene og lukke dialogboksen.

Angi Sample Volume (Prøvevolum)

Som standard angir CFX Manager Dx prøvevolumet for hver brønn til 25 µl. CFX Dx-systemet-
området er 0–125 µl.

Instrumentet bruker én av to moduser for temperaturkontroll for å bestemme når prøven når
måltemperaturen i en protokoll:

n Calculated mode (Beregningsmodus) – når prøvevolumet er satt til et volum som er egnet for
blokken, beregner instrumentet prøvetemperaturen basert på prøvevolumet. Dette er
standardmodusen.

n Block mode (Blokkmodus) – når prøvevolumet er satt til null (0) µl, registrerer instrumentet
prøvetemperaturen som den samme som den målte blokktemperaturen.
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Slik angir du prøvevolumet for en spesifikk blokk

u Skriv inn den riktige verdien i tekstboksen Sample Volume (Prøvevolum) på verktøylinjen i
vinduet Plate Editor (Plateredigering).

Tips: Du kan endre standard prøvevolum i dialogboksen User Preferences (Brukerpreferanser).
Se Endre Default File Settings (Standard filinnstillinger) på side 62.

Legge til trinn i en protokoll
Slik legger du til et trinn i en protokoll

1. Åpne protokollen i vinduet Protocol Editor (Protokollredigering).

2. Velg hvor det nye trinnet skal settes inn. På verktøylinjen velger du Before (Før) eller After (Etter) i
rullegardinmenyen Step (Trinn).

3. På grafen velger du trinnet før eller etter der du vil sette inn det nye trinnet.

4. Klikk på Insert Step (Sett inn trinn) i ruten til venstre.

5. Hvis du vil endre temperaturen eller holdetiden, klikker du på standardverdien på grafen eller
protokollutkastet og skriver inn en ny verdi.

6. (Valgfritt) Klikk på Step Options (Trinnalternativer) i ruten til venstre for å vise dialogboksen Step
Options (Trinnalternativer), og endre de tilgjengelige alternative for det valgte trinnet.

Tips: Dialogboksen Step Options (Trinnalternativer) er tilgjengelig via høyreklikkmenyen i
både ruten med grafen og ruten med protokollutkastet.

7. Klikk på OK og klikk så på Yes (Ja) for å lagre endringene i protokollen.

Dialogboksen Save As (Lagre som) vises.

8. Skriv inn et navn på den nye protokollfilen i dialogboksen Save As (Lagre som), og klikk på Save
(Lagre).

Sette inn et gradienttrinn
Slik setter du inn et gradienttrinn

1. Kontroller at platestørrelsen for gradienten er den samme som blokktypen til instrumentet, 96
brønner.

2. Hvis du ikke allerede har gjort det, velger du platestørrelsen for gradienten:

Velg Tools > Gradient Calculator (Verktøy > Gradientkalkulator) og velg ønsket brønntype fra
rullegardinmenyen.
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3. På verktøylinjen velger du enten Before (Før) eller After (Etter) fra rullegardinmenyen Insert Step
(Sett inn trinn).

4. På grafen eller i utkastruten velger du trinnet før eller etter der du vil sette inn gradienttrinnet.

5. Klikk på Insert Gradient (Sett inn gradient) i ruten til venstre. Det nye gradienttrinnet utheves på
grafen og i utkastruten, for eksempel:

Temperaturen i hver rad i gradienten vises i tabellen Gradient i høyre rute.

6. Når du vil redigere temperaturområdet for gradienten, velger du én av følgende fremgangsmåter:

n Klikk på standardtemperaturen på grafen eller i utkastruten, og angi en ny temperatur.

n Klikk på Step Options (Trinnalternativer) for å angi gradientområdet i vinduet Step Options
(Trinnalternativer).

n Endre områdeverdien i tabellen Gradient.

7. Når du vil redigere holdetiden, klikker du på standardtiden i grafikk- eller tekstvisningen og angir
en ny tid.

8. Klikk på OK og deretter på Yes (Ja) for å lagre endringene.
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Sette inn et GOTO-trinn
Merknad: Du kan ikke sette inn et GOTO-trinn i et GOTO-sett, og du kan ikke opprette nøstede
GOTO-løkker.

Slik setter du inn et GOTO-trinn

1. På verktøylinjen velger du Before (Før) eller After (Etter) i rullegardinmenyen Insert Step (Sett inn
trinn).

2. I grafen velger du trinnet før eller etter der du vil sette inn GOTO-trinnet.

3. Klikk på Insert GOTO (Sett inn GOTO) i ruten til venstre.

4. Hvis du vil redigere GOTO-trinnummeret eller antall GOTO-gjentakelser, velger du
standardverdien i grafen eller disposisjonsruten og legger inn en ny verdi.

5. Klikk på OK og deretter på Yes (Ja) for å lagre endringene.

Sette inn et smeltekurvetrinn
Tips: Du kan ikke sette inn et smeltekurvetrinn i en GOTO-løkke.

Merknad: Smeltekurvetrinnet inneholder en 30 sekunders holdetid i begynnelsen av trinnet som
ikke vises i protokollen.

Slik setter du inn et smeltekurvetrinn

1. På verktøylinjen velger du Before (Før) eller After (Etter) i rullegardinmenyen Insert Step (Sett inn
trinn).

2. I grafen velger du trinnet før eller etter der du vil sette inn smeltekurvetrinnet.
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3. Klikk på Insert Melt Curve (Sett inn smeltekurve) i ruten til venstre. Det nye smeltekurvetrinnet
utheves i grafen og disposisjonsruten, for eksempel:

4. Hvis du vil redigere smeltetemperaturområdet eller intervalltiden, velger du standardverdien i
grafen eller disposisjonsruten og legger inn en ny verdi.

5. Klikk på OK og deretter på Yes (Ja) for å lagre endringene.
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Legge til eller fjerne et plateavlesningstrinn
Tips: Når du har lagt til en plateavlesningskommando i et trinn, endres knappen til Remove Plate
Read (Fjern plateavlesning) når du velger trinnet.

Slik legger du til en plateavlesning i et trinn

1. På verktøylinjen velger du Before (Før) eller After (Etter) i rullegardinmenyen Insert Step (Sett inn
trinn).

2. På grafen velger du trinnet før eller etter der du har å tenkt å sette inn plateavlesningstrinnet.

3. I venstre rute klikker du på Add Plate Read to Step (Legg til plateavlesning i trinn) for å legge til en
plateavlesning i det valgte trinnet.

4. Klikk på OK og deretter på Yes (Ja) for å lagre endringene.

Slik fjerner du en plateavlesning fra et trinn

u På grafen velger du trinnet som inneholder plateavlesningen, og klikker på Remove Plate Read
(Fjern plateavlesning) i venstre rute.

Endre trinnalternativer
Slik endrer du trinnalternativer for et valgt trinn

1. Velg måltrinnet på grafen eller i utkastruten.

2. Klikk på Step Options (Trinnalternativer) i ruten til venstre for å vise dialogboksen Step Options
(Trinnalternativer).

Du kan også klikke på måltrinnet i enhver rute og velge Step Options (Trinnalternativer) i menyen
som åpnes.

3. Slik kan du legge til, endre eller fjerne alternativer:

n Angi en verdi i den relevante tekstboksen.

n Rediger en verdi i den bestemte tekstboksen.

n Merk eller fjern merkingen i en avmerkingsboks.

4. Klikk på OK for å lagre endringene og lukke dialogboksen Step Options (Trinnalternativer).

5. Klikk på OK og deretter på Yes (Ja) for å lagre protokollen.
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Slette et trinn
Slik sletter du et trinn i protokollen

1. Velg et trinn i diagrammet eller disposisjonsruten.

2. I venstre rute klikker du på Delete Step (Slett trinn) for å slette det valgte trinnet.

3. Klikk på OK og deretter på Yes (Ja) for å lagre protokollen.

Kopiere, eksportere eller skrive ut en protokoll
Slik kopierer du en protokoll

u Høyreklikk på protokollutkastet og velg Copy Protocol (Kopier protokoll).

Utkastet kan limes inn i en .txt-, .xls-, .doc- eller .ppt-fil.

Slik eksporterer du en protokoll

1. Høyreklikk på protokollutkastet og velg Export Protocol (Eksporter protokoll).

Dialogboksen Save As (Lagre som) vises.

2. (Valgfritt) ÅpneWindows Utforsker og naviger til mappen du vil lagre protokollfilen i.

3. I File name (Filnavn) skriver du inn navnet på den eksporterte protokollfilen.

4. Klikk på Save (Lagre).

Slik skriver du ut en protokoll

u Høyreklikk på protokollutkastet og velg Print (Skriv ut).

Protokollutkastet kan skrives ut på standardskriveren din.
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Opprette en protokoll med Protocol AutoWriter (Automatisk
protokollskriving)

Viktig: Bio-Rad garanterer ikke at kjøring av en protokoll opprettet med Protocol AutoWriter
(Automatisk protokollskriving) alltid vil resultere i et sanntids PCR-produkt.

Protocol AutoWriter (Automatisk protokollskriving) i CFX Manager Dx genererer automatisk
syklusprotokoller basert på de følgende inndataparameterne:

n Amplicon length (Amplikonlengde) – den forventede lengden på PCR-produktet

n Annealing temperature (Hybridiseringstemperatur) – reaksjons-Ta for primerne som brukes

Hvis Ta er ukjent, kan du bruke Ta-kalkulatoren til å beregne den automatisk basert på
primersekvensene.

Merknad: Ta justeres ut fra informasjonen om smeltetemperatur (Tm) for primer, som er
basert på det valgte enzymet og protokollhastigheten.

n Enzyme type (Enzymtype) – DNA-polymeraseenzymet (iTaq™, iProof™ DNA-polymerase eller
annet)

Hvis du bruker et annet enzym enn iTaq eller iProof DNA-polymerase, kan du legge inn ytterligere
informasjon, inkludert gradientområde, varmstart-aktiveringstid (i sek) og endelig forlengelsestid
(i sek).

n Run speed (Kjøringshastighet) – reaksjonshastigheten (standard, rask eller ultrarask)

Protocol AutoWriter (Automatisk protokollskriving) optimerer protokollen avhengig av den valgte
hastighetsinnstillingen. Den totale kjøringstiden er avhengig av antallet trinn og sykluser,
inkuberingstiden på hvert trinn og tiden det tar å nå ensartethet ved måltemperaturen.

I henhold til parameterne du angir og standard PCR-retningslinjer genererer Protocol AutoWriter
(Automatisk protokollskriving) automatisk en tilpasset PCR-protokoll med varmstart, innledende
denaturering, hybridisering og forlengelsestrinn. Du kan deretter se en grafisk representasjon av den
foreslåtte protokollen og redigere, kjøre eller lagre protokollen.
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Slik oppretter du en ny protokoll med Protocol AutoWriter (Automatisk
protokollskriving) i CFX Manager Dx

1. I startvinduet velger du Tools > Protocol AutoWriter (Verktøy > Automatisk protokollskriving).

Dialogboksen Protocol AutoWriter (Automatisk protokollskriving) vises.

2. I delen Enter Target Values/Enzyme (Angi målverdier/enzym) gjør du følgende:

n Angi hybridiseringstemperaturen (Ta) for primerne, hvis kjent.

Tips: Se Bruke Ta Calculator (Ta-kalkulator) på side 98 for mer informasjon.

Merknad: For informasjon om beregningene som brukes i Ta-kalkulatoren, se Breslauer
et al. 1986.

n Angi Amplicon length (Amplikonlengde) i basepar (bp).

n Velg en enzymtype fra listen over alternativer (iTaq™DNA polymerase (iTaq™DNA-
polymerase), iProof™ DNA polymerase (iProof™ DNA-polymerase) eller Other (Annet)).

Tips: Hvis du velger Other (Annet) som enzymtypen, aktiveres parameterne i delen
Additional Parameters (Optional) (Ytterligere parametere (valgfritt)).
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3. Hvis du valgte Other (Annet) som enzymtypen, kan du legge til en eller flere av følgende
parametere i protokollen:

n Gradient range (Gradientområde)

n Hot start activation temperature (Varmstart-aktiveringstemperatur)

n Final extension time (Endelig forlengelsestid)

4. I delen Type beveger du glidebryteren for å velge en protokollhastighet (Standard, Fast (Rask)
eller Ultrafast (Ultrarask)). CFX Manager Dx justerer den totale kjøringstiden.

5. Velg typen PCR som skal utføres (sanntids-PCR er standardinnstillingen).

Med sanntids-PCR legger CFX Manager Dx til et plateavlesningstrinn for å samle inn
fluorescensdata.

6. Gå gjennom protokollen i delen Preview (Forhåndsvisning). Du kan gjøre endringer ved behov.

7. Gjør ett av følgende:

n Klikk på OK for å lagre den nye protokollen. Etter lagring åpnes protokollen i Startup Wizard
(Oppstartsveiviser). Klikk på Edit Selected (Rediger valgte) for å gjøre endringer i
protokollen. Du kan for eksempel endre lokktemperaturen og prøvevolumet.

n Klikk på Cancel (Avbryt) for å lukke vinduet uten å lagre protokollen.

Bruke Ta Calculator (Ta-kalkulator)
Når hybridiseringstemperaturen for primeren er ukjent, kan du bruke Ta Calculator (Ta-kalkulator) til å
beregne verdien. Du kan bruke verdien i Protocol AutoWriter (Automatisk protokollskriving) eller
Protocol Editor (Protokollredigering) til å opprette protokollen.

Om Ta-kalkulatoren
Ta-kalkulatoren beregner Tm-verdien for hver primer samt Ta-verdien for protokollen ved standard
hastighet.

Ta for protokollen er basert på de gjennomsnittlige Tm-primerverdiene med følgende regler anvendt:

n Hvis forskjellen mellom Tm-primerverdiene er >4 °C, er Ta = (den laveste av de to Tm-
primerverdiene + 2) – 4 °C

n Hvis forskjellen mellom Tm-verdiene er ≤4 °C, er Ta = (gjennomsnittet av Tm-primerverdiene) –
4 °C
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Metode for telling av basepar

For hver primer bruker Ta Calculator (Ta-kalkulator) metoden for telling av basepar for sekvenser på
14 basepar (bp) eller færre.

Tm = ((w*A + x*T) * 2) + ((y*G + z*C) * 4)

der w, x, y og z er antallet av henholdsvis basene A, T, G og C i sekvensen.

Nærmeste nabo-metoden

For sekvenser som er lengre enn 14 bp, brukes nærmeste nabo-metoden. Med næmeste nabo-
metoden er beregningene for smeltetemperatur basert på det termodynamiske forholdet mellom
entropi (orden eller måling av randomiteten til oligonukleotiden), entalpi (varme avgitt eller absorbert
av oligonukleotiden), fri energi og temperatur.

∆H = ∆G + T* ∆S

der:

n ∆H = Entalpiverdi, cal/mol*K

n T = Temperatur, kelvin

n ∆S = Entropiverdi, cal/mol*K

n ∆G = Gibbs fri energi i cal/omol*K

Endringen i entropi og entalpi beregnes direkte ved å legge sammen verdiene for nukleotidparene
som vises i Tabell 12 (Breslauer et al. 1986).

Forholdet mellom fri energi og konsentrasjon av reaktanter og produkter ved likevekt beregnes slik:

∆G = R*T*ln ((DNA * Primer)/(DNA + Primer))

der R er gasskonstanten (1,986 cal/mol*K).

Ved å substituere G i de to ligningene og løse på T får man

T = ∆H/(∆S + R*Ln((DNA * Primer)/(DNA + Primer)))

med forbehold om at konsentrasjonen av DNA og DNA-primer-kompleks er lik.

Det er fastslått empirisk at det er en endring på 5 kcal fri energi (3,4 kcal) (Sugimoto et al. 1996) under
overgangen fra enkeltrådet til B-formet DNA. Dette er antageligvis energien for heliksinitiering. Til slutt
legger man til en justering for salt for å få ligningen som Ta-kalkulatoren bruker:

T = (∆H – 5(kcal/K*mol))/(∆S + (R * ln(1/(primer)))) + 16,6 log10 (Saltmolaritet)
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Ingen justeringskonstant for saltkonsentrasjon trengs, da de ulike parameterne ble bestemt ved
1 M NaCl og log10 av 1 er null.

De termodynamiske beregningene antar at hybridisering skjer ved pH 7,0. Tm-beregningene antar at
sekvensene ikke er symmetriske og inneholder minst én G eller C.

Oligonukleotidsekvensen skal være minst 14 baser lang for å få rimelige Tm-verdier. Hvis det er
mindre enn 14 baser, brukes metoden for telling av basepar (se Tabell 12 nedenfor).

Interaksjon ∆H ∆S ∆G

AA TT 9,1 24 1,5

AT TA 8,6 23,9 1,5

AC TG 6,5 17,3 1,3

AG TC 7,8 20,8 1,6

TA AT 6 16,9 0,9

TT AA 9,1 24 1,9

TC AG 5,6 13,5 1,6

TG AC 5,8 12,9 1,9

CA GT 5,8 12,9 1,9

CT GA 7,8 20,8 1,6

CC GG 11 26,6 3,1

CG GC 11,9 27,8 3,6

GA CT 5,6 13,5 1,6

GT CA 6,5 17,3 1,3

GC CG 11,1 26,7 3,1

GG CC 11 26,6 3,1

Tabell 12. Breslauer-interaksjonskonstanter
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Bruke Ta Calculator (Ta-kalkulator)

Slik bruker du Ta Calculator (Ta-kalkulator)

1. Velg én av følgende fremgangsmåter for å åpne Ta Calculator (Ta-kalkulator):

n Klikk på Ta Calculator (Ta-kalkulator) hvis du arbeider i Protocol AutoWriter (Automatisk
protokollskriving).

n Velg Tools (Verktøy) > Ta Calculator (Ta-kalkulator) i startvinduet.

Dialogboksen Ta Calculator (Ta-kalkulator) vises.

2. I tekstboksen Forward Primer (Forward-primer) skriver eller limer du inn forward-
primersekvensen.

Tips: Du kan også bruke knappene A, T, G og C på venstre side av dialogboksen til å legge
inn sekvensen.

3. Skriv eller lim inn revers-primersekvensen i tekstboksen Reverse Primer (Revers-primer).
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4. Klikk på Calculate (Beregn).

Ta Calculator (Ta-kalkulator) beregner og viser Tm for hver primer og gjennomsnittlige Tm- og Ta-
verdier, for eksempel:

Hvis primer Tm-verdiene er mer enn 4 °C fra hverandre, bruker Protocol AutoWriter (Automatisk
protokollskriving) den laveste primer Tm-verdien + 2 °C som grunnlag for å beregne Ta-verdien,
som du kan modifisere ytterligere ved å endre enzym og reaksjonshastighet.

Ta Calculator (Ta-kalkulator) genererer en hybridiseringstemperatur for standardhastighet med
iTaq DNA-polymerase. Når du bruker et annet enzym, vil hastighetsinnstillingene automatisk
justere Ta.

5. Gjør ett av følgende:

n Hvis du åpnet Ta Calculator (Ta-kalkulator) fra Protocol AutoWriter (Automatisk
protokollskriving), klikker du på OK. Du kommer da tilbake til Protocol AutoWriter (Automatisk
protokollskriving). Hybridiseringstemperaturen endres automatisk.

n Hvis du åpnet Ta Calculator (Ta-kalkulator) fra menyen Tools (Verktøy), registrerer du
beregningene og klikker på Cancel (Avbryt) for å lukke kalkulatoren.
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En platefil inneholder informasjon om kjøringsparametere slik som skannemodus, fluoroforer og
brønninnhold. Etter kjøringen vil CFX Manager™ Dx-programvaren knytte brønninnholdet til
fluorescensdataene innsamlet under kjøringen, og bruke egnet analyse i vinduet Data Analysis
(Dataanalyse). Brønner som for eksempel er lastet med standard prøvetype, brukes til å generere en
standardkurve.

CFX Manager Dx-programvaren har to alternativer for opprettelse av plater: Plate Editor
(Plateredigering) for sanntids-PCR-kjøringer og Setup Wizard (Oppsettsveiviser) for analyser av
normalisert genuttrykk.

Plate Editor (Plateredigering) inkluderer følgende funksjoner:

n Standard fluoroforer og prøvetyper for tilordning til platebrønner

n Mulighet til å angi referansemål og kontrollprøve for genuttrykksanalyse

n Mulighet til å redigere plateoppsett før, under eller etter en kjøring

n Mulighet til å lagre platefiler for gjenbruk

n Mulighet til å skrive ut platefilen på en standardskriver

Setup Wizard (Oppsettsveiviser) veileder deg gjennom opprettelse av plateoppsett for analyse av
normalisert genuttrykk. Du kan bruke Setup Wizard (Oppsettsveiviser) før, under eller etter en kjøring.
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Vinduet Plate Editor (Plateredigering)
Du bruker Plate Editor (Plateredigering) til å opprette egendefinerte plater eller endre eksisterende
plater.

1. Menylinjen gir rask tilgang til menykommandoene File (Fil) og Settings (Innstillinger) så vel
som verktøy for plateredigering.

2. Verktøylinjen gir rask tilgang til viktige plateinnlastingsfunksjoner.

3. Hovedruten viser platedisposisjonen og platealternativene i henhold til gjeldende valg.

4. Høyre rute viser alternativer du kan bruke for å tilpasse platen.

5. Den nederste ruten viser platetypen og gir rask tilgang til visningsalternativer.

FORKLARING
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Kommandoer i menyen File (Fil)
Save (Lagre) – lagrer platedatafilen på plasseringen angitt i fanen File (Fil) i dialogboksen User
Preferences (Brukerpreferanser). Se Endre Default File Settings (Standard filinnstillinger) på side 62
for mer informasjon. Dette menyelementet er kun tilgjengelig når du oppretter en ny platefil.

Save As (Lagre som) – lagrer den åpne platedatafilen med et nytt navn, som du selv angir. Dette
menyelementet er kun tilgjengelig når du oppretter en ny platefil.

Extract Plate (Hent ut platefil) – åpner en dialogboks, der du kan hente ut / lagre platefilen (.pltd).
Dette menyelementet er kun tilgjengelig når du viser eller redigerer en eksisterende platefil.

Print (Skriv ut) – skriver ut den åpne platedatafilen.

Close (Lukk) – lukker Plate Editor (Plateredigering).

Kommandoer i menyen Settings (Innstillinger)
Plate Size (Platestørrelse) – inneholder alternativer du kan bruke til å velge en platestørrelse for
kjøringen.

Merknad: CFX Dx-systemet kan kun bruke en plate med 96 brønner.

Plate Type (Platetype) – brukes til å velge brønntypen i platen som inneholder prøvene, enten BR
White (BR hvit) eller BR Clear (BR klar). For å sikre nøyaktig dataanalyse må den valgte platetypen
være den samme som platetypen som brukes i kjøringen.

Number Convention (Tallkonvensjon) – brukes til å aktivere eller deaktivere alternativet for å vise
enheter i vitenskapelig notasjon. Enheter vises i vitenskapelig notasjon som standard.

Units (Enheter) – brukes til å velge enhetene som skal vises i regnearkene når du utfører
kvantifisering av ukjente kontra en standardkurve.

Kommandoer i menyen Editing Tools (Redigeringsverktøy)
Setup Wizard (Oppsettsveiviser) – åpner Setup Wizard (Oppsettsveiviser), der du kan definere
oppsett og analyseparametere for den gjeldende platen. Du kan bruke Setup Wizard
(Oppsettsveiviser) før, under eller etter at en kjøring er fullført.

Spreadsheet View/Importer (Regnearkvisning/-import) – åpner dialogboksen View (Vis), som viser
plateoppsettet som en mal i regnearkformat. Du kan bruke denne dialogboksen til å eksportere eller
importere platemaldata i .csv-format.

Flip Plate (Snu plate) – snur plateinnholdet 180o.
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Kommandoer på verktøylinjen

Lagrer den gjeldende platefilen.

Viser en rullegardinmeny, der du kan øke eller redusere forstørrelsen av
platevisningen.

Viser en rullegardinmeny, der du kan velge en skannemodus som angir
hvilke kanaler instrumentet skal hente fluorescensdata fra under en kjøring.

Åpner Well Groups Manager (Administrering av brønngrupper), som du kan
bruke til å opprette brønngrupper for den gjeldende platen.

Viser en dialogboks, der du kan velge farger og symboler for
amplifiseringskurvene.

Åpner dialogboksen View (Vis), som viser plateoppsettet som en mal i
regnearkformat. Du kan bruke denne dialogboksen til å eksportere eller
importere platemaldata i .csv-format.

Viser de nødvendige trinnene for å sette opp en plate og fylle brønnene.
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Opprette en platefil ved hjelp av Plate Editor
(Plateredigering)

Du kan bruke Plate Editor (Plateredigering) til å opprette egendefinerte platefiler. Du kan også
redigere og lagre tidligere lagrede platefiler eller prøveplatefiler som leveres sammen med CFX
Manager Dx-programvaren.

Du oppretter en ny platefil på følgende måte:

n Åpne en platefil i Plate Editor (Plateredigering).

n Velg Plate type (Platetype).

Merknad: Plate type (Platetype) for platefilen må være den samme som platen i
reaksjonsmodulen.

n Velg Scan mode (Skannemodus) som skal brukes i protokollen.

n Velg Fluorophores (Fluoroforer) som skal brukes i platen.

n Velg Sample type (Prøvetype), Targets (Mål) og Samples (Prøver).

n Velg replikater, hvis aktuelt.

n Lagre plateoppsettet.

Tips: Se Åpne en eksisterende platefil i Plate Editor (Plateredigering) på side 109 for å opprette
en ny plate fra en tidligere lagret platefil eller en prøveplatefil.

Åpne en ny platefil i Plate Editor (Plateredigering)
CFXManager Dx-programvaren har flere alternativer for å åpne en ny platefil:

n Fra startvinduet

n Fra dialogboksen Startup Wizard (Oppstartsveiviser)

n Fra dialogboksen Run Setup (Kjøringsoppsett)

Slik åpner du en ny platefil fra startvinduet

u Velg File > New > Plate (Fil > Ny > Plate).

Vinduet Plate Editor (Plateredigering) åpnes og viser standard platefil for det valgte instrumentet.

Tips: For informasjon om innstilling av standard platefil, se Endre Default File Settings
(Standard filinnstillinger) på side 62.
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Slik åpner du en ny platefil fra Startup Wizard (Oppstartsveiviser)

1. Gjør ett av følgende i startvinduet for å åpne Startup Wizard (Oppstartsveiviser) hvis den ikke
vises:

n Velg View > Startup Wizard (Vis > Oppstartsveiviser).

n Klikk på Startup Wizard (Oppstartsveiviser) på verktøylinjen.

Som standard viser Startup Wizard (Oppstartsveiviser) fanen Run Setup (Kjøringsoppsett) med
CFX96™-instrumentet valgt.

2. Velg om nødvendig instrumenttypen fra rullegardimenyen.

3. For å opprette en ny plate velger du User-defined (Brukerdefinert) som kjøringstypen.

Dialogboksen Run Setup (Kjøringsoppsett) åpnes og viser fanen Protocol (Protokoll).

4. Klikk på fanen Plate og klikk på Create New (Opprett ny).

Vinduet Plate Editor (Plateredigering) åpnes og viser standard plateoppsett for det valgte
instrumentet.

Slik åpner du en ny platefil fra dialogboksen Run Setup (Kjøringsoppsett)

1. I startvinduet gjør du ett av følgende for å åpne dialogboksen Run Setup (Kjøringsoppsett):

n Velg Run > User-defined Run (Kjøring > Brukerdefinert kjøring).

n Klikk på User-defined Run Setup (Brukerdefinert kjøringsoppsett) på verktøylinjen.

Dialogboksen Run Setup (Kjøringsoppsett) åpnes og viser fanen Protocol (Protokoll).

2. Hvis du vil opprette en ny plate, klikker du på fanen Plate og deretter på Create New (Opprett ny).

Vinduet Plate Editor (Plateredigering) åpnes og viser standard plateoppsett for det valgte
instrumentet.
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Åpne en eksisterende platefil i Plate Editor (Plateredigering)
CFXManager Dx-programvaren gir prøveplatefiler som du kan redigere og lagre som en ny plate. Du
kan også opprette en ny platefil fra en tidligere lagret platefil.

Slik åpner du en prøveplatefil

1. I startvinduet velger du File > Open > Plate (Fil > Åpne > Plate).

Windows Utforsker (Søk) åpnes i plasseringen for CFX Manager Dx Sample (Prøve)-filmappen.

2. Åpne Sample (Prøve)-filmappen, og åpne deretter Plates (Plater)-mappen.

3. Velg ønsket plate og klikk på Open (Åpne).

Prøveplatefilen åpnes i vinduet Plate Editor (Plateredigering).

4. Velg File > Save As (Fil > Lagre som) og lagre platefilen med et nytt navn eller i en annen mappe.

Slik åpner du en tidligere lagret platefil

1. Gjør ett av følgende Velg File > Open > Plate (Fil > Åpne > Plate), naviger til og velg målplaten, og
klikk på Open (Åpne).

Målplaten åpnes i vinduet Plate Editor (Plateredigering).

2. Velg File > Save As (Fil > Lagre som) og lagre platefilen med et nytt navn eller i en annen mappe.
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Sette opp en ny platefil
Tips: Hvis platefilen inneholder de nødvendige parametrene (hvis du for eksempel redigerer en
prøve eller eksisterende platefil), kan du hoppe over dette avsnittet. Fortsett til Tilordne valgfrie
parametere til platefilen på side 116.

Nye platefiler krever følgende parametere:

n Platestørrelse

n Platetype

n Skannemodus

n Én fluorofor (fargestoff)

n Én prøvetype

Velge platestørrelse og -type

Viktig: Du må velge en platestørrelse under plateoppsett. Du kan ikke endre platestørrelsen
under eller etter en kjøring.

Programvaren anvender platestørrelsen og -typen på alle brønner under kjøringen. Kontroller at valgt
platestørrelse er den samme som for platen du skal bruke under kjøringen.

Bio-Rads CFX96 og CFX96 DeepWell-instrumenter kalibreres på fabrikken for mange
kombinasjoner av fluorescerende fargestoffer og plater. Kalibreringen er spesifikk for instrumentet,
fargestoffet og platetypen. Kontroller at fluoroforen du skal bruke er kalibrert for platetypen du velger.

Velge skannemodus

CFX96 og CFX96 DeepWell-systemene eksiterer og detekterer fluoroforer i fem kanaler. Alle
systemer bruker flere skannemoduser for datainnhenting for å samle inn fluorescensdata under en
kjøring.

CFX Manager Dx-programvaren har tre skannemoduser:

n All Channels (Alle kanaler)

o Skanner kanal 1 til 5 på CFX96 og CFX96 DeepWell-systemene
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n SYBR®/FAM

o Skanner kun kanal 1

o Kjører en hurtigskanning

n FRET

o Skanner kun FRET-kanalen

o Kjører en hurtigskanning

Velge fluoroforer

Viktig: Før du starter kjøringen, kontrollerer CFX Manager Dx-programvaren at fluoroforene du
har angitt i platen, er kalibrert på det aktuelle instrumentet. Du kan ikke kjøre en plate hvis den
inneholder fluoroforer som ikke er kalibrert på instrumentet.

Du må laste inn minst én fluorofor i plateoppsettet før kjøringen. Du kan legge til så mange fluoroforer
som nødvendig på dette tidspunktet, men platen må inneholde minst én fluorofor. De valgte
fluoroforene vises som alternativer for mål i Target Names (Målnavn).

Du bruker dialogboksen Select Fluorophores (Velg fluoroforer) til å laste inn fluoroforer (eller
platefargestoffer) i brønninnlastingskontrollene i Plate Editor (Plateredigering). Fluoroforene som
vises i dialogboksen Select Fluorophores (Velg fluoroforer), avhenger av skannemodusen du velger:

n All Channels (Alle kanaler)

Alle tilgjengelige fluoroforer vises.

Tips: Du kan legge til så mange fluoroforer som nødvendig, men du kan kun laste inn én
fluorofor per kanal i hver brønn.

n SYBR®/FAM

Kun kanal 1-fluoroforer vises.

n FRET

Kun kanal 6-fluoroforen vises.

Tips: Kanal 6 FRET-fluoroforen vises kun når FRET er den valgte skannemodusen. Den er
ikke tilgjengelig for skannemodusen All Channels (Alle kanaler).

Merknad: Du kan ikke legge til eller fjerne fluoroforer direkte i dialogboksen Select Fluorophores
(Velg fluoroforer). Du må kalibrere nye fluoroforer på et instrument ved hjelp av Calibration
Wizard (Kalibreringsveiviser). Etter kalibrering vil den nye fluoroforen automatisk legges til i listen.
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Velge prøvetyper

Viktig: Du må velge minst én prøvetype som skal til tilordnes platebrønnene før kjøringen.

CFX Manager Dx-programvaren har fem prøvetyper:

n Unknown (Ukjent)

n Standard

n NTC (ikke-templatkontroll)

n Positive Control (Positiv kontroll)

n Negative Control (Negativ kontroll)

n NRT (uten revers transkriptase)

Du tilordner prøvetypene til platebrønnene.

Sette opp en ny plate

Slik setter du opp en ny plate

1. Åpne en ny plate i vinduet Plate Editor (Plateredigering).

2. Når du skal angi platestørrelse, velger du Settings > Plate Size (Innstillinger > Platestørrelse) og
deretter velger du ønsket platestørrelse fra rullegardinmenyen.

3. Når du skal angi platetype, velger du Settings > Plate Type (Innstillinger > Platetype) og deretter
velger du BRWhite (BR hvit) eller BR Clear (BR klar) fra rullegardinmenyen.

4. Du kan også endre tallkonvensjonen og visningsenhetene i menyen Settings (Innstillinger):

n Når du skal endre tallkonvensjonen, velger du Settings > Number Convention (Innstillinger >
Tallkonvensjon) og deretter Scientific Notation (Vitenskapelig notasjon).

Tips: Scientific Notation (Vitenskapelig notasjon) er valgt som standard. I dette tilfellet
fjernes standardvalget og tallkonvensjonen angis til standardform når du velger
Scientific Notation (Vitenskapelig notasjon).

n Når du skal endre visningsenheter, velger du Settings > Units (Innstillinger > Enheter) og
velger en ny enhetsverdi.

5. Når du skal angi skannemodus, velger du ønsket skannemodus fra rullegardinmenyen Scan
Mode (Skannemodus) på verktøylinjen i vinduet Plate Editor (Plateredigering).
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6. Velg påkrevde fluoroforer for platen:

a. Klikk på Select Fluorophores (Velg fluoroforer) i høyre rute.

Dialogboksen Select Fluorophores (Velg fluoroforer) åpnes. Du kan se de tilgjengelige
fluoroforene for typen skannemodus du valgte i Trinn 5, for eksempel:

b. Når du skal velge en fluorofor, merker du avmerkingsboksen Selected (Valgt) for denne
fluoroforen.

Tips: Når du skal fjerne en fluorofor fra listen, fjerner du merkingen i avmerkingsboksen
Selected (Valgt) for denne fluoroforen.

c. Når du skal endre visningsfargen på fluoroforen, klikker du på avmerkingsboksen Color
(Farge) for denne fluoroforen.

Merknad: Fargen du velger, representerer fluoroforen både i vinduet Plate Editor
(Plateredigering) og i diagrammet Data Analysis (Dataanalyse).

d. I dialogboksen Color (Farge) velger du ønsket farge, eller klikker på Define Custom Colors
(Definer egendefinerte farger) og oppretter en ny farge som skal representere fluoroforen.

e. Klikk på OK for å lagre endringene og lukke dialogboksen Select Fluorophores (Velg
fluoroforer).

Brukerhåndbok | 113



Kapittel 7 Klargjøre plater

7. Du må velge minst én brønn for fylling av en prøvetype. Brønn A1 velges som standard.

Velg ett av følgende alternativer i plateruten:

n Du kan fylle flere tilstøtende brønner ved å klikke på en brønn og dra den til målbrønnen.

n Du kan fylle flere brønner som ikke er tilstøtende, ved å holde inne Ctrl-tasten og klikke på
hver enkelt brønn.

n Du kan fylle en hel kolonne med den samme prøvetypen ved å klikke på kolonnenummeret.

n Du kan fylle en hel rad ved å klikke på radnummeret.

n Du kan fylle hele platen ved å klikke øverst i venstre hjørne av platen.

For eksempel:

8. Tilordne en prøvetype til den valgte brønnen eller de valgte brønnene fra rullegardinmenyen
Sample Type (Prøvetype).
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9. Tilordne minst én fluorofor til alle brønner som inneholder en prøvetype. Du kan tilordne mer enn
én fluorofor til en brønn eller en brønngruppe.

Merknad: Du kan bare tilordne én fluorofor per kanal. Du kan ikke tilordne mer enn én
fluorofor fra den samme kanalen til den samme brønnen.

Tips: Du kan tilknytte et mål til fluoroforen eller tilordne kun fluoroforen til brønnen på dette
tidspunktet og tilknytte et mål til fluoroforen etter at eksperimentet er kjørt.

n Når du skal tilordne kun én fluorofor til de valgte brønnene, merker du avmerkingsboksen
Load (Last inn) for den spesifikke fluroforen i delen Target Names (Målnavn).

n Når du skal tilknytte et mål til en fluorofor, velger du et målnavn fra rullegardinmenyen for den
spesifikke fluoroforen i delen Target Name (Målnavn). Programvaren merker den tilhørende
avmerkingsboksen Load (Last inn) automatisk.

10. For brønner som inneholder prøvetypen Standard, må du fylle på en konsentrasjon. Hver brønn
kan ha forskjellig konsentrasjonsverdi. Som standard fyller CFX Manager Dx-programvaren en
konsentrasjon på 1,00 E+06 i alle brønner med prøvetypen Standard. Om nødvendig kan du
endre verdien.

a. Velg en Standard-brønn eller -brønngruppe i plateruten.

b. Klikk på Load (Last inn) i delen Concentration (Konsentrasjon) for å fylle verdien i de(n)
valgte brønnen(e).

c. (Valgfritt) Når du skal fylle på en annen konsentrasjon, skriver du inn den nye verdien i
tekstboksen Concentration (Konsentrasjon) og trykker på Enter.

d. Utfør dette trinnet for alle brønner med prøvetypen Standard.

Tips: Når du skal fylle på samme konsentrasjon i alle Standard-brønner, må du
kontrollere at <All> (Alle) vises på rullegardinmenyen under verdien Concentration
(Konsentrasjon). Når du skal fylle på samme konsentrasjonsverdi i alle brønner med en
spesifikk fluorofor, klikker du på rullegardinmenyen og velger fluoroforen.

11. Klikk på OK for å lagre den nye platen.
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Tilordne valgfrie parametere til platefilen
En platefil inneholder informasjon om innholdet i hver brønn som er lastet med prøve for en kjøring.
Etter kjøringen knytter CFX Manager Dx-programvaren innholdet i brønnen til fluorescensdataene
som er innsamlet under protokollen, og bruker egnet analyse i vinduet Data Analysis (Datanalyse).

I CFX Manager Dx kan du tilordne parametere til hver brønn i platen før, under eller til og med etter du
kjører eksperimenter. Du kan tilordne parameterne til en eksisterende platefil eller til en ny platefil.
Disse parameterne inkluderer:

n Target names (Målnavn) – interessemålet eller -målene (gener eller sekvenser) i hver lastet
brønn.

n Sample names (Prøvenavn) – identifikatoren eller tilstanden som tilsvarer prøven i hver lastet
brønn, for eksempel 0Hr, 1Hr eller 2Hr.

Tips: Mål- og prøvenavn må være de sammemellom brønnene for å sammenligne data i
fanen Gene Expression (Genuttrykk) i vinduet Data Analysis (Datanalyse). Hvert navn må
inneholde samme tegnsetting, mellomrom og de samme store og små bokstavene. "Actin" er
for eksempel ikke det samme som "actin", "2Hr" er ikke det samme som "2 hr", og "Mouse 1"
er ikke det samme som "mouse1". For å sikre et konsekvent navneformat kan du angi
navnene i delen Libraries (Biblioteker) i User > User Preferences > Plate (Bruker >
Brukerpreferanser > Plate), som er tilgjengelig i startvinduet.

n Biological sets (Biologiske sett) – identifikatoren eller tilstanden som tilsvarer et sett med
brønner.

n Replicates (Replikater) – hver brønn som brukes til å analysere samme kombinasjon av prøve og
mål, dvs. repliserte qPCR-reaksjoner.

n Dilution series (Fortynningsserie) – hvor mye konsentrasjonen skal endres for
standardprøvetypen i en replikatgruppe for å opprette standardkurvedata for analyse.

Tilordne et mål til brønner
Tips: Du kan tilordne det sammemålnavnet til én eller flere brønner. Du kan også tilordne flere
mål til samme brønn.

Slik tilordner du et mål til en brønn eller en brønngruppe

1. Kontroller i Plate Editor (Plateredigering) at brønnen eller brønngruppen har blitt tilordnet en
prøvetype.

Se Velge prøvetyper på side 112 for informasjon om tilordning av prøvetyper til brønner.
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2. Velg brønnen eller brønngruppen i plateruten:

n Hvis du vil velge en enkelt brønn, klikker du på brønnen.

n Hvis du vil velge flere tilstøtende brønner, klikker du på en brønn og drar markøren til ønsket
brønn.

n Hvis du vil velge flere ikke-tilstøtende brønner, holder du Ctrl-tasten nede og klikker på hver
brønn.

n Hvis du vil velge en hel kolonne med samme prøvetype, klikker du på kolonnenummeret.

n Hvis du vil velge en hel rad, klikker du på radnummeret.

3. I høyre rute velger du et navn i rullegardinmenyen Target Name (Målnavn) for hver valgte
fluorofor.

4. Gjenta Trinn 3 for hver brønn eller brønngruppe du må tilordne et mål til.

Tips: Du kan tilordne det samme eller et annet målnavn for hver valgte fluorofor.

5. Klikk på OK for å godta endringene og lagre platen.

Slik fjerner du et målnavn

u Hvis du vil fjerne et målnavn fra en valgt brønn eller brønngruppe, fjerner du merket i
avmerkingsboksen Load (Last inn).

Viktig: Hvis du fjerner et målnavn fra en brønn, fjerner du også den tilknyttede fluoroforen. Utvis
forsiktighet når du fjerner et målnavn fra en brønn.

Slik legger du til et målnavn i listen

u Gjør ett av følgende for å legge til et målnavn i rullegardinmenyen:

n Skriv inn et navn i rullegardinmenyen Target Name (Målnavn) og trykk på Enter.

Tips: Målnavn som du legger til i én liste, vises i alle andre mållister.

n Klikk på det grønne pluss-symbolet (+) til høyre for rullegardinmenyen, skriv inn et navn for
målet og trykk på Enter.

n Klikk på User Preferences (Brukerpreferanser) på verktøylinjen, og legg til navnet i
biblioteket Target Names (Målnavn) i fanen Plate (Plate).
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Viktig: Målnavn som legges til i rullegardinmenyen, er kun tilgjengelige for den aktuelle
platen, og bare hvis du tilordner navnet til en brønn og lagrer plateoppsettet. Hvis du ikke
tilordner navnet til en brønn og lagrer plateoppsettet, lagres ikke navnet og er ikke tilgjengelig
for fremtidig bruk. For permanent å legge til et målnavn må navnet også legges til i biblioteket
Target Names (Målnavn) ved bruk av dialogboksen User Preferences (Brukerpreferanser).
Navn som legges til i biblioteket, er tilgjengelige neste gang du åpner Plate Editor
(Plateredigering). Se Angi standardparametere for plate på side 64 for mer informasjon.

Slik sletter du et målnavn fra listen

1. Klikk på User Preferences (Brukerpreferanser) på verktøylinjen.

Dialogboksen User Preferences (Brukerpreferanser) åpnes, og fanen Plate (Plate) vises.

2. Velg navnet du vil slette under fanen Plate (Plate) i biblioteket Target Names (Målnavn), og trykk
på tasten Delete (Slett).

3. Trykk på OK for å lagre endringer og lukke dialogboksen User Preferences (Brukerpreferanser).

Viktig: Du kan ikke slette målnavn som er lagret sammen med en platefil. Egendefinerte
navn du legger til i rullegardinmenyen Target Names (Målnavn), men ikke bruker og lagrer
sammen med platen, fjernes automatisk fra listen. Navn som slettes fra biblioteket Target
Names (Målnavn), fjernes automatisk fra programvaren og er ikke lenger tilgjengelig for
brukeren. Utvis forsiktighet når du sletter målnavn.

Tilordne et prøvenavn til brønner
Merknad: Du tilordner et prøvenavn ved å tilordne minst én fluorofor til de valgte brønnene. Hvis
de valgte brønnene ikke er tilordnet en fluorofor, deaktiveres rullegardinmenyen Sample Names
(Prøvenavn). Se Tilordne et mål til brønner på side 116 for informasjon om tilordning av
fluoroforer.

Tips: Du kan kun tilordne ett prøvenavn til hver brønngruppe.

Slik tilordner du et prøvenavn til en brønn eller brønngruppe

1. Kontroller i Plate Editor (Plateredigering) at brønnen eller brønngruppen har blitt tilordnet en
fluorofor.

2. Velg brønnen eller brønngruppen i plateruten.

3. I høyre rute velger du et navn i rullegardinmenyen Sample Names (Prøvenavn).
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4. Gjenta Trinn 3 for hver brønn eller brønngruppe du må tilordne et prøvenavn til.

5. Klikk på OK for å godta endringene og lagre platen.

Slik fjerner du et prøvenavn

u Hvis du vil fjerne et prøvenavn fra en valgt brønn eller brønngruppe, fjerner du merket i
avmerkingsboksen Load (Last inn).

Slik legger du til et prøvenavn i listen

u Gjør ett av følgende for å legge til et prøvenavn i rullegardinmenyen:

n Skriv inn et navn i rullegardinmenyen Sample Names (Prøvenavn) og trykk på Enter.

n Klikk på det grønne pluss-symbolet (+) til høyre for rullegardinmenyen, og skriv inn et navn
for prøven.

n Klikk på User Preferences (Brukerpreferanser) på verktøylinjen, og legg til navnet i
biblioteket Sample Names (Prøvenavn) i fanen Plate (Plate).

Viktig: Prøvenavn som legges til i rullegardinmenyen, er kun tilgjengelige for den aktuelle
platen, og bare hvis du tilordner navnet til en brønn og lagrer plateoppsettet. Hvis du ikke
tilordner navnet til en brønn og lagrer plateoppsettet, lagres ikke navnet og er ikke tilgjengelig
for fremtidig bruk. For permanent å legge til et prøvenavn må navnet også legges til i
biblioteket Sample Names (Prøvenavn) ved bruk av dialogboksen User Preferences
(Brukerpreferanser). Navn som legges til i biblioteket, er tilgjengelige neste gang du åpner
Plate Editor (Plateredigering). Se Angi standardparametere for plate på side 64 for mer
informasjon.

Slik sletter du et prøvenavn fra listen

1. Klikk på User Preferences (Brukerpreferanser) på verktøylinjen.

Dialogboksen User Preferences (Brukerpreferanser) åpnes, og fanen Plate (Plate) vises.

2. Velg navnet du vil slette under fanen Plate (Plate) i biblioteket Sample Names (Prøvenavn), og
trykk på tasten Delete (Slett).

3. Trykk på OK for å lagre endringer og lukke dialogboksen User Preferences (Brukerpreferanser).
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Viktig: Du kan ikke slette prøvenavn som er lagret sammen med en platefil. Egendefinerte
navn du legger til i listen Sample Names (Prøvenavn), men ikke bruker og lagrer sammen
med platen, fjernes automatisk fra rullegardinmenyen. Navn som slettes fra biblioteket
Sample Names (Prøvenavn), fjernes fra programvaren og er ikke lenger tilgjengelig for
brukeren. Utvis forsiktighet når du sletter prøvenavn.

Tilordne biologiske sett til brønner
Merknad: Når du skal tilordne et biologisk sett, må du tilordne minst én fluorofor til de valgte
brønnene. Når du tilordner en fluorofor, aktiveres rullegardinmenyen Biological Set Name (Navn
for biologisk sett). Se Tilordne et mål til brønner på side 116 for informasjon om tilordning av
fluoroforer.

Tips: Du kan tilordne ett biologisk sett til hver brønn eller brønngruppe.

Slik tilordner du et biologisk sett til en brønn eller brønngruppe

1. Velg avmerkingsboksen Biological Set (Biologisk sett) under alternativene View (Vis) nederst i
vinduet Plate Editor (Plateredigering).

2. Kontroller i Plate Editor (Plateredigering) at brønnen eller brønngruppen har blitt tilordnet en
fluorofor.

3. Velg brønnen eller brønngruppen i plateruten.

4. I høyre rute velger du fra rullegardinmenyen Biological Set Name (Navn på biologisk sett).

CFX Manager Dx-programvaren merker avmerkingsboksen Load (Last inn) automatisk.

5. Gjenta Trinn 4 for hver brønn eller brønngruppe som krever tilordning av et biologisk sett.

6. Klikk på OK for å godta endringene og lagre platen.

Tips: Når du tilordner navn på biologiske sett til brønner, aktiveres Biological Set Analysis
Options (Alternativer for analyser på biologiske sett) i dialogboksen Experiment Settings
(Eksperimentinnstillinger), der du kan utføre prøveanalyse i én av fire konfigurasjoner. Se
Endre eksperimentinnstillinger på side 126 for mer informasjon.

Slik fjerner du et biologisk sett

u Hvis du vil fjerne et biologisk sett fra den valgte brønnen eller brønngruppen, fjerner du merket i
avmerkingsboksen Load (Last inn).
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Slik legger du til et biologisk sett på listen

u Når du skal legge til et biologisk sett i rullegardinmenyen, skriv inn et navn i rullegardinboksen
Biological Set Name (Navn på biologisk sett) og trykk på Enter.

Viktig: Navn på biologiske sett som du legger til i rullegardinemenyen, er bare tilgjengelige
for den gjeldende platen, og bare hvis du tilordner navnet til en brønn og lagrer
plateoppsettet. Hvis du ikke tilordner navnet til en brønn og lagrer plateoppsettet, lagres ikke
navnet og er ikke tilgjengelig for fremtidig bruk.

Slik viser du alle biologiske sett på platen

u Merk avmerkingsboksen Biological Set (Biologisk sett) under alternativene View (Vis) nederst i
vinduet Editor (Redigering).

Alle brønner viser sine respektive navn på biologiske sett, hvis dette er tilordnet. Kontrollen
Biological Set Name (Navn på biologisk sett) vises i høyre rute.

Fjern merkingen i avmerkingsboksen Biological Set (Biologisk sett) under alternativene View
(Vis) for å skjule biologiske sett.

Tilordne replikatnumre til brønner
Viktig: For å tilordne replikatnumre må innholdet i de valgte brønnene være identisk. Det vil si at
de valgte brønnene må ha samme prøvetype og fluorofor. Hvis relevant, må de også tilordnes
sammemål- og prøvenavn og samme biologiske sett. Hvis de ikke er samme, aktiverer ikke CFX
Manager Dx-programvaren dette alternativet.

Slik tilordner du replikatnumre til en brønngruppe

1. Kontroller i Plate Editor (Plateredigering) at innholdet i brønngruppen er identisk.

2. Velg målgruppen med brønner i plateruten.

3. For å tilordne samme replikatnummer til alle valgte brønner går du til Replicate # (Replikatnr.) i
høyre rute, skriver inn replikatnummeret i boksen og velger Load (Last inn).

4. (Valgfritt) Gjør følgende for å bruke en replikatserie på et sett valgte brønner:
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a. Klikk på Replicate Series (Replikatserier). Delen Replicate # (Replikatnr.) endres for å vise
følgende alternativer:

n Replicate size (Replikatstørrelse) – et nummer som representerer antallet brønner i
hver replikatgruppe

n Starting replicate # (Startreplikatnr.) – det første nummeret i replikatserien for den
valgte replikatgruppen

Merknad: Som standard viser CFX Manager Dx-programvaren startreplikatnummeret
som ett nummer høyere enn det siste replikatnummeret tilordnet i platen. For eksempel,
hvis det siste replikatnummeret i platen er fem, er det neste startnummeret seks. Du kan
endre startnummeret til ethvert nummer som ikke allerede er tilordnet.

n Innlastingsretning (horisontal eller vertikal)

b. Klikk på Apply (Bruk) for å bruke parametrene på serien og returnere til visningen Replicate #
(Replikatnr.).

5. Klikk på OK for å godta endringene og lagre platen.

Slik fjerner du en brønn fra en replikatserie

u Velg brønnen eller brønngruppen som skal fjernes, og fjern merket i avmerkingsboksen Replicate
# Load (Last inn replikatnr.).

Alternativt kan du klikke på Clear Replicate # (Fjern replikatnr.) for å fjerne replikatnummeret fra
en valgt brønn eller brønngruppe.

Tilordne en fortynningsserie til standard prøvetyper
Som tidligere nevnt må alle brønner med prøvetypen Standard være tilordnet en konsentrasjonsverdi.
Du kan tilordne en fortynningsserie til flere brønner med prøvetypen Standard.

Merknad: For å tilordne en fortynningsserie til en gruppe med brønner må brønnene være
inkludert i en replikatserie. Se Tilordne replikatnumre til brønner på side 121 for informasjon om
hvordan du legger til brønner i en replikatserie.
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Slik tilordner du en fortynningsserie til en gruppe standard prøvebrønner

1. I Plate Editor (Plateredigering) kontrollerer du at følgende krav er oppfylt:

n Prøvetypen for brønngruppen er Standard.

n Alle brønner i gruppen er tilordnet minst én fluorofor, og alle inneholder de samme
fluoroforene.

n Alle brønner i gruppen er inkludert i samme replikatserie.

Merknad: CFXManager Dx-programvaren aktiverer alternativet Dilution Series
(Fortynningsserie) kun når alle valgte brønner oppfyller disse kriteriene.

2. Velg målgruppen med brønner i plateruten.

3. I delen Concentration (Konsentrasjon) i høyre rute klikker du på Dilution Series
(Fortynningsserie). Delen Concentration (Konsentrasjon) endres og viser følgende alternativer:

n Starting concentration (Startkonsentrasjon) – konsentrasjonsverdien som serien starter fra

n Replicates from and to (Replikater fra og til) – replikatene i serien som fortynningsfaktoren
vil bli brukt på

n Dilution factor (Fortynningsfaktor) – mengden som konsentrasjonen skal endres med
innenfor hver replikatgruppe

4. Angi verdiene for alternativene eller godta standardverdiene.

5. Fortynningsserien reduseres med fortynningsfaktoren som standard. Velg Increasing (Stigende)
for å øke fortynningsserien.

6. (Valgfritt) Fortynningsfaktoren brukes på alle fluoroforer i replikatserien som standard. Hvis serien
inneholder mer enn én fluorofor og du vil bruke fortynningen på en enkelt fluorofor, velger du den
fra rullegardinmenyen.

7. Klikk på Apply (Bruk) for å bruke fortynningsserien på brønngruppen og gå tilbake til visningen
Concentration (Konsentrasjon).
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8. Klikk på OK for å godta endringene og lagre platen.

Kopiere brønninnhold til en annen brønn
Du kan kopiere innholdet i en brønn og lime det inn i én eller flere brønner. Du kan imidlertid kun
kopiere innholdet fra én enkelt brønn. Du kan ikke velge flere brønner og kopiere innholdet i disse.

Slik kopierer du innholdet i en brønn til en annen brønn

1. I plateruten velger du brønnen som skal kopieres.

2. Høyreklikk på brønnen og velg Copy Well (Kopier brønn).

3. Velg brønnen eller brønnene som innholdet skal limes inn i:

n Hvis du vil velge en enkelt brønn, klikker du på brønnen.

n Hvis du vil velge flere tilstøtende brønner, klikker du på en brønn og drar markøren til ønsket
brønn.

n Hvis du vil velge flere ikke-tilstøtende brønner, holder du Ctrl-tasten nede og klikker på hver
brønn.

4. Når målbrønnene er valgt, høyreklikker du og velger Paste Well (Lim inn brønn).

CFX Manager Dx-programvaren limer inn innholdet fra den første brønnen i de valgte brønnene.

Legge til en merknad for en brønn
Du kan legge til en beskrivende merknad for en brønn. Du kan vise brønnmerknadene i fanen
Quantification (Kvantifisering) i vinduet Data Analysis (Dataanalyse).

Slik legger du til en merknad for en brønn

1. I plateruten velger du brønnen eller brønnene du vil legge til en merknad for.

2. I delen View (Visning) i nederste rute velger du Well Note (Brønnmerknad).

Området Well Note (Brønnmerknad) vises i høyre rute.

3. Skriv inn merknaden i tekstboksen og trykk på Enter.

Teksten vises nederst i de valgte brønnene.

Tips: Hvis du allerede har opprettet en brønnmerknad, kan du velge den fra
rullegardinmenyen og bruke den på de valgte brønnene.
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Tømme brønner for alt innhold
Du kan tømme en enkelt brønn, en brønngruppe eller hele platen for alt innhold. Tømming av brønner
vil ikke fjerne fluorescensdata som er samlet inn under plateavlesningen.

Når du tømmer en brønn, fjernes alt innholdet i brønnen permanent. Utvis forsiktighet når du tømmer
brønner.

Slik tømmer du brønner for alle innstillinger

1. I Plate Editor (Plateredigering) velger du en brønn eller brønngruppe i plateruten:

n Hvis du vil velge en enkelt brønn, klikker du på brønnen.

n Hvis du vil velge flere tilstøtende brønner, klikker du på en brønn og drar markøren til ønsket
brønn.

n Hvis du vil velge flere ikke-tilstøtende brønner, holder du Ctrl-tasten nede og klikker på hver
brønn.

n Hvis du vil velge en hel kolonne med samme prøvetype, klikker du på kolonnenummeret.

n Hvis du vil velge en hel rad, klikker du på radnummeret.

2. Klikk på Clear Wells (Tøm brønner) i høyre rute.

CFX Manager Dx-programvaren tømmer de valgte brønnene for alle innstillinger.

3. Klikk på OK for å godta endringene og lagre platen.
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Endre eksperimentinnstillinger
Bruk dialogboksen Experiment Settings (Eksperimentinnstillinger) til å vise eller endre listen med mål
eller prøver, eller til å velge genuttrykksanalyse-gruppen og analysealternativet hvis du har tilordnet
biologiske sett til brønner i platen.

I dialogboksen Experiment Settings (Eksperimentinnstillinger) viser fanen Targets (Mål) en liste med
målnavn for hver PCR-reaksjon, for eksempel målgenet eller gensekvenser av interesse.

Fanen Prøver viser en liste med navn på prøver som angir kilden til målet, for eksempel en prøve tatt
etter 1 time (1Hr) eller fra et bestemt individ (mouse1).

Slik endrer du plateinnstillinger ved hjelp av dialogboksen Experiment Settings
(Eksperimentinnstillinger)

1. Velg én av følgende fremgangsmåter for å åpne dialogboksen Experiment Settings
(Eksperimentinnstillinger):

n Klikk på Experiment Settings (Eksperimentinnstillinger) i høyre rute i Plate Editor
(Plateredigering).

n Klikk på Experiment Settings (Eksperimentinnstillinger) i fanen Gene Expression
(Genuttrykk) i vinduet Data Analysis (Dataanalyse).

Dialogboksen Experiment Settings (Eksperimentinnstillinger) åpnes i fanen Targets (Mål).
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2. Hvis du vil legge til et nytt navn på et mål eller en prøve, går du til den relevante fanen, skriver inn
et navn i tekstboksen New (Ny) og klikker på Add (Legg til).

3. Hvis du vil fjerne et eller flere navn på et mål eller en prøvefra listen, går du til den relevante fanen,
velger elementets avmerkingsboks i kolonnen Select to Remove (Velg for å fjerne) og klikker på
Remove checked item(s) (Fjern avmerkede elementer).

4. CFX Manager Dx-programvaren utelukker prøvetypen NTC (ikke-templatkontroll) fra
genuttrykksanalysen.

Hvis du vil inkludere NTC-prøvetyper, fjerner du merket i avmerkingsboksen i delen Exclude the
following sample types (Utelukk følgende prøvetyper). Du kan velge å utelukke følgende
prøvetyper ved å merke av i den relevante avmerkingsboksen:

n NRT (uten revers transkriptase)

n Negative Control (Negativ kontroll)

n Positive Control (Positiv kontroll)

n Standard
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5. I fanen Targets (Mål):

a. Hvis du vil velge et mål som referanse for genuttrykksdataanalyse, velger du det i kolonnen
Reference (Referanse).

b. Hvis du vil skjule analyseinnstillinger som vil bli brukt i fanen Gene Expression (Genuttrykk) i
vinduet Analysis Settings (Analyseinnstillinger), fjerner du merket i avmerkingsboksen Show
Analysis Settings (Vis analyseinnstillinger).

Programvaren skjuler følgende kolonner:

n Color (Farge)

n Show Chart (Vis diagram)

n Auto Efficiency (Automatisk effektivitet)

n Efficiency (%) (Effektivitet (%))

c. Hvis du vil endre fargen på målet som vises i diagrammet Gene Expression (Genuttrykk),
klikker du på tilhørende celle i kolonnen Color (Farge), velger en ny farge i dialogboksen
Color (Farge) og klikker på OK.

d. Hvis du vil vise målet i den valgte fargen i diagrammet Gene Expression (Genuttrykk), velger
du tilhørende avmerkingsboks i kolonnen Show Chart (Vis diagram).

e. Som standard beregner CFX Manager Dx automatisk den relative effektiviteten for et mål
hvis dataene inkluderer en standardkurve.

Hvis du vil bruke en tidligere bestemt effektivitetsverdi, skriver du inn verdien i tilhørende
celle i kolonnen Efficiency (%) (Effektivitet (%)) og trykker på Enter-tasten. CFX Manager Dx
fjerner merket i avmerkingsboksen Auto Efficiency (Automatisk effektivitet).

6. I fanen Samples (Prøver):

a. Hvis du vil velge en prøve som kontrollprøve for genuttrykksdataanalyse, merker du av i
avmerkingsboksen i kolonnen Control (Kontroll).

b. Hvis du vil tilordne kontrolltilstanden til en prøve for en kjøring, klikker du på
avmerkingsboksen i kolonnen Control (Kontroll).

c. Hvis det ikke allerede er valgt, klikker du på Show Analysis Settings (Vis analyseinnstillinger)
for å vise eller endre analyseparametere som vil bli brukt i fanen Gene Expression
(Genuttrykk). Programvaren skjuler kolonnene Color (Farge) og Show Chart (Vis diagram).
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7. Hvis du har tilordnet ett eller flere biologiske sett til brønner i platen (se Tilordne biologiske sett til
brønner på side 120), velger du ett av følgende alternativer i listen Biological Set Analysis Options
(Alternativer for analyse av biologiske sett):

n Target vs. Sample (Mål kontra prøve) – Kun brønnprøvenavnet brukes i beregningene av
genuttrykk.

n Target vs. Biological Set (Mål kontra biologisk sett) – Kun det biologiske settnavnet brukes
i beregningene.

n Target vs. Sample_Biological Set (Mål kontra prøve biologisk sett) – Prøvenavnet og det
biologiske settnavnet kombineres til ett enkelt navn som brukes i beregningene.

n Target vs. Biological Set_Sample (Mål kontra biologisk sett_prøve) – Det biologiske
settnavnet og prøvenavnet kombineres til ett enkelt navn som brukes i beregningene.

8. Klikk på OK for å lagre parametrene i dialogboksen Experiment Settings
(Eksperimentinnstillinger) og gå tilbake til vinduet Plate Editor (Plateredigering).

Opprette brønngrupper
Brønngrupper deler inn en enkelt plate i delsett med brønner som kan analyseres uavhengig av
hverandre i vinduet Data Analysis (Dataanalyse). Når brønngrupper er satt opp, velger du én i vinduet
Data Analysis (Dataanalyse) for å analysere dataene som en uavhengig gruppe. Du kan for eksempel
sette opp brønngrupper for å analysere flere eksperimenter kjørt på én plate, eller for å analysere hver
brønngruppe med forskjellig standardkurve.

Merknad: Standard brønngruppe er All Wells (Alle brønner).

Slik oppretter du brønngrupper

1. Velg én av følgende fremgangsmåter for å åpneWell Groups Manager (Administrering av
brønngrupper):

n Klikk på Well Groups (Brønngrupper) på verktøylinjen i Plate Editor (Plateredigering).

n Klikk på ManageWell Groups (Administrer brønngrupper) i vinduet Data Analysis
(Dataanalyse).

DialogboksenWell Groups Manager (Administrering av brønngrupper) vises.
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2. Klikk på Add (Legg til) for å opprette en ny gruppe. Rullegardinmenyen viser gruppenavnet som
Group 1 (Gruppe 1) for den første gruppen.

3. Velg brønnene til brønngruppen i platevisningen ved å klikke og dra over gruppen med brønner.
Valgte brønner vises i blått i Manager (Administrering).

4. (Valgfritt) Hvis du vil endre navnet på gruppen, velger du navnet i rullegardinmenyen og skriver
inn et nytt navn.

5. (Valgfritt) Hvis du vil slette en brønngruppe, velger du navnet i rullegardinmenyen og klikker på
Delete (Slett).

6. Klikk på OK for å avslutte og lukke vinduet, eller klikk på Cancel (Avbryt) for å lukke vinduet uten å
gjøre endringer.

Viktig: Hvis du vil vise brønngruppene, velger du Well Groups (Brønngrupper) i alternativene for
View (Visning) nederst i vinduet Plate Editor (Plateredigering).
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Elementer i høyreklikkmenyen for dialogboksen Well Groups Manager
(Administrering av brønngrupper)

Tabell 13 viser menyelementene som er tilgjengelige i Well Groups Manager (Administrering av
brønngrupper) når du høyreklikker på en brønn.

Element Funksjon

Copy (Kopier) Kopierer innholdet i brønnen, som deretter kan limes inn i
en annen brønn eller flere andre brønner.

Copy as Image (Kopier som
bilde)

Kopierer brønnvelgervisningen som et bilde.

Print (Skriv ut) Skriver ut brønnvelgervisningen.

Print Selection (Skriv ut utvalg) Skriver ut kun de valgte cellene.

Export to Excel (Eksporter til
Excel)

Eksporterer dataene til et Excel-regneark.

Export to Csv (Eksporter til Csv) Eksporterer dataene som et kommaseparert dokument.

Export to Xml (Eksporter til Xml) Eksporterer dataene som et .xml-dokument.

Export to Html (Eksporter til
Html)

Eksporterer dataene som et .html-dokument.

Tabell 13. Elementer i høyreklikkmenyen i dialogboksen Plate Editor Well Selector
(Plateredigering for brønnvelger)

Brukerhåndbok | 131



Kapittel 7 Klargjøre plater

Endre kurvestiler
Under plateoppsett og mens en kjøring pågår, kan du endre fargen og stilen på amplifiseringskurvene.
Du kan deretter enkelt vise kurvene i vinduet for sanntidsstatus etter hvert som dataene samles inn.

Slik endrer du kurvestiler

1. Klikk på Trace Styles (Kurvestiler) på verktøylinjen i Plate Editor (Plateredigering).

Dialogboksen Trace Styles (Kurvestiler) vises for den åpne platen, for eksempel:

2. Hvis du vil vise kurvestilene etter en bestemt fluorofor, velger du den fra rullegardinmenyen
Fluorophores (Fluoroforer).

3. Slik endrer du kurvevisningen:

a. Velg kurvetypen fra rullegardinmenyenWells (Brønner).

b. Klikk på fargen i kolonnen Color (Farge).

c. I dialogboksen Color (Farge) som vises, velger du en annen farge for kurven og klikker på
OK.

Endringen for brønntypen vises i rutenettet under.

d. (Valgfritt) Velg et symbol for kurven fra rullegardinmenyen Symbols (Symboler).
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Endre kurvestiler

4. Hvis du vil endre fargesettet raskt, klikker du på det relevante valget i delen Color Quick Set
(Hurtigfargesett).

5. Hvis du vil vise brønnetiketter i rutenettet, velger du etikettypen i delen Well Labels
(Brønnetiketter).

6. Klikk på OK for å lagre endringer, eller på Cancel (Avbryt) for å avbryte endringer.
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Vise platen i regnearkformat
Verktøyet Spreadsheet View/Importer (Regnearkvisning/-import) viser innholdet i en plate i
regnearkformat. Du kan bruke verktøyet Spreadsheet View/Importer (Regnearkvisning/-import) til å
eksportere brønninnhold i tabulatordelt format til et program som for eksempel Microsoft Excel. Du kan
også importere brønninnhold fra et tabulatordelt program.

Slik bruker du verktøyet Spreadsheet View/Importer (Regnearkvisning/-import)

1. På verktøylinjen i Plate Editor (Plateredigering) klikker du på Spreadsheet View/Importer
(Regnearkvisning/-import) for å åpne dialogboksen Plate Spreadsheet View (Visning av
plateregneark).

2. Dialogboksen Plate Spreadsheet View (Visning av plateregneark) viser innholdet i platen for en
enkelt fluorofor. Hvis du vil vise plateinnholdet for en annen fluorofor, velger du den i
rullegardinmenyen Fluors List (Fluoroforliste).

3. Klikk på Export Template (Eksporter mal) for å eksportere en mal for plateregnearket til en Excel-
fil (.csv-format). Du kan redigere denne malen for å importere informasjon om brønninnhold.

4. (Valgfritt) Klikk på Import (Importer) for å importere brønninnhold fra en kommadelt fil.

5. Hvis du vil sortere regnearket etter dataene i en bestemt kolonne, klikker du på trekanten ved
siden av kolonnenavnet.

Tips: Du kan redigere innholdet i alle celler i en kolonne som har en stjerne (*) ved siden av
kolonnenavnet (for eksempel *Target Name (Målnavn)).
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Vise platen i regnearkformat

Merknad: Velg enhetene for standardkurvedata i kolonnen Quantity (Kvantitet) ved å åpne Plate
Editor (Plateredigering) og velge Settings > Units (Innstillinger > Enheter) i menylinjen. Når
platekjøringen er fullført, vises dataene fra disse standardene i diagrammet Standard Curve
(Standardkurve) i fanen Quantification (Kvantifisering) i vinduet Data Analysis (Dataanalyse) med
enhetene du har valgt.

Elementer i høyreklikkmenyen for verktøyet Plate Spreadsheet View/Importer
(Plateregnearkvisning/-import)

Tabell 14 viser menyelementene som er tilgjengelige i verktøyet Spreadsheet View/Importer
(Regnearkvisning/-import) når du høyreklikker på en brønn i verktøyet.

Element Funksjon

Copy (Kopier) Kopierer hele regnearket.

Copy as Image (Kopier
som bilde)

Kopierer regnearket som en bildefil.

Print (Skriv ut) Skriver ut regnearket.

Print Selection (Skriv ut
utvalg)

Skriver ut kun de valgte cellene.

Export to Excel
(Eksporter til Excel)

Eksporterer filen til et Excel-regneark.

Export to CSV
(Eksporter til CSV)

Eksporterer filen som en .csv-fil.

Export to Xml
(Eksporter til Xml)

Eksporterer filen som en .xml-fil.

Export to Html
(Eksporter til Html)

Eksporterer filen som en .html-fil.

Find (Søk) Søker etter bestemt tekst.

Sort (Sorter) Sorterer regnearket ved å velge opptil tre datakolonner i vinduet
Sort (Sorter).

Tabell 14. Elementer i høyreklikkmenyen for verktøyet Plate Spreadsheet View/Im-
porter (Plateregnearkvisning/-import)
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Opprette et plateoppsett ved hjelp av Setup Wizard
(Oppsettsveiviser) for plater

Du kan bruke Setup Wizard (Oppsettsveiviser) til å angi plateoppsettinformasjonen som er påkrevd for
analyse av normalisert genuttrykk, inkludert:

n Målnavn

n Prøvenavn

n Plassering av mål og prøve på platen

n Referansegen(er)

n Kontrollprøve

Du kan bruke Setup Wizard (Oppsettsveiviser) før, under eller etter en kjøring.

Bruke Setup Wizard (Oppsettsveiviser) for plater
Dette avsnittet forklarer hvordan du oppretter et plateoppsett ved bruk av Setup Wizard
(Oppsettsveiviser) for plater. For enklere visning av innholdet i hver brønn i platen kan du klikke på
Zoom Plate (Zoom inn plate) øverst i Setup Wizard (Oppsettsveiviser).

Viktig: Plateoppsettet tilbakestilles hvis du går tilbake til fanen Auto layout (Auto-oppsett) mens
du befinner deg i en annen fane i Setup Wizard (Oppsettsveiviser). Utvis forsiktighet når du velger
denne fanen.

Tips: Du kan tilbakestille oppsettet ved å velge Tools > Clear Plate (Verktøy > Tøm plate) i Setup
Wizard (Oppsettsveiviser).

Slik bruker du Setup Wizard (Oppsettsveiviser) for plater

1. Åpne Plate Editor (Plateredigering).

2. Velg Editing Tools > Setup Wizard (Verktøy > Oppsettsveiviser) for å åpne Setup Wizard
(Oppsettsveiviser).

Setup Wizard (Oppsettsveiviser) åpnes og viser fanen Auto layout (Auto-oppsett).
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Opprette et plateoppsett ved hjelp av Setup Wizard (Oppsettsveiviser) for plater

3. I fanen Auto layout (Auto-oppsett) gjør du følgende:

a. Klikk på en brønn i rutenettet og dra den på tvers og ned for å angi det området på platen du
skal fylle i en prøve.

b. Angi antall mål og prøver som skal fylles i.

Tips: Antall mål og prøver må tilsvare antall valgte celler. Hvis det angitte antallet ikke
passer i det valgte området, må du endre antallet eller utvalgsområdet på platen. Du kan
angi retningen på elementene på platen og på elementenes gruppering.

c. (Valgfritt) Endre the plateretningen. Du kan for eksempel angi mål i kolonner og prøver i
rader, eller gruppere etter prøver.

d. Klikk på Next (Neste) for å fortsette til fanen Target names (Målnavn).

Merknad: Hvis plateoppsettet ikke har et jevnt mønster, bruker du fanen Target names
(Målnavn) til manuelt å plassere målene eller fanen Sample names (Prøvenavn) til manuelt å
plassere prøvene, på platen. Klikk og dra for å velge flere brønner.

4. Angi målnavn for målgruppene i fanen Target names (Målnavn):

a. Gjør ett av følgende:

n Angi Select by (Velg etter) til Target (Mål) for å gi målene nytt navn etter gruppe.

n Angi Select by (Velg etter) til Welll (Brønn) for å gi målene nytt navn etter brønn.
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b. Velg en målgruppe eller brønn i rutenettet, og skriv inn et navn i rullegardinmenyen Target
name (Målnavn).

Tips: Trykk på tabulatortasten for å velge neste gruppe eller brønn mot høyre, eller trykk
på Enter for å velge neste gruppe eller brønn under. I fanene Target name (Målnavn) og
Sample name (Målnavn) kan du også velge flere ikke-tilstøtende brønner ved å holde
inne Ctrl-tasten på tastaturet og klikke på de brønnene du ønsker.

c. Klikk på Next (Neste) for å fortsette til fanen Sample names (Prøvenavn).

5. Angi prøvenavn for prøvegruppene i fanen Sample names (Prøvenavn).

6. Klikk på Next (Neste) for å fortsette til fanen Reference targets (Referansemål).

7. I fanen Reference targets (Referansemål) velger du ett eller flere mål som skal brukes som
referanser for normalisert genuttrykk. Klikk på Next (Neste) for å gå videre til fanen Control
Sample (Kontrollprøve).

8. I fanen Control sample (Kontrollprøve) velger du én prøve som skal brukes som en kontroll for
beregninger av relativt genuttrykk.

9. Klikk på OK for å lagre plateoppsettet og gå tilbake til Plate Editor (Plateredigering), der du kan
angi flere plateparametere. Se Tilordne valgfrie parametere til platefilen på side 116 for mer
informasjon.

Du kan også klikke på Previous (Forrige) for å gå tilbake til en tidligere fane for å gjøre ønskede
endringer.

Merknad: Platen tilbakestilles hvis du går tilbake til fanen Auto layout (Auto-oppsett). Utvis
forsiktighet når du klikker på Previous (Forrige).
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Kapittel 8 Kjøre eksperimenter
Dette kapitlet forklarer hvordan du kjører egne (brukerdefinerte) eller PrimePCR™-
analyseeksperimenter ved bruk av CFX Manager™ Dx-programvaren.

En kjøringsdatafil inneholder protokollen og plateinformasjonen for kjøringen. Filen inneholder også
dataene fra analysene som CFXManager Dx utfører når kjøringen er fullført.

CFX Manager Dx-programvaren gjør det lett å sette opp og kjøre brukerdefinerte eller PrimePCR-
eksperimenter. Vinduet Run Setup (Kjøringsoppsett) veileder deg gjennom de vanlige trinnene for å
sette opp et eksperiment, hvilket tar deg til dialogboksen Start Run (Start kjøring), der du starter
kjøringen.

Åpne vinduet Run Setup (Kjøringsoppsett)
Slik åpner du kjøringsoppsettvinduet

u Gjør ett av følgende:

n I fanen Run setup (Kjøringsoppsett) i Startup Wizard (Oppstartsveiviser) klikker du på enten
User-defined (Brukerdefinert) eller PrimePCR.

n På verktøylinjen i startvinduet klikker du på enten User-defined Run Setup (Brukerdefinert
kjøringsoppsett) eller PrimePCR Run Setup (PrimePCR-kjøringsoppsett).

n I startvinduet klikker du på Run > User-defined Run (Kjør > Brukerdefinert kjøring) eller Run >
PrimePCR Run (Kjør > PrimePCR-kjøring).
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Vinduet Run Setup (Kjøringsoppsett)
Vinduet Run Setup (Kjøringsoppsett) gir rask tilgang til filene og innstillingene som kreves for å sette
opp og kjøre et eksperiment. Når du velger å kjøre et brukerdefinert eksperiment, åpnes vinduet Run
Setup (Kjøringsoppsett) og viser fanen Protocol (Protokoll). Når du velger å kjøre et PrimePCR-
eksperiment, åpnes vinduet Run Setup (Kjøringsoppsett) og viser fanen Start Run (Start kjøring).

Tips: Se Utføre PrimePCR-eksperimenter på side 157 for informasjon om PrimePCR; se Fanen
Start Run (Start kjøring) på side 147 for informasjon om fanen Start Run (Start kjøring).

1. Faner som gir deg veiledning under oppsett og kjøring av eksperimenter:

n Fanen Protocol (Protokoll) – velg en eksisterende protokoll du vil kjøre eller
redigere, eller opprett en ny protokoll i Protocol Editor (Protokollredigering).

n Fanen Plate – velg en eksisterende plate du vil kjøre eller redigere, eller
opprett en ny plate i Plate Editor (Plateredigering).

n Fanen Start Run (Start kjøring) – vis eksperimentinnstillinger, velg én eller
flere instrumentblokker og start kjøringen.

2. Hovedvinduet viser alternativene for hver fane etter hvert som du bruker dem.

3. Navigeringsknapper fører deg til fanen Start Run (Start kjøring).

FORKLARING
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Fanen Protocol (Protokoll)
Fanen Protocol (Protokoll) viser en forhåndsvisning av protokollfilen du ønsker å kjøre. En protokollfil
inneholder instruksjoner for trinnene for instrumenttemperatur samt instrumentalternativer som
kontrollerer rampehastigheten, prøvevolumet og lokktemperaturen.

Som standard viser programvaren protokollen som er definert i File Selection (Filutvalg) for delen Run
Setup (Kjøringsoppsett) i fanen Files (Filer) i dialogboksen User > User Preferences (Bruker >
Brukerpreferanser). Du kan endre standardprotokollen i dialogboksen User Preferences
(Brukerpreferanser). Se Endre Default File Settings (Standard filinnstillinger) på side 62 for mer
informasjon.

I fanen Protocol (Protokoll) kan du:

n opprette en ny protokoll som skal kjøres

n velge en eksisterende protokoll som skal kjøres eller redigeres

Se Kapittel 6, Opprette protokoller for mer informasjon om hvordan du oppretter og modifiserer
protokoller.
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Slik oppretter du en ny protokoll

1. Klikk på Create New (Opprett ny) i fanen Protocol (Protokoll).

Protocol Editor (Protokollredigering) åpnes.

2. Bruk Protocol Editor (Protokollredigering) til å opprette en ny protokoll.

3. Klikk på OK for å lagre protokollen og gå tilbake til fanen Protocol (Protokoll) i Run Setup
(Kjøringsoppsett).

4. Vis protokollinformasjonen, og velg én av følgende fremgangsmåter:

n Hvis informasjonen er riktig, velger du Next (Neste) for å fortsette til fanen Plate.

n Hvis informasjonen er feil, velger du Edit Selected (Rediger valgt) for å gå tilbake til vinduet
Protocol Editor (Protokollredigering). Gjør redigeringer i protokollen, lagre endringene og
klikk deretter på Next (Neste) i fanen Protocol (Protokoll) for å fortsette til fanen Plate.

Slik velger du en eksisterende protokoll

1. I fanen Protocol (Protokoll) velger du én av følgende fremgangsmåter:

n Klikk på Select Existing (Velg eksisterende), og naviger til en eksisterende protokoll.

n Klikk på Express Load (Hurtigfylling), og velg en protokoll fra rullegardinmenyen over
protokoller.

Tips: Du kan legge til eller fjerne protokoller fra rullegardinmenyen Express Load
(Hurtigfylling). Se Legge til og fjerne protokoller for hurtiginnlasting for mer informasjon.

2. Vis protokollinformasjonen, og velg én av følgende fremgangsmåter:

n Hvis informasjonen er riktig, velger du Next (Neste) for å fortsette til fanen Plate.

n Hvis informasjonen er feil, velger du Edit Selected (Rediger valgt) for å åpne Protocol Editor
(Protokollredigering). Gjør redigeringer i protokollen, lagre endringene og klikk deretter på
Next (Neste) i fanen Protocol (Protokoll) for å fortsette til fanen Plate.

Legge til og fjerne protokoller for hurtiginnlasting

Du kan endre innholdet i rullegardinmenyen Express Load (Hurtiginnlasting) som vises i Protocol
Editor (Protokollredigering). Protokollene i denne menyen er lagret i følgende mappe:

c:\Users\Public\Documents\Bio-Rad\CFX\Users\<user_name>\ExpressLoad\
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Slik endrer du menyen Express Load (Hurtiginnlasting) for protokoller

1. Naviger til mappen ExpressLoad (Hurtiginnlasting), og åpne den.

2. Gå gjennom protokollfilene (.pcrl) i mappen.

3. Gjør ett av følgende:

n Slett protokoller fra mappen for å fjerne dem fra rullegardinmenyen.

n Kopier protokoller til mappen for å legge dem til i rullegardinmenyen.
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Fanen Plate
Merknad: Hvis den valgte protokollen i fanen Protocol (Protokoll) ikke inkluderer et
plateavlesningstrinn for sanntids PCR-analyse, vil fanen Plate være skjult. For å vise fanen Plate
må du legge til minst én plateavlesning i protokollen.

Fanen Plate viser en forhåndsvisning av platefilen du har tenkt å laste inn. I en sanntids PCR-kjøring
inneholder platefilen en beskrivelse av innholdet i hver brønn, inkludert fluoroforer, skannemodus og
platetype. CFX Manager Dx-programvaren bruker disse beskrivelsene til innsamling og analyse av
data.

Som standard viser programvaren platen definert i delen File Selection for Run Setup (Filvalg for
kjøringsoppsett) i fanen Files (Filer) i dialogboksen User > User Preferences (Bruker >
Brukerpreferanser). Du kan endre standardplaten i dialogboksen User Preferences
(Brukerpreferanser). Se Endre Default File Settings (Standard filinnstillinger) på side 62 for mer
informasjon.

I fanen Plate kan du:

n Opprette en ny plate som skal lastes inn.

n Velge en eksisterende plate som skal lastes inn eller redigeres.
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Hvis du vil ha mer informasjon om hvordan du oppretter og endrer plater, se Kapittel 7, Klargjøre
plater.

Slik oppretter du en ny plate

1. Klikk på Create New (Opprett ny) i fanen Plate.

Plate Editor (Plateredigering) vises.

2. Bruk Plate Editor (Plateredigering) til å opprette en ny plate.

3. Klikk på OK for å lagre platen og gå tilbake til fanen Plate i Run Setup (Kjøringsoppsett).

4. Vis detaljene om platen og velg én av følgende fremgangsmåter:

n Hvis detaljene er riktige, klikker du på Next (Neste) for å gå videre til fanen Start Run (Start
kjøring).

n Hvis detaljene ikke er riktige, klikker du på Edit Selected (Rediger valgte) for å gå tilbake til
Plate Editor (Plateredigering). Revider platefilen, lagre endringer og klikk deretter på Next
(Neste) i fanen Plate for å gå videre til fanen Start Run (Start kjøring).

Slike velger du en eksisterende plate

1. Velg én av følgende fremgangsmåter i fanen Plate:

n Klikk på Select Existing (Velg eksisterende) og naviger til en eksisterende platefil.

n Klikk på Express Load (Hurtiginnlasting) og velg en platefil fra rullegardinmenyen.

Tips: Du kan legge til plater i eller fjerne dem fra rullegardinmenyen Express Load
(Hurtiginnlasting). Se Legge til og fjerne platefiler for hurtiginnlasting for mer
informasjon.

2. Vis detaljene om platen og velg én av følgende fremgangsmåter:

n Hvis detaljene er riktige, klikker du på Next (Neste) for å gå videre til fanen Start Run (Start
kjøring).

n Hvis detaljene ikke er riktige, klikker du på Edit Selected (Rediger valgte) for å åpne Plate Editor
(Plateredigering). Endre platefilen, lagre endringer og klikk deretter på Next (Neste) for å gå
videre til fanen Start Run (Start kjøring).

Legge til og fjerne platefiler for hurtiginnlasting

Du kan endre innholdet i rullegardinmenyen Express Load (Hurtiginnlasting), som vises i Plate Editor
(Plateredigering). Platene som vises i denne listen, er lagret i følgende mappe:

c:\Users\Public\Documents\Bio-Rad\CFX\Users\<user_name>\ExpressLoad\
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Slik modifiserer du listen over platefiler i Express Load (Hurtiginnlasting)

1. Naviger til mappen ExpressLoad (Hurtiginnlasting), og åpne den.

2. Se gjennom platefilene (.pltd) i mappen.

3. Gjør ett av følgende:

n Slett platefilene fra mappen for å fjerne dem fra rullegardinmenyen.

n Kopier platefilene til mappen for å legge dem til i rullegardinmenyen.
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Fanen Start Run (Start kjøring)
Fanen Start Run (Start kjøring) viser informasjon om eksperimentet som skal kjøres. Den viser også
den tilkoblede instrumentblokken eller blokker du kan kjøre eksperimentet på.

I fanen Start Run (Start kjøring) kan du gjøre følgende:

n vise detaljert kjøringsinformasjon, inkludert valgt protokollfil, platefil og skannemodus

n legge til merknader om kjøringen

n vise informasjon om alle tilkoblede instrumenter, inkludert kjøringsstatus (kjører eller inaktiv),
prøvevolum i µl, lokktemperatur, emuleringsmodus samt eventuell ID og strekkode.

Merknad: Du kan modifisere kolonnene som vises i Start Run (Start kjøring) i tabellen
Selected Blocks (Valgte blokker). Se Endre detaljer i tabellen for valgte blokker på side 148
for information.

n Velg blokken eller blokkene du vil utføre kjøringen på.

n Fjern-åpne eller -lukke lokket på hvert valgte instrument.

n Start kjøringen.
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Endre detaljer i tabellen for valgte blokker

Du kan endre kolonnene som vises i tabellen Start Run on Selected Block(s) (Start kjøring på valgte
blokker). Du kan også endre verdiene for standard prøvevolum og lokktemperatur i tabellen.
Innstillingsendringene brukes på kjøringen som skal utføres.

Slik legger du til kolonner i tabellen Start Run on Selected Blocks (Start kjøring på valgte
blokker)

u Høyeklikk i tabellen og velg et alternativ i menyen som vises.

Slik fjerner du kolonner i tabellen Start Run on Selected Blocks (Start kjøring på valgte
blokker)

u Høyeklikk i tabellen og deaktiver alternativet i menyen som vises.

Slik redigerer du verdier for prøvevolum eller lokktemperatur for en blokk

u Velg prøvevolum- eller lokktemperaturcellen for målblokken og skriv inn en ny verdi i cellen.

Slik legger du til en kjørings-ID eller strekkode for en blokk

u Velg ID/Barcode (ID-/strekkodecellen) for målblokken og skriv inn en ID eller skann blokken med
en strekkodeleser.

Kjøre et eksperiment
Viktig: Før du kjører et eksperiment, må du se til at datamaskinens antivirusprogram ikke
kommer til å starte en skanning under kjøringen.

Slik kjører du et eksperiment

1. I fanen Start Run (Start kjøring) bekrefter du plate- og protokolldetaljene i delen Run Information
(Kjøringsinformasjon).

2. (Valgfritt) Legg til merknader om kjøringen eller eksperimentet i tekstboksen Notes (Merknader).

3. Merk avmerkingsboksen for én eller flere blokker som kjøringen skal utføres på.

Tips: Hvis du vil kjøre eksperimentet på alle blokker, velger du Select All Blocks (Velg alle
blokker) under tabellen Selected Blocks (Valgte blokker).

4. (Valgfritt) Klikk på Flash Block Indicator (Blokkindikatorlampe) for å få indikatorlampen på de valgte
instrumentblokkene til å blinke.

148 | CFX96 Dx- og CFX96 DeepWell Dx-systemet



Fanen Start Run (Start kjøring)

5. Sett eksperimentplater inn i blokken:

a. Klikk på Open Lid (Åpne lokk). Det motoriserte lokket for hver valgte blokk åpnes.

b. Sett en eksperimentblokk inn i hver valgte blokk.

c. Klikk på Close Lid (Lukk lokk).

Tips: Du kan også trykke på knappen foran på hver blokk for å åpne og lukke lokket.

6. Klikk på Open Lid (Åpne lokk) og Close Lid (Lukk lokk) for å åpne og lukke det motoriserte lokket
for hver valgte instrumentblokk.

7. Vis detaljene om kjøringen og gjør ett av følgende:

n Hvis detaljene er riktige, klikker du på Start Run (Start kjøring).

n Hvis detaljene ikke er riktige:

o Korriger detaljene i tabellen Selected Blocks (Valgte blokker) og klikk på Start Run (Start
kjøring).

o Returner til den korrigerte fanen og foreta relevante endringer, lagre endringene, og klikk
deretter på Next (Neste) for å returnere til fanen Start Run (Start kjøring) og starte
kjøringen.

Slik starter du en ny kjøring fra en tidligere kjøring

u Gjør ett av følgende:

n Velg File > Repeat a Run (Fil > Gjenta en kjøring) i programvarens hovedmenylinje, naviger
til og dobbeltklikk på kjøringsdatafilen som du ønsker å gjenta.

n Velg fanen Repeat Run (Gjenta kjøring) i Startup Wizard (Oppstartsveiviser) og dobbeltklikk
på kjøringsdatafilen for kjøringen som du ønsker å gjenta.

(Valgfritt) Klikk på Browse (Bla) på fanen Repeat Run (Gjenta kjøring) og dobbeltklikk på
kjøringsdatafilen som du ønsker å gjenta.
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Dialogboksen Run Details (Kjøringsdetaljer)
Når du klikker på Start Run (Start kjøring), ber CFX Manager Dx-programvaren deg om å lagre
datafilen (.pcrd), starter kjøringen og åpner dialogboksen Run Details (Kjøringsdetaljer). Dialogboksen
Run Details (Kjøringsdetaljer) består av tre statusfaner:

n Run Status (Kjøringsstatus) – bruk denne fanen for å vise gjeldende status for protokollen, åpne
eller lukke lokket, sette en kjøring på pause, legge til gjentakelser, hoppe over trinn eller stanse
kjøringen.

n Real-time Status (Sanntidsstatus) – bruk denne fanen for å vise PCR-fluorescensdata i sanntid
etter hvert som de samles inn.

n Time Status (Tidsstatus) – bruk denne fanen for å vise en nedteller i fullskjerm for protokollen.

Disse fanene forklares i detalj i de neste avsnittene.

Fanen Run Status (Kjøringsstatus)
Fanen Run Status (Kjøringsstatus) viser gjeldende status for en kjøring som pågår. I denne visningen
kan du også kontrollere lokket og endre kjøringen som pågår.
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1. Ruten Run Status (Kjøringsstatus) – viser gjeldende fremdrift for protokollen.

2. Kontroller for Run Status (Kjøringsstatus) – brukes til å betjene instrumentet eller
avbryte den gjeldende protokollen.

3. Ruten Run Information (Kjøringsinformasjon) – viser kjøringsdetaljer.

FORKLARING

Kommandoer i Run Status (Kjøringsstatus)

Kommandoene i fanen Run Status (Kjøringsstatus) brukes til enten å betjene instrumentet via
programvaren eller endre en kjøring som pågår.

Merknad: Endringer i protokollen under kjøringen, for eksempel tilføyelse av repetisjoner, endrer
ikke protokollfilen som er knyttet til kjøringen. Disse handlingene registreres i Run Log
(Kjøringslogg).

– åpner det motoriserte lokket på valgte instrumenter.

Viktig: Hvis lokket åpnes under en kjøring, settes kjøringen på pause i det aktuelle trinnet, og
dataene kan bli påvirket.

– lukker det motoriserte lokket på valgte instrumenter.

– legger til flere repetisjoner i det aktuelle GOTO-trinnet i protokollen. Dette alternativet er kun
tilgjengelig når et GOTO-trinn kjører.

– hopper over det gjeldende trinnet i protokollen.

Merknad: Hvis du hopper over et GOTO-trinn, ber programvaren deg om å bekrefte at du
ønsker å hoppe over hele GOTO-sløyfen og fortsette til neste trinn i protokollen.

– gjør at LED-en på det valgte instrumentet blinker for å identifisere de valgte blokkene.
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– setter protokollen på pause.

Merknad: Denne handlingen registreres i Run Log (Kjøringslogg).

– gjenopptar en protokoll som er satt på pause.

– stopper kjøringen før protokollene avsluttes.

Merknad: Hvis en kjøring stoppes før protokollen avsluttes, kan det påvirke dataene.

152 | CFX96 Dx- og CFX96 DeepWell Dx-systemet



Dialogboksen Run Details (Kjøringsdetaljer)

Fanen Real-time Status (Sanntidsstatus)
Fanen Real-time Status (Sanntidsstatus) viser PCR-data i sanntid som er samlet inn i hver syklus
under kjøringen etter de to første plateavlesningene.

1. Amplification (Amplifisering)-kurverute – viser amplifiseringsdata i sanntid under
kjøringen.

2. Well group (Brønngruppe)-identifikator – hvis brønngrupper ble identifisert i
plateoppsettet, kan brukere velge en spesifikk brønngruppe for å vise dens
kurver, brønner og tabellinformasjon.

Step number (Trinnummer)-identifikator – hvis protokollen samler inn data i mer
enn ett trinn (for eksempel under amplifisering og smeltekurve), kan brukere
velge et spesifikt trinn og vise kurvene som ble samlet inn i dette trinnet.

3. Well selector (Brønnvelger)-rute – viser de aktive, inaktive og tomme brønnene i
platen.

4. Plate setup (Plateoppsett)-tabellrute – viser plateoppsettet i tabellformat.

FORKLARING
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5. Run details (Kjøringsdetaljer)-rute – viser sanntidsstatus for kjøringen, inkludert:

n gjeldende trinn

n gjeldende gjentakelse

n gjeldende temperatur

n gjenværende tid

n prøvetemperatur

n lokktemperatur

6. Plate Setup (Plateoppsett) – åpner dialogboksen Plate Setup (Plateoppsett), der
brukere kan endre det gjeldende plateoppsettet under en kjøring.

I fanen Real-time Status (Sanntidsstatus) kan du:

n vise eller skjule sanntidskurver ved å velge dem i brønnvelger-ruten eller plateoppsett-tabellen

n vise enkle kurver eller kurvegrupper ved å velge dem i brønngruppe-rullegardinmenyen

n redigere platen eller erstatte platefilen

n bruke en PrimePCR-fil til kjøringen

Vise eller skjule sanntidskurver

Alle fylte brønner er aktive og vises i plateoppsettabellen som standard. Aktive brønner vises i blått i
brønnvelgerruten. Skjulte brønner vises i lysegrått, og ubrukte brønner vises i mørkegrått i
brønnvelgerruten.

Du kan skjule kurver i aktive brønner under kjøringen. CFX Manager Dx fortsetter å samle inn data for
alle brønner. Når du skjuler brønner, vil ikke dataene vises i plateoppsettabellen.

Slik skjuler du sanntidskurver

u I brønnvelgerruten klikker du på de aktive (blå) brønnene du ønsker å skjule.

Slik viser du sanntidskurver

u I brønnvelgerruten klikker du på de skjulte (lysegrå) brønnene du ønsker å vise.

Hvis du vil ha mer informasjon om brønnvelgeren, se Brønnvelger på side 170.
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Redigere et plateoppsett

Slik redigerer du et plateoppsett

u Klikk på Plate Setup (Plateoppsett) og velg deretter View/Edit Plate (Vis/rediger plate).

Vinduet Plate Editor (Plateredigering) vises, der du kan redigere platen mens kjøringen pågår.
Hvis du vil ha mer informasjon om hvordan du redigerer plater, se Kapittel 7, Klargjøre plater.

Merknad: Du kan også redigere kurvestiler fra vinduet Plate Editor (Plateredigering).
Endringer vises i amplifiseringskurvediagrammet i fanen Real-Time Status (Sanntidsstatus).

Erstatte en platefil

Tips: Det kan være nyttig å erstatte en platefil hvis du starter en kjøring med en hurtigplatefil i
ExpressLoad-mappen.

Slik erstatter du en platefil

u Klikk på Plate Setup (Plateoppsett) og velg deretter ett av de følgende alternativene:

n Replace Plate file (Erstatt platefil) – velg den nye platefilen fra listen i filleservinduet

n Apply PrimePCR file (Bruk PrimePCR-fil) – søk etter en kjøringsfil som plateoppsettet skal
hentes fra, ved hjelp av Smart-søk, eller klikk på Browse (Bla gjennom) for å finne en fil som
du lastet ned fra Bio-Rad-nettstedet og som ikke finnes i PrimePCR-mappen

Merknad: CFXManager Dx kontrollerer skannemodusen og platestørrelsen for platefilen.
Disse må være de samme som kjøringsinnstillingene som kjøringen ble startet med.
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Fanen Time Status (Tidsstatus)
Fanen Time Status (Tidsstatus) viser tiden som gjenstår før den aktuelle kjøringen er fullført.
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Utføre PrimePCR-eksperimenter
PrimePCR-eksperimenter bruker pathway- eller sykdomsspesifikke analyser som Bio-Rad har våtlab-
validert og -optimert, og er tilgjengelig i følgende formater:

n Forhåndsplatede paneler – plater som inneholder analyser som er spesifikke for en biologisk
pathway eller sykdom; inkluderer PrimePCR-kontroller og referansegener

n Egenkonfigurerte plater – plater som kan settes opp i et brukerkonfigurert oppsett, med alternativ
for å velge analyser for interessemål, kontroller og referanser

n Individuelle analyser – rør som inneholder individuelle primersett for bruk i sanntidsreaksjoner

For å redusere total kjøringstid kan du fjerne smeltetrinnet i protokollen. Bio-Rad anbefaler på det
sterkeste at du ikke endrer noe annet i en PrimePCR-kjøringsprotokoll. Standardprotokollen er den
som ble brukt for analysevalidering. Avvik fra denne kan påvirke resultatene. Protokollendringer føres
opp i fanen Run Information (Kjøringsinformasjon) for den resulterende datafilen og i eventuelle
rapporter som opprettes.

Slik starter du en PrimePCR-kjøring

u Gjør ett av følgende for å starte en PrimePCR-kjøring:

n I Startup Wizard (Oppstartsveiviser) velger du PrimePCR i fanen Run setup
(Kjøringsoppsett), og deretter velger du egnet kjemi (SYBER eller probe).

n Velg en PrimePCR-kjøring på listen Recent Runs (Nylige kjøringer) i fanen Repeat run
(Gjenta kjøring) i Startup Wizard (Oppstartsveiviser).

n Velg File > New > PrimePCR Run (Fil > Ny > PrimePCR-kjøring) i startvinduet.

n Velg File > Open > PrimePCR Run File (Fil > Åpne > PrimePCR-kjøringsfil) i startvinduet.

n Dra og slipp en PrimePCR-kjøringsfil i startvinduet.

Etter at du velger en PrimePCR-kjøring, åpnes vinduet Run Setup (Kjøringsoppsett) og viser fanen
Start Run (Start kjøring) med standard PrimePCR-plateoppsett basert på valgt instrument.

Slik fjerner du smeltetrinnet i protokollen

u I fanen Protocol (Protokoll) fjerner du haken i avmerkingsboksen ved siden av Include Melt Step
(Inkluder smeltetrinn).
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Slik importerer du målinformasjon for PrimePCR-plater til et plateoppsett

1. Gjør ett av følgende:

n I fanen Real-time Status (Sanntidsstatus) i dialogboksen Run Details (Kjøringsdetaljer)
velger du Plate Setup > Apply PrimePCR File (Plateoppsett > Bruk PrimePCR-fil).

n I vinduet Data Analysis (Dataanalyse) velger du Plate Setup > Apply PrimePCR File
(Plateoppsett > Bruk PrimePCR-fil).

2. I dialogboksen PrimePCR run file (PrimePCR-kjøringsfil) klikker du på Browse (Bla gjennom) for å
navigere til riktig PrimePCR-fil (.csv).

3. Velg ønsket PrimePCR-fil og klikk på Open (Åpne).

CFX Manager Dx importerer målinformasjonen til plateoppsettet.
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CFXManager™ Dx byr på flere metoder for å åpne og vise datafiler. Du kan:

n Velge File > Open > Data File (Fil > Åpne > Datafil) i startvinduet og bla til ønsket .pcrd-fil.

n Velge File > Recent Data Files (Fil > Nyeste datafiler) i startvinduet for å velge fra en liste over de
10 siste datafilene som har vært åpnet.

Vinduet Data Analysis (Dataanalyse)
Vinduet Data Analysis (Dataanalyse) inneholder flere faner, og hver fane viser de analyserte dataene
for en bestemt analysemetode eller informasjon om en bestemt kjøring. Faner vises kun hvis dataene
som er samlet inn i kjøringen, er tilgjengelige for den aktuelle analysetypen.

Tips: Du velger fanene som skal vises fra rullegardinmenyen View (Visning) i vinduet Data
Analysis (Dataanalyse). Hvis du vil gå tilbake til det opprinnelige faneoppsettet, velger du Settings
> Restore Default Window Layout (Innstillinger > Gjenopprett standard vindusoppsett).
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Verktøylinje i Data Analysis (Dataanalyse)
Verktøylinjen i vinduet Data Analysis (Dataanalyse) gir rask tilgang til viktige dataanalysefunksjoner.

Tabell 15 viser en liste over funksjonene til knappene på verktøylinjen.

Knapp Navn Funksjon

Plate Setup
(Plateoppsett)

View/Edit plate (Vis/rediger plate): Åpner
Plate Editor (Plateredigering) der du kan
vise og redigere innholdet i brønnene.

Replace Plate file (Skift platefil): Velger en
platefil for å skifte plateoppsettet.

Apply PrimePCR file (Bruk PrimePCR-fil):
Velger en kjøringsfil for å skifte
plateoppsettet for en PrimePCR™-kjøring.

ManageWell
Groups (Administrer
brønngrupper)

Åpner vinduet Well Groups Manager
(Administrering av brønngrupper) der du
kan opprette, redigere og slette
brønngrupper.

Well Group
(Brønngruppe)

Velger et eksisterende brønngruppenavn
fra rullegardinmenyen. All Wells (Alle
brønner) er valgt som standard. Denne
knappen vises kun når brønngrupper er
opprettet.

Analysis Mode
(Analysemodus)

Analyserer dataene i modusen Fluorophore
(Fluorofor) eller Target (Mål).

Help (Hjelp) Åpner en digital kopi av denne håndboken i
Acrobat PDF-format.

Tabell 15. Verktøylinje i vinduet Data Analysis (Dataanalyse)
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Menylinje i Data Analysis (Dataanalyse)
Tabell 16 viser elementene på menylinjen i vinduet Data Analysis (Dataanalyse).

Menyelement Kommando Funksjon

Fil (File) Save (Lagre) Lagrer filen.

Save As (Lagre som) Lagrer filen med et nytt navn.

Repeat Run (Gjenta kjøring) Henter ut protokollen og platefilen fra den
pågående kjøringen for å kjøre den på
nytt.

Close (Lukk) Lukk vinduet Data Analysis (Dataanalyse)

View (Vis) Run Log (Kjøringslogg) Åpner vinduet Run Log (Kjøringslogg),
der du kan vise kjøringsloggen for den
gjeldende datafilen.

Quantification (Kvantifisering),
Melt Curve (Smeltekurve), Gene
Expression (Genuttrykk), End
Point (Endepunkt), Custom Data
View (Tilpasset datavisning), QC
(Kvalitetskontroll), Run
Information
(Kjøringsinformasjon)

Viser de analyserte dataene i de valgte
fanene i vinduet Data Analysis
(Dataanalyse). Minst én fane må være
valgt.

Settings
(Innstillinger)

Cq Determination Mode (Cq-
bestemmelsesmodus)

Velg modusen Regression (Regresjon)
eller Single Threshold (Enkel terskel) for å
bestemme hvordan Cq-verdiene
bestemmes for hver kurve.

Baseline Setting
(Baselinjeinnstilling)

Velg metoden Baseline Subtraction
(Baselinjesubtraksjon) for de valgte
brønngruppene.

Analysis Mode (Analysemodus) Velg å analysere dataene etter
Fluorophore (Fluorofor) eller Target (Mål).

Cycles to Analyze (Sykluser som
skal analyseres)

Velg syklusene som skal analyseres.

Tabell 16. Elementer på menylinjen i vinduet Data Analysis (Dataanalyse)
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Menyelement Kommando Funksjon

Baseline Threshold
(Baselinjeterskler)

Åpner vinduet Baseline Threshold
(Baselinjeterskler) for å justere baselinjen
eller terskelen.

Trace Styles (Kurvestiler) Åpner vinduet Trace Styles (Kurvestiler).

Plate Setup (Plateoppsett) Åpner Plate Editor (Plateredigering) for
visning og redigering av platen. Skift ut
den pågående platen med en plate fra en
brukerdefinert platefil eller en PrimePCR-
kjøringsfil.

Include All Excluded Wells
(Inkluder alle ekskluderte
brønner)

Inkluderer alle ekskluderte brønner i
analysen.

Mouse Highlighting
(Musemerking)

Slår av eller på samtidig merking av data
med musepekeren.

Tips: Hvis Mouse Highlighting
(Musemerking) er slått av, trykker du
på Control-tasten på tastaturet for å
slå merking på midlertidig.

Restore Default Window Layout
(Gjenopprett standard
vindusoppsett)

Gjenoppretter vindusoppsettet til
standardinnstillingen.

Tabell 16. Elementer på menylinjen i vinduet Data Analysis (Dataanalyse), forts.
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Menyelement Kommando Funksjon

Export (Eksport) Export All Data Sheets to Excel
(Eksporter alle dataark til Excel)

Eksporterer alle regnearkvisningene fra
hver fane til en separat Excel-fil.

Custom Export (Tilpasset
eksport)

Åpner vinduet Custom Export (Tilpasset
eksport), der du kan angi feltene du vil
eksportere samt filformat for eksportfilen.

Export to LIMS Folder (Eksporter
til LIMS-mappe)

Åpner et vindu der du kan lagre data i
LIMS-mappen i et forhåndsbestemt
format.

Seegene Export (Seegene-
eksport)

Åpner et vindu der du kan identifisere
plasseringen for lagring av data fra alle
regnearkvisninger i Excel-filer som er
bygget opp spesifikt for bruk av Seegene,
Inc.

Tools (Verktøy) Reports (Rapporter) Åpner Report (Rapport) for denne
datafilen.

Well Group Reports
(Brønngrupperapporter)

Åpner vinduet Well Group Reports
(Brønngrupperapporter), der du kan
generere rapporter for spesifiserte
brønngrupper.

Import Fluorophore Calibration
(Importer fluoroforkalibrering)

Velg en kalibreringsfil som skal brukes på
den gjeldende datafilen.

qbase+ Åpner qbase+ v2.5 direkte fra den
gjeldende .pcrd-filen, hvis det er installert.

Tabell 16. Elementer på menylinjen i vinduet Data Analysis (Dataanalyse), forts.
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Informasjon om faner
Hver fane i vinduet Data Analysis (Dataanalyse) viser data i diagrammer og regneark for en bestemt
analysemetode, og inneholder en brønnvelger som brukes til å velge dataene du vil vise. Når vinduet
Data Analysis (Dataanalyse) åpnes, vises fanen Quantification (Kvantifisering) som standard. Du kan
bruke dataene i diagrammet Amplification (Amplifisering) i fanen Quantification (Kvantifisering) til å
bestemme de relevante analyseinnstillingene for kjøringen.

Merknad: Programvaren kobler sammen dataene i rutene i hver fane i vinduet Data Analysis
(Dataanalyse). Hvis du for eksempel uthever en brønn ved å plassere musepekeren over
brønnen i brønnvelgervisningen, utheves dataene i alle de andre rutene.
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Velgeren Step Number (Trinnummer)
CFX96- og CFX96 DeepWell-systemene kan innhente fluorescensdata i flere protokolltrinn.
Programvaren bevarer dataene som innhentes i hvert trinn uavhengig av hverandre. Programvaren
viser velgeren Step Number (Trinnummer). Når en protokoll inneholder minst ett datainnsamlingstrinn,
viser CFX Manager Dx-programvaren dataene fra det første innsamlingstrinnet.

Hvis protokollen inneholder mer enn ett innsamlingstrinn, kan du velge et annet trinn fra
rullegardinmenyen, for eksempel:

Når du velger et trinn, bruker programvaren dette valget på alle dataene som vises i vinduet Data
Analysis (Dataanalyse).

Vise Well Groups (Brønngrupper) i Data Analysis (Dataanalyse)
Brønner i platen kan grupperes i undersett for uavhengig analyse ved bruk av brønngrupper. Når du
oppretter brønngrupper, vises gruppenavnene i vinduet Data Analysis (Dataanalyse) i
rullegardinmenyenWell Groups (Brønngrupper) på verktøylinjen.

Hvis du opprettet brønngrupper, viser programvaren standardbrønngruppen All Wells (Alle brønner)
når du åpner vinduet Data Analysis (Dataanalyse), og viser dataene i alle brønner med innhold i
diagrammene og regnearkene. Kun brønnene i brønngruppen med det innlastede innholdet vises i
brønnvelgeren, og kun data for disse brønnene er inkludert i dataanalyseberegningene.

Merknad: Hvis du ikke opprettet brønngrupper, vises ikke rullegardinmenyenWell Groups
(Brønngrupper) på verktøylinjen.

Endre brønninnhold etter en kjøring
Under dataanalyse, hvis måten data vises på endres ved å endre innholdet i brønnene i Plate Editor
(Plateredigering), endres aldri fluorescensdataene som ble samlet inn fra hver brønn under kjøringen.
Når modulen har samlet inn fluorescensdata, kan du ikke slette disse dataene, men du kan velge å
fjerne dem fra visningen og analysen.

Slik endrer du innholdet i brønner etter en kjøring

u I vinduet Data Analysis (Dataanalyse) klikker du på Plate Setup (Plateoppsett) og velger et av
følgende alternativer:

n Edit/View Plate (Rediger/vis plate) – åpner Plate Editor (Plateredigering), der du kan endre
oppsettet manuelt.
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n Replace Plate File (Erstatt platefil) – åpner dialogboksen for valg av plate, der du kan
navigere til en tidligere lagret platefil som du vil skal erstatte det gjeldende plateoppsettet.

n Apply PrimePCR file (Bruk PrimePCR-fil) – åpner dialogboksen for valg av PrimePCR-fil,
der du kan navigere til en PrimePCR™-kjøringsfil og bruke den i plateoppsettet.

Tips: Du kan legge til eller redigere informasjon om innholdet i brønnen før en kjøring, under en
kjøring eller etter fullføring av en PCR-kjøring. Du må tilordne skannemodus og platestørrelse før
kjøringen. Disse parametrene kan ikke endres etter kjøringen.
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Innstillinger for dataanalyse
Diagramdataene for Amplification (Amplifisering) i fanen Quantification (Kvantifisering) viser den
relative fluorescensen (RFU) for hver brønn ved hver syklus. Hver kurve i diagrammet representerer
data fra en fluorofor i én brønn. Disse dataene brukes for å fastslå Cq-verdier for hver brønn per
fluorofor. Programvaren bruker én eller to moduser for å fastslå Cq-verdier:

n Regression (Regresjon) – anvender en multivariabel, ikke-lineær regresjonsmodell på
individuelle brønnkurver og bruker deretter denne modellen til å beregne en optimal Cq-verdi.

n Single Threshold (Enkel terskel) – bruker en enkel terskelverdi til å beregne Cq-verdien basert
på terskelskjæringspunktet til individuelle fluorescenskurver.

Velg Settings > Cq Determination Mode (Innstillinger > Cq-bestemmelsesmodus) for å velge Cq-
bestemmelsesmodusen.

Justere terskelen
I modusen Single Threshold (Enkel terskel) kan du justere terskelen for en fluorofor ved å klikke på
terskellinjen i Amplification Chart (Amplifiseringsdiagram) og bevege musepekeren vertikalt.
Alternativt kan du spesifisere en nøyaktig krysningsterskel for den valgte fluoroforen.

Baselinjeinnstillinger
Programvaren angir automatisk baselinjen individuelt for hver brønn. Baselinjeinnstillingen
bestemmer metoden for baselinjesubtraksjon for alle fluorescenskurver. Programvaren har tre
alternativer for baselinjesubtraksjon:

n No Baseline Subtraction (Ingen baselinjesubtraksjon) – viser dataene som relative
fluorescenskurver. Noen analyser kan ikke utføres i denne analysemodusen, og programvaren
viser derfor ikke fanene Gene Expression (Genuttrykk), End Point (Endepunkt) og Allelic
Discrimination (Allelisk diskriminering).

n Baseline Subtracted (Baselinjesubtrahert) – viser dataene som baselinjesubtraherte kurver for
hver fluorofor i en brønn. Programvaren må baselinjesubtrahere dataene for å bestemme
kvantifiseringssykluser, konstruere standardkurver og bestemme konsentrasjonen av ukjente
prøver. For å generere en baselinjesubtrahert kurve tilpasser programvaren den beste rette linjen
gjennom den registrerte fluorescensen for hver brønn under baselinjesyklusene, og subtraherer
deretter de best tilpassede dataene fra de bakgrunnssubtraherte dataene ved hver syklus.
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n Baseline Subtracted Curve Fit (Baselinjesubtrahert kurvetilpasning) – viser dataene som
baselinjesubtraherte kurver, og programvaren jevner ut den baselinjesubtraherte kurven ved
hjelp av et sentrert gjennomsnittsfilter. Denne prosessen utføres slik at hver Cq forblir konstant.

I tillegg til disse alternativene kan du også velge Apply Fluorescent Drift Correction (Bruk korreksjon mot
fluorescensavvik). For brønner som har unormalt variererende RFU-verdier under de første syklusene i
en kjøring, vil programvaren derivere en estimert baselinje fra tilstøtende brønner som det var mulig å
generere en horisontal baselinje for.

Slik endrer du innstillingen for baselinjesubtraksjon

u Velg Settings > Baseline Setting (Innstillinger > Baselinjeinnstilling).

Analysemodus
Data kan grupperes og analyseres etter enten fluorofor eller målnavn. Når data er gruppert etter
fluorofor, vises datakurver etter fluorofor som angitt i plateoppsettet for den aktuelle kjøringen.
Individuelle fluorofordata vises i amplifiserings- og standardkurvediagrammet (hvis tilgjengelig) når de
relevante avmerkingsboksene for fluorofor, som er plassert under amplifiseringsdiagrammet, er valgt.

Når data er gruppert etter mål, vises datakurver etter målnavn som angitt i plateoppsettet for den
aktuelle kjøringen.
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Innstillinger for dataanalyse

Slik velger du en dataanalysemodus

u Gjør ett av følgende:

n Velg Settings > Analysis Mode (Innstillinger > Analysemodus).

n Velg en modus fra rullegardinmenyen Analysis Mode (Analysemodus) på verktøylinjen.

Sykluser som skal analyseres
Du kan begrense antall sykluser som skal analyseres. Du kan også analysere data fra et spesifikt sett
med sykluser. Maksimalt antall sykluser du kan analysere, er 50.

Merknad: Fjerning av sykluser fra begynnelsen av en kjøring kan ha en signifikant innvirkning på
baselinjen.

Slik begrenser du dataanalyse til et spesifikt antall sykluser

1. Velg Settings > Cycles to Analyze (Innstillinger > Sykluser som skal analyseres).

Dialogboksen Cycles to Analyze (Sykluser som skal analyseres) vises.

2. Angi start- og sluttsyklusverdiene og klikk på OK.

Klikk på Restore Defaults (Gjenopprett standarder) i dialogboksen Cycles to Analyze (Sykluser som
skal analyseres) for å gjenopprette de opprinnelige syklusene som ble brukt for analysen.
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Brønnvelger
Bruk Well Selector (Brønnvelger) til å vise eller skjule brønndata i diagrammer eller regneark i vinduet
Data Analysis (Dataanalyse). Kun brønner som er lastet med en prøve, kan velges i brønnvelgeren.
Programvaren farger brønnene i Well Selector (Brønnvelger):

n Blå – angir valgte brønner. Data fra valgte brønner vises i vinduet Data Analysis (Dataanalyse).

n Lysegrå – angir ikke-valgte brønner. Data fra ikke-valgte brønner vises ikke i vinduet Data
Analysis (Dataanalyse).

n Mørkegrå – angir tomme brønner.

Slik viser eller skjuler du brønndata

u Velg en av følgende fremgangsmåter i brønnvelgeren:

n Hvis du vil skjule en brønn, klikker du på brønnen. Hvis du vil vise brønnen, klikker du på
brønnen en gang til.

n Hvis du vil skjule flere brønner, drar du markøren over brønnene du vil velge. Hvis du vil vise
brønnene, drar du markøren over brønnene en gang til.

n Klikk øverst til venstre i platen for å skjule alle brønner. Klikk øverst til venstre en gang til for å
vise alle brønner.

n Klikk i starten av en kolonne eller rad for å skjule disse brønnene. Klikk i kolonnen eller raden
en gang til for å vise brønnene.
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Brønnvelger

Elementer i høyreklikkmenyen for Well Selector (Brønnvelger)
Tabell 17 viser tilgjengelige høyreklikkalternativer i brønnvelgervisningen.

Element Funksjon

Well XX (Brønn XX) Viser kun denne brønnen, fjerner denne brønnen fra visningen,
angir farge for denne brønnen, eller utelukker denne brønnen fra
analysen.

Selected Wells (Valgte
brønner) (høyreklikk og dra)

Viser kun disse brønnene, fjerner disse brønnene fra visningen,
angir farge for disse brønnene, eller utelukker disse brønnene fra
analysen.

Copy (Kopier) Kopierer innholdet i brønnen til en utklippstavle, inkludert Sample
Type (Prøvetype) og valgfritt Replicate # (Replikatnr.).

Copy as Image (Kopier som
bilde)

Kopierer brønnvelgervisningen som et bilde.

Print (Skriv ut) Skriver ut brønnvelgervisningen.

Print Selection (Skriv ut utvalg) Skriver ut det gjeldende utvalget.

Export to Excel (Eksporter til
Excel)

Eksporterer dataene til et Excel-regneark.

Export to Csv (Eksporter til Csv) Eksporterer dataene som et tekstdokument.

Export to Xml (Eksporter til Xml) Eksporterer dataene som et .xml-dokument.

Well Labels (Brønnetiketter) Endrer brønnetikettene til Sample Type (Prøvetype), Target Name
(Målnavn) eller Sample Name (Prøvenavn).

Tabell 17. Elementer i høyreklikkmenyen for brønnvelger
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Midlertidig ekskludering av brønner fra analyse
Slik ekskluderer du brønner fra en dataanalyse midlertidig

1. Høyreklikk på brønnen i brønnvelgeren. Når du skal ekskludere flere brønner, kan du høyreklikke
og dra for å merke flere brønner, kurver eller punkter.

2. Velg ønsket alternativ fra høyreklikkmenyen:

n Well > Exclude Well (Brønn > Ekskluder brønn)

n Selected Wells > Exclude from Analysis (Valgte brønner > Ekskluder fra analyse)

n Selected Traces > Exclude these wells from Analysis (Valgte kurver > Ekskluder disse
brønnene fra analyse)

Du kan også fjerne brønner permanent fra analyse ved å klikke på knappen Clear Wells (Fjern
brønner) for å fjerne innholdet fra brønner i Plate Editor (Plateredigering).

Viktig: Alt innhold som fjernes fra brønnen(e), må legges inn på nytt.

Slik inkluderer du en ekskludert brønn

u Høyreklikk på ønsket brønn i brønnvelgeren, og velg Well > Include Well in Analysis (Brønn >
Inkluder brønn i analyse).
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Diagrammer
Hvert diagram i vinduet Data Analysis (Dataanalyse) viser dataene i forskjellige grafer og inneholder
alternativer som kan brukes til å justere og eksportere data eller diagramgrafikk.

Vanlige elementer i høyreklikkmenyen for diagrammer
Tabell 18 viser en liste over elementer i høyreklikkmenyen som er tilgjengelige for diagrammer. Noen
av elementene er tilgjengelige for alle diagrammer. Disse elementene kan brukes til å endre måten
dataene vises på, eller til å eksportere dataene fra et diagram på en enkel måte.

Element Funksjon

Copy (Kopier) Kopierer diagrammet til utklippstavlen.

Save Image As (Lagre bilde
som)

Lagrer bildet med en angitt størrelse, oppløsning og filtype.
Tilgjengelige bildeformater er PNG (standard), JPG og BMP.

Page Setup (Sideoppsett) Forhåndsvis og velg sideoppsett for utskrift.

Print (Skriv ut) Skriver ut diagrammet.

Set Scale to Default (Angi
skala til standard)

Gjenoppretter diagrammets standardvisning etter at diagrammet har
vært forstørret.

Chart Options
(Diagramalternativer)

Åpner vinduet Chart Options (Diagramalternativer) for å endre
diagrammet, inkludert endre tittelen, velge grenser for X- og Y-
aksene, vise rutenettlinjer og vise mindre hakemerker på aksene.

Tabell 18. Elementer i høyreklikkmenyen for diagrammer

Merknad: Menyelementer som gjelder for bestemte diagrammer, er beskrevet i Kapittel 10,
Detaljer om dataanalyse.

Kopiere diagramdata til utklippstavlen
Du kan kopiere innholdet i diagramvisningen og lime det inn i alle programmer som godtar bitmap-
bildefiler.

Slik kopierer du diagramdata til utklippstavlen

1. Fra diagrammets høyreklikkmeny velger du Copy (Kopier).

2. Åpne et program som godtar bitmap-bilder, for eksempel Microsoft Word.

3. Høyreklikk og velg Paste (Lim inn) for å lime inn bitmap-bildet fra utklippstavlen i programmet.
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Endre innstillingene for Baseline Threshold (Baselinjeterskel)
I modusen Single Threshold (Enkel terskel) kan du justere terskelen for en fluorofor ved å klikke på
terskellinjen i Amplification Chart (Amplifiseringsdiagram) og bevege musepekeren vertikalt.
Alternativt kan du spesifisere en nøyaktig krysningsterskel for den valgte fluoroforen.

Tips: Du kan spesifisere et syklusområde for å fastslå baselinjen for alle datafiler i fanen Data
Analysis (Dataanalyse) i User > User Preferences (Bruker > Brukerpreferanser).

Slik justerer du begynnende og avsluttende baselinjesyklus for hver brønn

1. I fanen Quantification (Kvantifisering) velger du en enkelt fluorofor under
amplifiseringsdiagrammet.

2. I høyreklikkmenyen i diagrammet velger du Baseline Threshold (Baselinjeterskel).

Dialogboksen Baseline Threshold (Baselinjeterskel) vises.
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Diagrammer

3. Gjør et av følgende i delen Baseline Cycles (Baselinjesykluser):

n Velg én brønn ved å klikke på radnummeret.

n Velg flere tilstøtende brønner ved å klikke på radnummeret til den første brønnen og dra
nedover i kolonnen til den siste brønnen.

n Velg flere ikke-tilstøtende brønner ved å trykke på Ctrl-tasten på tastaturet og klikke på
radnummeret til hver målbrønn.

n Velg alle brønner ved å klikke øverst til venstre i tabellen.

4. Juster syklusen Baseline Begin (Begynnende baselinje) og syklusen Baseline End (Avsluttende
baselinje) for alle valgte brønner, eller endre syklusnummeret for Begin (Begynnende) og End
(Avsluttende) nederst i regnearket.

Tips: Hvis du vil tilbakestille innstillingene til de sist lagrede verdiene, klikker du på Reset All
User Defined Values (Tilbakestill alle brukerdefinerte verdier).

5. Klikk på OK for å lagre endringene og gå tilbake til diagrammet.

Slik spesifiserer du et syklusområde for alle datafiler

u I startvinduet eller vinduet for plateredigering velger du User > User Preferences (Bruker >
Brukerpreferanser) og velger fanen Data Analysis (Dataanalyse).

Sortere måldata og prøvedata
Merknad: Dette alternativet er kun tilgjengelig for genuttrykksdiagrammer.

Som standard vises listene Targets (Mål) og Samples (Prøver) i alfabetisk rekkefølge. Bruk
dialogboksen Sort (Sorter) for å sortere visningen i omvendt alfabetisk rekkefølge eller for manuelt å
flytte et begrep til en annen plassering på listen.

Slik sorterer du data for mål og prøver

1. Klikk på Sort (Sorter) i diagrammets høyreklikkmeny.

Dialogboksen Gene Expression Chart Sorting (Sortering i genuttrykksdiagram).
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2. Klikk på Z-A i dialogboksen for å sortere listen i omvendt alfabetisk rekkefølge.

3. Hvis du vil flytte et begrep manuelt, velger du begrepet og klikker på den relevante knappen
mellom diagrammene:

n Klikk på pil opp eller pil ned for å flytte det valgte begrepet én posisjon.

n Klikk på pil opp- eller pil ned-rullefeltet for å flytte det valgte begrepet til øverste eller nederste
posisjon på listen.

4. Klikk på OK for å lagre endringene og gå tilbake til fanen Gene Expression (Genuttrykk).

Forstørre et område i diagrammet
Slik forstørrer du et område i diagrammet

u Klikk og dra over diagrammet, og klikk deretter på Zoom*. Programvaren endrer størrelsen på
diagrammet og sentrerer det i det valgte området.

Merknad: * Bar Chart (Søylediagram) krever ikke at du klikker på popup-kommandoen
Zoom.

Slik tilbakestiller du diagrammet til full visning

u Høyreklikk i diagrammet og velg Set Scale to Default (Sett skala til standard).

Kopiere diagrammer til en Microsoft-fil
Du kan kopiere datadiagrammer til Microsoft Word-, Excel- eller PowerPoint-dokumenter.
Bildeoppløsningen er den samme som på skjermen bildet ble hentet fra

Slik kopierer du diagrammer til en Microsoft-fil

1. I vinduet Data Analysis (Dataanalyse) velger du Copy (Kopier) på høyreklikkmenyen i
diagrammet.

2. Åpne en tomMicrosoft-fil og lim inn innholdet fra utklippstavlen.

Alternativ: Klikk på klikk-og-dra-ikonet og dra og slipp diagrammet i Microsoft-filen.
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Regneark
Regnearkene som vises i Data Analysis (Dataanalyse), inkluderer alternativer for sortering og
overføring av data. Du kan sortere kolonnene ved hjelp av én av disse metodene:

n Klikk og dra en kolonne til en ny plassering i den valgte tabellen.

n Klikk på kolonneoverskriften for å sortere dataene i stigende eller synkende rekkefølge.

Slik sorterer du opptil tre kolonner med data i vinduet Sort (Sortering)

1. Høyreklikk i regnearket og velg Sort (Sorter).

2. I dialogboksen Sort (Sortering) velger du den første kolonnetittelen som skal sorteres. Sorter
dataene i stigende eller synkende rekkefølge.

3. Velg en andre eller tredje kolonne som skal sorteres, og velg Ascending (Stigende) eller
Descending (Synkende).

4. Klikk på OK for å sortere dataene eller på Cancel (Avbryt) for å stoppe sorteringen.

Uthev dataene i de tilhørende diagrammene og brønnvelgeren ved å holde musepekeren over en
celle. Klikk på en celle for å kopiere innholdet og lime det inn i et annet program.

Vanlige elementer i høyreklikkmenyen for regneark
Tabell 19 viser de tilgjengelige elementene i høyreklikkmenyen i alle regnearkvisninger.

Element Funksjon

Copy (Kopier) Kopierer innholdet i de valgte brønnene til en utklippstavle, og limer
deretter innholdet inn i et regneark, som f.eks. Excel.

Copy as Image (Kopier som
bilde)

Kopierer regnearkvisningen som en bildefil og limer den inn i en fil
som godtar en bildefil, som f.eks. tekst-, bilde- eller regnearkfiler.

Print (Skriv ut) Skriver ut den gjeldende visningen.

Print Selection (Skriv ut utvalg) Skriver ut det gjeldende utvalget.

Export to Excel (Eksporter til
Excel)

Eksporterer dataene til et Excel-regneark.

Export to CSV (Eksporter til
CSV)

Eksporterer dataene til en kommaseparert fil (.csv).

Tabell 19. Elementer i høyreklikkmenyen for regneark
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Element Funksjon

Export to Xml (Eksporter til Xml) Eksporterer dataene til en Xml-fil.

Export to Html (Eksporter til
Html)

Eksporterer dataene til en Html-fil.

Find (Søk) Søker etter tekst.

Sort (Sorter) Sorterer dataene i opptil tre kolonner.

Select Columns (Velg kolonner) Velger kolonnene som skal vises i regnearket.

Tabell 19. Elementer i høyreklikkmenyen for regneark, forts.
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Eksport
CFXManager Dx-programvaren har fire eksportalternativer i rullegardinmenyen Export (Eksport):

n Export All Data Sheets (Eksporter alle dataark) (til Excel)

n Custom Export (Tilpasset eksport)

n Export to LIMS (Eksporter til LIMS)

n Seegene Export (Seegene-eksport)

Eksportere alle dataark
Du kan eksportere alle regnearkvisningene fra hver fane i CFX Manager Dx-programvaren til
individuelle filer.

Slik eksporterer du alle dataark

u Velg Export > Export All Data Sheets to Excel (Eksport > Eksporter alle dataark til Excel), og velg
deretter ønsket filtype:

n CSV (*.csv)

n Tekst (*.txt)

n Excel 2007 (*.xlsx)

n Excel 2003 (*.xls)

n XML (*.xml)
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Opprette en tilpasset eksportfil
Slik oppretter du en tilpasset eksportfil

1. Velg Export > Custom Export (Eksport > Tilpasset eksport). Dialogboksen Custom Export
(Tilpasset eksport) vises.

2. Velg eksportformatet fra rullegardinmenyen som vises.

3. Merk avmerkingsboksene for elementene som skal eksporteres.

4. (Valgfritt) Klikk på Customize Column Names (Tilpass kolonnenavn) for å endre kolonnenavn.

5. Klikk på Export (Eksport). Dialogboksen Save As (Lagre som) vises.

6. I dialogboksen Save As (Lagre som) angir du et filnavn og et lagringssted for den eksporterte
filen.

7. Klikk på OK for å lagre eksportfilen.
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Eksportere til en LIMS-mappe
Du kan eksportere data til et LIMS-kompatibelt filformat.

Slik eksporterer du data i LIMS-format

1. Velg Export > Export to LIMS Folder (Eksport > Eksporter til LIMS-mappe).

Dialogboksen Save As (Lagre som) vises.

2. I dialogboksen Save As (Lagre som) angir du et filnavn og et lagringssted for den eksporterte
filen.

3. Klikk på OK for å lagre eksportfilen.

Eksportere Seegene-formaterte data
Du kan eksportere dataene fra alle regnearkvisninger til Excel-filer som er strukturert spesielt for bruk
med Seegene, Inc.

Slik eksporterer du data i et Seegene-spesifikt format

1. Velg Export > Seegene Export (Eksport > Seegene-eksport).

Dialogboksen Save As (Lagre som) vises.

2. I dialogboksen Save As (Lagre som) velger du en mappe der du vil lagre de eksporterte Seegene-
formaterte Excel-filene (.xlsx).

3. Klikk på OK for å lagre eksportfilene.
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Kapittel 10 Detaljer om dataanalyse
Data Analysis (Dataanalyse)-vinduet i CFX Manager™ Dx-programvaren består av flere faner som
man kan vise data fra. Dette kapitlet forklarer disse fanene i detalj.

Tips: Du kan velge hvilke faner som skal vises i Data Analysis (Dataanalyse)-vinduet ved bruk av
View (Vis)-menyen. Det tilpassede oppsettet lagres med datafilen.
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Fanen Quantification (Kvantifisering)
Bruk dataene i fanen Quantification (Kvantifisering) for å angi betingelsene for dataanalysen, inkludert
baselinjeinnstillinger for individuelle brønner og terskelinnstillinger. Fanen Quantification
(Kvantifisering viser data i disse fire visningene:

n Amplification chart (Amplifiseringsdiagram) – viser de relavtive fluorescensenhetene (RFU) for
hver brønn i hver syklus. Hver kurve i diagrammet representerer data fra en fluorofor i én brønn.

n Standard curve (Standardkurve) – vises bare hvis kjøringen inkluderer brønner designert som
prøvetypen standard (Std). Standardkurven viser terskelsyklusen plottet mot loggen over
startkvantiteten. Forklaringen viser reaksjonseffektiviteten (E) for hver fluorofor i brønnene med
prøver av typen standard.

n Well Selector (Brønnvelger) – velger brønnene med fluorescensdataene du vil vise.

n Regneark – viser et regneark med dataene samlet inn i de valgte brønnene.

Fluoroforalternativer
Velg målfluoroforet eller -fluoroforene under diagrammet Amplification (Amplifisering) for å vise
fluorofordata i diagrammene og regnearkene i fanen Quantification (Kvantifisering). Hvis du vil skjule
fluorofordataene i vinduet for dataanalyse, fjerner du merkingen i den tilhørende avmerkingsboksen.

184 | CFX96 Dx- og CFX96 DeepWell Dx-systemet



Fanen Quantification (Kvantifisering)

Dialogboksen Trace Styles (Kurvestiler)
Dialogboksen Trace Styles (Kurvestiler) kan brukes til å justere utseendet til kurvene i
amplifiseringsdiagrammet og smeltekurvediagrammet i fanene Quantification (Kvantifisering) og Melt
Curve (Smeltekurve). Deretter kan du forhåndsvise endringene i brønnvelgeren som vises i
dialogboksen Trace Styles (Kurvestiler).

Slik justerer du kurvestiler

1. Velg kun ett fluorofor under diagrammet Amplification (Amplifisering).

2. Velg ett av følgende alternativer for å åpne dialogboksen Trace Styles (Kurvestiler):

n Klikk på Trace Styles (Kurvestiler) i diagrammet Amplification (Amplifisering).

n Velg Settings > Trace Styles (Innstillinger > Kurvestiler) på menylinjen Data Analysis
(Dataanalyse).

n Høyreklikk på en kurve, og velg Trace Styles (Kurvestiler).

Dialogboksen Trace Styles (Kurvestiler) åpnes.

3. Velg et spesifikt sett med brønner i brønnvelgeren i nederste rute i dialogboksen Trace Styles
(Kurvestiler). Du kan også velge brønner som inneholder én prøvetype i rullegardinmenyen i
kolonnenWells (Brønner).
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4. Velg en av følgende fremgangsmåter:

n Klikk i boksen i kolonnen Color (Farge) for å velge en farge for de valgte brønnene.

n Velg et symbol fra rullegardinmenyen Symbol for å tilordne et Symbol til de valgte brønnene.

n For raskt å farge brønnene etter knappeetikett klikker du på det tilhørende hurtigsettet:

o Random byWell (Tilfeldig etter brønn)

o Random by Replicate (Tilfeldig etter replikat)

o Use Fluor Colors (Bruk fluoroforfarger)

o Use Target Colors (Bruk målfarger)

o Use Sample Colors (Bruk prøvefarger)

n Velg enten Sample Type (Prøvetype), Target Name (Målnavn), Sample Name (Prøvenavn)
eller Symbol for å tilordne brønnetiketter.

Alternativet Log Scale (Log-skala)
Velg Log Scale (Log-skala) under diagrammet Amplification (Amplifisering) for å se
fluorescenskurvene i en semilog-skala:

Tips: Du kan forstørre ethvert område av diagrammet ved å dra over målområdet. Du går tilbake
til full visning ved å høyreklikke på diagrammet og velge Set Scale to Default (Angi skala til
standard).
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Standard Curve Chart (Standardkurvediagram)
Hvis dataene inkluderer prøvetyper definert som Std (Standard) for minst en fluorofor i kjøringen,
oppretter programvaren diagrammet Standard Curve (Standardkurve) i fanen Quantification
(Kvantifisering).

Diagrammet Standard Curve (Standardkurve) viser følgende informasjon:

n Navn på hver kurve (fluoroforen eller målet).

n Fargen på hver fluorofor eller mål.

n Reaksjonseffektivitet (E). Bruk denne statistikken til å optimere en multipleks reaksjon og utjevne
dataene for en standardkurve.

Merknad: Reaksjonseffektiviteten beskriver hvor stor del av målet som produseres for hver
syklus i protokollen. En effektivitet på 100 % indikerer at du dobler målet for hver syklus.

n Bestemmelseskoeffisient, R2 (uttrykt som R^2). Bruk denne statistikken for å bestemme hvor
nøyaktig linjen beskriver dataene (hvor god tilpasningen er).

n Stigningstall

n y-skjæringspunkt
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Menyalternativer i Amplification Chart (Amplifiseringsdiagram)
I tillegg til de vanlige høyreklikk-menyalternativene for diagrammer (se Vanlige elementer i
høyreklikkmenyen for diagrammer på side 173) viser Tabell 20 menyalternativene som er tilgjengelige
for diagrammet Amplification Chart (Amplifiseringsdiagram).

Merknad: Standard Curve Chart (Standardkurvediagram) har bare de vanlige alternativene i
høyreklikkmenyen.

Menyalternativ Funksjon

Show Threshold Values
(Vis terskelverdier)

Viser terskelverdien for hver amplifiseringskurve i diagrammet.

Trace Styles (Kurvestiler) Åpner vinduet Trace Styles (Kurvestiler) for å endre stil på kurvene i
fanene Quantification (Kvantifisering) og Melt Curve (Smeltekurve).

Baseline Thresholds
(Baselinjeterskler)

Åpner vinduet Baseline Thresholds (Baselinjeterskler) for å endre
baselinjen eller tersklene for hvert fluorofor (endringene vises i
amplifiseringsdiagrammet i fanen Quantification (Kvantifisering)).

Tabell 20. Elementer i høyre- og venstreklikkmenyen for amplifiseringsdiagrammet

Regneark i fanen Quantification (Kvantifisering)
Tabell 21 definer dataene som vises i regnearket i fanen Quantification (Kvantifisering).

Informasjon Beskrivelse

Well (Brønn) Brønnposisjon i platen

Fluor (Fluorofor) Fluorofor detektert

Target (Mål) Target Name (Målnavn) som er lastet inn i Plate Editor (Plateredigering)-
brønnene

Content (Innhold) En kombinasjon av Sample Type (Prøvetype) (påkrevd) og Replicate #
(Replikatnr.) (valgfritt) som er lastet inn i Plate Editor (Plateredigering)

Sample (Prøve) Sample Name (Prøvenavn) som er lastet inn i Plate Editor
(Plateredigering)-brønnene

Cq Kvantifiseringssyklus for hver kurve

Tabell 21. Innhold i regneark med fanen Quantification (Kvantifisering)
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Fanen Quantification (Kvantifisering)

Endre data for mål, innhold eller prøve

Du kan endre dataene i kolonnene Target (Mål), Content (Innhold) og Sample (Prøve) ved å redigere
platefilen ved hjelp av Plate Editor (Plateredigering) selv etter at du har kjørt eksperimentet.

Slik endrer du dataene i kolonnene Content (Innhold), Target (Mål) og Sample (Prøve)

u Klikk på Plate Setup (Plateoppsett) og velg View/Edit Plate (Vis/rediger plate) for å åpne Plate
Editor (Plateredigering).
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Fanen Quantification Data (Kvantifiseringsdata)
Fanen Quantification Data (Kvantifiseringsdata) viser kvantifiseringsdataene som er samlet inn i hver
brønn. CFX Manager Dx-programvaren viser dataene i fire ulike regnearkvisninger:

n Results (Resultater) – viser et regneark med dataene. Dette er standardvisningen.

n Standard Curve Results (Resultater for standardkurve) – viser et regneark med
standardkurvedataene.

n Plate – viser dataene i hver brønn som et platekart.

n RFU – viser RFU-kvantitetene i hver brønn for hver syklus.

Velg hvert regneark fra rullegardinmenyen som vises under fanen Quantification Data
(Kvantifiseringsdata).

Regnearket Results (Resultater)
Regnearket Results (Resultater) viser data for hver brønn i platen.

Merknad: Alle beregninger av Std. Dev (Standardavvik) gjelder for replikatgruppene tilordnet i
brønnene i vinduet Plate Editor (Plateredigering). Beregningene finner gjennomsnittet av Cq-
verdien for hver brønn i replikatgruppen.

Tabell 22 definerer dataene som vises i regnearket Results (Resultater).
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Fanen Quantification Data (Kvantifiseringsdata)

Informasjon Beskrivelse

Well (Brønn) Brønnposisjon i platen

Fluor (Fluorofor) Fluorofor detektert

Target (Mål) Navn på amplifiseringsmål (gen)

Content (Innhold) Prøvetype og replikatnummer

Sample (Prøve) Prøvebeskrivelse

Biological Set Name (Navn på
biologisk sett)

Navnet på det biologiske settet

Cq Kvantifiseringssyklus

CqMean (Gjennomsnittlig Cq) Gjennomsnittet av kvantifiseringssyklusen for replikatgruppen

Cq Std. Dev (Standardavvik for
replikatgruppe)

Standardavviket til kvantifiseringssyklusen for replikatgruppen

Starting Quantity (SQ)
(Startkvantitet (SQ))

Estimert startkvantitet av målet

Log Starting Quantity (Logg
over startkvantitet)

Logg over startkvantiteten

SQMean (Gjennomsnittlig SQ) Gjennomsnittlig startkvantitet

SQ Std. Dev (Standardavvik for
startkvantitet)

Standardavviket til startkvantiteten over replikater

Tabell 22. Innhold i regnearket Results (Resultater)
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Regnearket Standard Curve Results (Resultater for
standardkurve)
Regnearket Standard Curve Results (Resultater for standardkurve) viser parametrene for beregnet
standardkurve.

Tabell 23 definerer dataene som vises i regnearket Standard Curve Results (Resultater for
standardkurve).

Informasjon Beskrivelse

Fluor (or Target) (Fluor (eller
mål))

Fluorofor (eller mål) påvist

Efficiency % (Effektivitet %) Reaksjonseffektivitet

Slope (Stigningstall) Stigning for standardkurven

Y-intercept (Y-skjæringspunkt) Punkt der kurven skjærer gjennom y-aksen

R^2 Bestemmelseskoeffisient

Tabell 23. Innhold i regnearket Standard Curve Results (Resultater for standardkurve)
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Fanen Quantification Data (Kvantifiseringsdata)

Regnearket Plate
Regnearket Plate viser et platekart med dataene for én fluorofor om gangen.

Slik viser du data for en bestemt fluorofor

u Klikk på tilhørende fane nederst i regnearket.

RFU-regnearket
RFU-regnearket viser avlesningene av de relative fluorescensenhetene (RFU) for hver brønn
innhentetet i hver syklus av kjøringen. Brønnummeret vises øvert i hver kolonne, og syklusnummeret
vises til venstre for hver rad.

Brukerhåndbok | 193



Kapittel 10 Detaljer om dataanalyse

Fanen Melt Curve (Smeltekurve)
Forbehold: Bio-Rad tildeler ingen rettigheter for bruk av smeltekurveanalyse i høyoppløselig
smelteanalyse i feltet for in vitro-diagnostikk på mennesker eller dyr. I tillegg er det kjøperens ansvar
å innhente eventuelle intellektuelle rettigheter som kan være nødvendig for dets spesifikke
bruksområder.

Når det gjelder DNA-bindende fargestoffer og ikke-spaltbare hybridiseringsprober, er fluorescensen
sterkest når de to DNA-trådene hybridiseres. Dette betyr at etter hvert som temperaturen øker opp
mot smeltetemperaturen (Tm), synker fluorescensen med en konstant hastighet (konstant helling).
Ved Tm er det en dramatisk reduskjon i fluorescensen, med en merkbar endring i hellingen.
Endringshastigheten bestemmes ved å plotte den negative første regresjonen av fluorescens kontra
temperatur (-d(RFU)/dT). Den største endringshastigheten i fluorescensen resulterer i synlige topper,
og den representerer Tm i dobbelttrådede DNA-komplekser.

CFX Manager Dx-programvaren plotter RFU-dataene samlet inn under en smeltekurve som en
funksjon av temperatur. For å analysere smeltetoppdataene tildeler programvaren en start- og
sluttemperatur til hver topp ved å flytte på terskelsøylen. Nedre grense for toppområdet angis av
posisjonen til terskellinjen for smelting. En gyldig topp må ha en minmumshøyde som er relativ til
distansen mellom terskelsøylen og høyden på den høyeste toppen.

Fanen Melt Curve (Smeltekurve) viser Tm (smeltetemperatur) for amplifiserte PCR-produkter i fire
visninger:

n Melt Curve (Smeltekurve) – viser sanntidsdata for hvert fluorofor som RFU-er per temperatur for
hver brønn.

n Melt Peak (Smeltetopp) – viser den negative regresjonen til RFU-dataene per temperatur for hver
brønn.

n Well selector (Brønnvelger) – viser brønner for å vise eller skjule dataene.

n Regnearket Peak (Topp) – viser dataene samlet inn i den valgte brønnen.

Merknad: Dette regnearket viser opptil to topper for hver kurve. Klikk på fanen Melt Curve
Data (Smeltekurvedata) for å vise flere topper.
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Fanen Melt Curve (Smeltekurve)

Tabell 24 på side 195 definerer dataene som vises i regnearket Melt Curve (Smeltekurve).

Informasjon Beskrivelse

Well (Brønn) Brønnposisjon i platen

Fluor (Fluorofor) Fluorofor detektert

Content (Innhold) En kombinasjon av prøvetype og replikatnummer

Sample (Prøve) Navn på prøve som er lastet inn i Plate Editor (Plateredigering)

Melt Temp (Smelte-
temperatur)

Temperaturen for smeltetoppen for hver brønn

Merknad: Kun de to høyeste toppene vises i dette regnearket.

Tabell 24. Innhold i regnearket Melt Curve (Smeltekurve)
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Justere smeltekurvedata
Slik justerer du smeltekurvedata

u Velg en av følgende fremgangsmåter:

n Klikk og dra terskelsøylene i diagrammet Melt Peak (Smeltetopp) for å inkludere eller
ekskludere topper i dataanalysen.

n Velg Positive (Positiv) i rullegardinmenyen Peaks (Topper) for å vise regnearkdataene for
toppene som er over terskellinjen for smelting, eller velg Negative (Negativ) for å vise
regnearkdataene for toppene som er under terskellinjen for smelting.

n Åpne vinduet Trace Styles (Kurvestiler) for å endre fargen på kurvene i diagrammene Melt
Curve (Smeltekurve) og Melt Peak (Smeltetopp).

n Velg et tall i velgeren for Step Number (Trinnummer) for å vise dataene for Melt Curve
(Smeltekurve) i et annet trinn i protokollen. Listen viser mer enn ett trinn hvis protokollen
inkluderer plateavlesninger i mer enn ett smeltekurvetrinn.

n Velg brønner i brønnvelgeren for å fokusere på delsett av dataene.

n Velg en brønngruppe for å vise og analysere et delsett av brønnene i platen. Velg hver
brønngruppe etter navn i rullegardinmenyenWell Group (Brønngruppe) på verktøylinjen.
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Fanen Melt Curve Data (Smeltekurvedata)

Fanen Melt Curve Data (Smeltekurvedata)
Fanen Melt Curve Data (Smeltekurvedata) viser dataene fra fanen Melt Curve (Smeltekurve) i flere
regneark som inkluderer alle smeltetoppene for hver kurve. har fire regnearkalternativer for visning av
smeltekurvedata:

n Melt Peaks (Smeltetopper) – viser alle data, inkludert alle smeltetopper, for hver kurve. Dette er
standardvisningen.

n Plate – viser en oversikt over dataene og innholdet i hver brønn i platen.

n RFU – viser RFU-verdiene ved hver temperatur for hver brønn.

n -d(RFU)/dT – viser den negative endringsraten i RFU etter hvert som temperaturen (T) endres.
Dette er et første regresjonsplott for hver brønn i platen.

Velg hvert regneark fra rullegardinmenyen som vises under fanen Melt Curve Data
(Smeltekurvedata).

Regnearket Melt Peaks (Smeltetopper)
Regnearket Melt Peaks (Smeltetopper) viser alle smeltekurvedata.

Tabell 25 på side 198 definerer dataene som vises i regnearket Melt Peaks (Smeltetopper).
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Informasjon Beskrivelse

Well (Brønn) Brønnposisjon i platen

Fluor (Fluorofor) Fluorofor detektert

Content (Innhold) Sample Type (Prøvetype) oppført i vinduet Plate Editor
(Plateredigering)

Target (Mål) Amplifiseringsmål (gen)

Sample (Prøve) Sample Name (Prøvenavn) oppført i vinduet Plate Editor
(Plateredigering)

Melt Temperature
(Smeltetemperatur)

Smeltetemperaturen til hvert produkt, oppført som en topp
(høyeste) per rad i regnearket

Peak Height (Topphøyde) Høyde på toppen

Begin Temperature
(Starttemperatur)

Temperatur på begynnelsen av toppen

End Temperature
(Sluttemperatur)

Temperatur på slutten av toppen

Tabell 25. Innhold i regnearket Melt Peaks (Smeltetopper)

Regnearket Plate
Regnearket Plate viser smeltekurvedata i et plateformat.

Merknad: For å justere toppen som programvaren kaller, justerer du terskellinjen i diagrammet
Melt Peak (Smeltetopp) i fanen Melt Curve (Smeltekurve).

Tabell 26 på side 199 definerer dataene som vises i regnearket Plate.
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Fanen Melt Curve Data (Smeltekurvedata)

Informasjon Beskrivelse

Content (Innhold) En kombinasjon av Sample Type (Prøvetype) (påkrevd) og Replicate #
(Replikatnr.) (valgfritt)

Sample (Prøve) Prøvebeskrivelse

Peak 1 (Topp 1) Første smeltetopp (høyeste)

Peak 2 (Topp 2) Andre (lavere) smeltetopp

Tabell 26. Innhold i regnearket Plate

RFU-regnearket
RFU-regnearket viser fluorescensen for hver brønn ved hver syklus hentet under smeltekurven.

Tabell 27 definerer dataene som vises i regnearket RFU.

Informasjon Beskrivelse

Brønnnummer (A1, A2, A3, A4, A5) Brønnposisjon i platen for brønnene som er
lastet inn

Temperature (Temperatur) Smeltetemperaturen til det amplifiserte målet,
plottet som én brønn per rad og flere brønner for
flere produkter i den samme brønnen

Tabell 27. Innhold i regnearket RFU
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Regnearket -d(RFU)/dT
Regnearket -d(RFU)/dT viser den negative endringshastigheten i RFU etter hvert som temperaturen
(T) endres.

Tabell 28 definerer dataene som vises i regnearket -d(RFU)/dT.

Informasjon Beskrivelse

Brønnnummer (A1, A2, A3, A4, A5) Brønnposisjon i platen for brønnene som er lastet inn

Temperature (Temperatur) -d(RFU)/dT Negativ endringshastighet i RFU etter hvert som
temperaturen (T) endres

Tabell 28. Innhold i regnearket -d(RFU)/dT
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Fanen End Point (Endepunkt)

Fanen End Point (Endepunkt)
Åpne fanen End Point (Endepunkt) for å analysere endelige relative fluorescence-enheter (RFU-er)
for prøvebrønnene. Programvaren sammenligner RFU-nivåene for brønner med ukjente prøver med
RFU-nivåene for brønner med negative kontroller og «kaller» den ukjente positiv eller negativ. Positive
prøver har en RFU-verdi som er høyere enn den gjennomsnittlige RFU-verdien til den negative
kontrollen pluss cutoff-verdien.

For å analysere endepunktdataene må platen inneholde negative kontroller, ellers kan ikke
programvaren foreta bestemmelsen. Kjør én av disse to protokollene:

n Kjør en Quantification (Kvantifisering)-protokoll – sett opp en standardprotokoll. Når kjøringen er
fullført, åpner du vinduet Data Analysis (Dataanalyse), justerer innstillingene for dataanalyse i
fanen Quantification (Kvantifisering) og klikker deretter på fanen End Point (Endepunkt) for å
velge en endepunktsyklus.

n Kjør en End Point Only (Kun endepunkt)-protokoll – last inn protokollen End Point Only (Kun
endepunkt) i fanen Plate i vinduet Run Setup (Kjøringsoppsett), velg eller opprett en plate og start
kjøringen.

Fanen End Point (Endepunkt) viser de gjennomsnittlige RFU-verdiene for å bestemme ommålet ble
amplifisert ved den siste (ende)syklusen. Bruk disse dataene til å bestemme om en bestemt
målsekvens er tilstede (positiv) i en prøve. Positive mål har høyere RFU-verdier enn cutoff-nivået du
definerer.
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Tips: Når du vil opprette en endepunktprotokoll må du åpne fanen Protocol (Protokoll) (vinduet
Run Setup (Kjøringsoppsett)) og velge Run > End Point Only Run (Kjør > Kjøring av kun
endepunkt).

Når kjøringen er fullført, åpnes datafilen i fanen End Point (Endepunkt), som består av følgende deler:

n Settings (Innstillinger) – justerer innstillinger for dataanalyse.

n Results (Resultater) – viser resultatene umiddelbart etter at du har justert innstillingene.

n Well Selector (Brønnvelger) – velger brønnene med endepunktdataene du vil vise.

n RFU-regneark – viser ende-RFU innsamlet i de valgte brønnene.

Resultatdata
Delen Results (Resultater) viser følgende data:

n Lowest RFU value (Laveste RFU-verdi) – laveste RFU-verdi i dataene

n Highest RFU value (Høyeste RFU-verdi) – høyeste RFU-verdi i dataene

n Negative Control Average (Gjennomsnitt av negative kontroller) – gjennomsnittlig RFU for
brønnene som inneholder negative kontroller

n Cut Off Value (Cutoff-verdi) – beregnes ved å legge til toleransen (RFU eller Percentage of Range
(Prosent av område) oppført i Settings (Innstillinger)) og gjennomsnittet av de negative
kontrollene. Prøver med RFU-er som er større enn cutoff-verdien, vil bli kalt “Positive”. For å
justere cutoff-verdien endrer du RFU eller Percentage of Range (Prosent av område).

Cutoff-verdien beregnes med denne formelen:

Cutoff-verdi = gjennomsnitt av negative kontroller + toleranse

Velg en toleranse ved hjelp av én av disse metodene:

n RFUs (RFU-er) (standard) – velg denne metoden hvis du vil bruke en absolutt RFU-verdi for
toleransen. Minimum RFU-toleranseverdi er 2. Maksimum er den absolutte verdien av den
høyeste RFU-verdien minus den absolutte verdien av den laveste RFU-verdien. Standard RFU-
toleranseverdi er 10 % av det totale RFU-området.

n Percent of Range (Prosent av område) – velg denne metoden hvis du vil bruke en prosent av
RFU-området for toleransen. Minimum prosent av området er 1 %. Maksimum prosent av
området er 99 %. Standard prosent av området er 10 %.
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Fanen End Point (Endepunkt)

Justere analysen av endepunktsdata
Slik justerer du dataene i fanen End Point (Endepunkt)

u Velg en av følgende fremgangsmåter:

n Velg en fluorofor fra rullegardinmenyen.

n Velg en verdi for End Cycle to Average (Endesykluser for gjennomsnitt) for å angi antall
sykluser som skal brukes til å beregne gjennomsnittlig endepunkt-RFU.

n Velg RFU-er for å vise data i relative fluorescerende enheter.

n Velg Percentage of Range (Prosentvist område) for å vise dataene som en prosentandel av
RFU-området.

n Velg brønner i brønnvelgeren for å fokusere på delsett av dataene.

n Velg en brønngruppe for å vise og analysere et delsett av brønnene i platen. Velg hver
brønngruppe etter navn i rullegardinmenyenWell Group (Brønngruppe) på verktøylinjen.

RFU-regneark for endepunktsanalyse
Tabell 29 definerer dataene som vises i RFU-regnearket i fanen End Point (Endepunkt).

Informasjon Beskrivelse

Well (Brønn) Brønnposisjon i platen

Fluor (Fluorofor) Fluorofor detektert

Content (Innhold) En kombinasjon av prøvetype og replikatnummer

End RFU (Ende-RFU) RFU ved endepunktssyklusen

Call (Bestemmelse) Positive (Positiv) eller Negative (Negativ), der positive prøver har en RFU-
verdi som er større enn gjennomsnittlig RFU for de negative kontrollene
pluss Cut Off Value (Cutoff-verdi)

Sample (Prøve) Sample Name (Prøvenavn) som er lastet inn i Plate Editor
(Plateredigering)

Tabell 29. Innhold i regnearket End Point (Endepunkt)
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Fanen Allelic Discrimination (Allelisk diskriminering)
Fanen Allelic Discrimination (Allelisk diskriminering) tilordner genotyper til brønner med ukjente
prøver. Bruk disse dataene til å identifisere prøver med ulike genotyper, inkludert Allele 1 (Allel 1),
Allele 2 (Allel 2), Heterozygote (Heterozygot), No Call (no amplification) (Ingen bestemmelse (ingen
amplifisering) eller Undetermined (Ubestemt).

Merknad: Datene for allelisk diskriminering må komme fra multiplekse kjøringer med minst to
fluoroforer. Hver fluorofor identifiserer ett allel i alle prøver.

Allelisk diskriminering krever følgende minimale brønninnhold:

n to fluoroforer i hver brønn

n NTC-prøver (ikke-templatkontroll) for optimert dataanalyse

CFX Manager Dx-programvaren har fire alternativer for visning av data om allelisk diskriminering:

n Diagram over allelisk diskriminering – viser dataene på en graf over RFU for allel 1 / allel 2. Hvert
av punktene på grafen representerer data fra begge fluoroforer i én brønn. Du kan veksle mellom
kartesiske koordinater og polarkoordinater ved å merke eller fjerne merkingen i
avmerkingsboksen Polar Coordinates (Polarkoordinater). Cartesian Coordinates (Kartesiske
koordinater) representerer RFU for allel 1 på x-aksen og RFU for allel 2 på y-aksen.
Polarkoordinater representerer vinkelen på x-aksen og avstanden mellom origo og RFU på y-
aksen (medianen til alle NTC-er).

n Brønnregneark – viser data for allelisk diskriminering, som er samlet inn i hver av brønnene på
platen.
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Fanen Allelic Discrimination (Allelisk diskriminering)

n Brønnvelger – velger brønnene som har de alleliske dataene du vil vise.

n Panelet Selected Fluorophores (Valgte fluoroforer) – endrer etikettene på x- og y-aksene i
diagrammet for allelisk diskriminering, syklusen som skal analyseres og hvorvidt
bestemmelseskartet skal vises.

Justere data for allelisk diskriminering
Programvaren tilordner automatisk en genotype til brønner med ukjente prøver basert på posisjonene
til NTC-ene samt vinkelen og avstanden til de ukjente datapunktene fra NTC-ene.

Slik justerer du data for allelisk diskriminering

u Velg en av følgende fremgangsmåter:

n Hvis du vil vise polarkoordinater, merker du avmerkingsboksen i diagrammet Allelic
Discrimination (Allelisk diskriminering).

n Hvis du vil vise en annen fluorofor, velger du den fra rullegardinmenyen i panelet Selected
Fluorophores (Valgte fluoroforer).

n Hvis du vil endre en bestemmelse, drar du markøren over ett eller flere datapunkter i
diagrammet Allelic Discrimination (Allelisk diskriminering) og velger et alternativ i listen
Selected Wells (Valgte brønner):

o Allele 1 (Allel 1)

o Allele 2 (Allel 2)

o Heterozygote (Heterozygot)

o Undetermined (Ubestemt)

o No Call (Ingen bestemmelse)

o Auto Call (Automatisk bestemmelse)

Tips: Velg Auto Call (Automatisk bestemmelse) for å gå tilbake til standard
bestemmelse.
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Menyalternativer for diagrammer
I tillegg til de vanlige alternativene i høyreklikkmenyen for diagrammer (se Vanlige elementer i
høyreklikkmenyen for diagrammer på side 173), viser Tabell 30 menyalternativene som er tilgjengelige
for diagrammet Allelic Discrimination (Allelisk diskriminering).

Menyalternativ Funksjon

Zoom Fokuserer diagramvisningen på det valgte området (ved å klikke og
dra markøren i diagrammet).

Tips: Hvis du vil gjenopprette zoomingen for å vise alle
datapunkter, høyreklikker du og velger Set Scale to Default
(Angi skala til standard).

Well (Brønn) Alternativene for den valgte brønnen er: vis kun denne brønnen,
fjern denne brønnen fra visningen, angi farge for denne kurven og
utelukk denne brønnen fra analysen.

Selected Wells (Valgte brønner) Alternativene for de valgte brønnene (som velges ved å klikke og
dra markøren i diagrammet) er: vis kun disse brønnene, fjern disse
brønnene fra visningen, angi farge for disse kurvene og utelukk
disse brønnene fra analysen.

Tabell 30. Alternativer i høyre- og venstreklikkmenyen for diagrammet Allelic Discrimination
(Allelisk diskriminering)

Regnearket Allelic Discrimination (Allelisk diskriminering)
Tabell 31 definerer dataene som vises i regnearket Allelic Discrimination (Allelisk diskriminering).

Informasjon Beskrivelse

Well (Brønn) Brønnposisjon i platen

Sample (Prøve) Navn på prøven

Call (Bestemmelse) Identiteten til allelen, inkludert automatisk Allele 1 (Allel 1), Allele 2
(Allel 2), Heterozygote (Heterozygot), No Call (Ingen bestemmelse)
eller Undetermined (Ubestemt)

Tabell 31. Innhold i regnearket for allelisk diskriminering
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Fanen Allelic Discrimination (Allelisk diskriminering)

Informasjon Beskrivelse

Type Auto (Automatisk) eller Manual (Manuell) beskriver hvordan
bestemmelsen ble gjort. Automatisk betyr at programvaren valgte
bestemmelsen. Manuell betyr at brukeren valgte bestemmelsen.

RFU1 Relative fluorescensenheter for Allele1 (Allel 1)

RFU2 Relative fluorescensenheter for Allelle2 (Allel 2)

Tabell 31. Innhold i regnearket for allelisk diskriminering, forts.
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Fanen Custom Data View (Tilpasset datavisning)
I fanen Custom Data View (Tilpasset datavisning) vises flere ruter i tilpassbart format samtidig.

Rullegardinmenyen Load a Preset View (Last inn en forhåndsinnstilt visning) inneholder et utvalg av
maler for visningsformater. Standardvisningen avhenger av hvilken fil som analyseres. For eksempel,
hvis det finnes data for Melt Curve (Smeltekurve), vises standardvisningen Amp+Melt.
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Fanen Custom Data View (Tilpasset datavisning)

Opprette en tilpasset datavisning
Slik oppretter du en tilpasset datavisning

u Velg en av følgende fremgangsmåter:

n Velg en forhåndsinnstilt visning fra rullegardinmenyen.

n Velg en annen diagramvisning fra rullegardinmenyen, som du finner øverst i hver rute.

n Endre antall rader og kolonner i fanen.

n Endre størrelse på hver enkelt rute. Trekk i kantene ytterst på hver av rutene.

Klikk på Save as Preset (Lagre som forhåndsinnstilling) for å lagre tilpasningen som en
forhåndsinnstilt mal. Klikk på Manage Presets (Administrer forhåndsinnstillinger) for å slette, endre
navn på eller gjennopprette eksisterende forhåndsinnstilte visinger.
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Fanen QC (Kvalitetskontroll)
Bruk fanen QC (Kvalitetskontroll) til raskt å vurdere kvaliteten på de kjørte dataene basert på reglene i
QC.

CFX Manager Dx-programvaren har fire alternativer for visning av QC-data (Kvalitetskontroll):

n Amplification chart (Amplifiseringsdiagram) – viser RFU for hver brønn ved hver syklus. Hver
kurve i diagrammet representerer data fra en fluorofor i én brønn.

n QC rules table (Regeltabel for kvalitetskontroll) – viser de tilgjengelige kvalitetskontrollreglene
og innstillingene som definerer hver regel. Anvendte kvalitetskontrollregler angis med en hake.

n Well selector (Brønnvelger) – velger brønnene med fluorescensdataene du vil vise.

n Sammendragsrute for kvalitetskontrollregel – viser den valgte kvalitetskontrollregelen og
uthever brønner som ikke oppfyller regelen.

Endre kvalitetskontrollkriterier
Slik endrer du kvalitetskontrollkriterier

u Merk eller fjern merket i avmerkingsboksen Use (Bruk) for å inkludere eller utelukke regelen fra
kvalitetskontrollen.
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Fanen QC (Kvalitetskontroll)

Utelukke brønner som ikke består kvalitetskontroll
CFXManager Dx-programvaren viser brønner som ikke består kvalitetskontrollkriterier i kolonnen
Results (Resultater) i tabellen med kvalitetskontrollregler og i sammendragsruten.

Slik utelukker du brønner som ikke består kvalitetskontrollkriterier

u Velg Exclude Wells (Utelukk brønner) for hver brønn som skal utelukkes.
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Fanen Run Information (Kjøringsinformasjon)
Fanen Run Information (Kjøringsinformasjon) viser protokollen og annen informasjon om hver kjøring.
Bruk denne fanen til å gjøre følgende:

n Vise protokollen.

n Legge inn eller redigere merknader om kjøringen.

n Legge inn eller redigere ID-en eller strekkoden for kjøringen.

n Vise hendelser som kan ha oppstått under kjøringen. Bruk disse meldingene som en hjelp til
feilsøkingen av en kjøring.

Tips: Høyreklikk i protokollen for å kopiere, eksportere eller skrive den ut. Høyreklikk i rutene
Notes (Merknader), ID/Bar Code (ID/strekkode) eller Other (Annet) for å klippe ut, kopiere, lime
inn, slette eller velge teksten.
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Dataanalyserapporter

Dataanalyserapporter
Dialogboksen for rapporter viser informasjon om gjeldende datafil i vinduet Data Analysis
(Dataanalyse). Velg Tools > Reports (Verktøy > Rapporter).

Dialogboksen for rapporter består av følgende deler:

n Meny og verktøylinje – inneholder alternativer for å formatere, lagre og skrive ut rapporten eller
malen.

n Alternativliste (øverst til venstre i dialogboksen) – inneholder alternativer som kan vises i
rapporten.

n Alternativrute (nederst til venstre i dialogboksen) – viser tekstbokser hvor du kan legge inn
informasjon om et valgt alternativ.

n Forhåndsvisningsrute (høyre side av dialogboksen) – viser en forhåndsvisning av den gjeldende
rapporten.
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Kategorier for dataanalyserapporter
Tabell 32 viser alle alternativene som er tilgjengelige for en dataanalyserapport, avhengig av typen
data i vinduet Data Analysis (Dataanalyse).

Kategori Alternativ Beskrivelse

Overskrift

Tittel, undertittel og logo for rapporten

Report Information
(Rapportinformasjon)

Kjøringsdato, brukernavn, datafilnavn,
datafilbane og valgt brønngruppe

Audit Information
(Revisjonsinformasjon)

Tilleggsinformasjon som kreves for
revisjon, inkludert signaturer

Notes (Merknader) Merknader om datarapporten

Run Setup (Kjøringsoppsett)

Run Information
(Kjøringsinformasjon)

Kjøringsdato, brukernavn, datafilnavn,
datafilbane og valgt brønngruppe

Protocol (Protokoll) Tekstvisning av protokolltrinn og -
alternativer

Plate Display (Platevisning) Platevisning av informasjonen for hver
brønn i platen

Quantification (Kvantifisering)

Analysis Settings
(Analyseinnstillinger)

Nummer på datainnsamlingstrinn,
analysemodus og metode for
baselinjesubtraksjon

Amplification Chart
(Amplifiseringsdiagram)

Amplifiseringsdiagram for kjøringer som
inkluderer kvantifiseringsdata

Standard Curve Chart
(Standardkurvediagram)

Standardkurvediagram

Data Regneark som inneholder dataene for
hver brønn

Tabell 32. Kategorier for dataanalyserapporter i listen over alternativer

214 | CFX96 Dx- og CFX96 DeepWell Dx-systemet



Dataanalyserapporter

Kategori Alternativ Beskrivelse

Gene Expression (Genuttrykk) – Bar Chart (Søylediagram)

Analysis Settings
(Analyseinnstillinger)

Analysemodus, diagramdata,
skaleringsalternativ og diagramfeil

Chart (Diagram) Kopi av søylediagrammet

Target Names (Målnavn) Diagrammed målnavn

Sample Names (Prøvenavn) Diagrammed prøvenavn

Data Regneark som inneholder dataene for
hver brønn

Target Stability
(Målstabilitet)

Diagrammed målstabilitetsverdier

Gene Expression (Genuttrykk) – Clustergram (Klyngediagram) og Scatter Plot
(Spredningsplott)

Analysis Settings
(Analyseinnstillinger)

Innstillinger for hver diagramtype

Chart (Diagram) Kopi av diagrammet

Data Regneark som lister opp dataene i hvert
mål

Melt Curve (Smeltekurve)

Analysis Settings
(Analyseinnstillinger)

Smeltetrinnummer og innstilling for
terskellinje

Melt Curve Chart
(Smeltekurvediagram)

Smeltekurvediagram

Melt Peak Chart
(Smeltetoppdiagram)

Smeltetoppdiagram

Data Regneark som inneholder dataene for
hver brønn

Allelic Discrimination (Allelisk diskriminering)

Tabell 32. Kategorier for dataanalyserapporter i listen over alternativer, forts.
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Kategori Alternativ Beskrivelse

Analysis Settings
(Analyseinnstillinger)

Viser fluoroforer, syklus og
bestemmelsesskart

Allelic Discrimination Chart
(Allelisk
diskrimineringsdiagram)

Kopi av det alleliske
diskrimineringsdiagrammet

Data Regneark som inneholder dataene for
hver brønn

End Point (Endepunkt)

Analysis Settings
(Analyseinnstillinger)

Fluorofor, sluttsykluser til gjennomsnitt,
modus, laveste RFU-verdi, høyeste RFU-
verdi og cutoff-verdi

Data Regneark som inneholder dataene for
hver brønn

QC Parameters (Kvalitetskontrollparametere)

Data Regneark som inneholder parametrene
for hver kvalitetskontrollregel

Tabell 32. Kategorier for dataanalyserapporter i listen over alternativer, forts.
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Dataanalyserapporter

Opprette en dataanalyserapport
Du kan lagre rapportoppsettet som en mal, som du kan bruke om igjen for lignende rapporter.

Slik oppretter du en dataanalyserapport

1. Gjør de siste justeringene i brønninnhold, valgte brønner, diagrammer og regneark i vinduet Data
Analysis (Dataanalyse) før du oppretter rapporten.

2. Velg Tools > Reports (Verktøy > Rapporter) i menylinjen i Data Analysis (Dataanalyse) for å åpne
dialogboksen Report (Rapport).

3. Velg alternativene du vil inkludere i rapporten. Rapporten åpnes med standardalternativene valgt.
Merk av eller fjern merket i avmerkingsboksene for å endre hele kategorier eller individuelle
alternativer i en kategori.

Merknad: Dataene som vises i rapporten, avhenger av de aktuelle utvalgene i fanene i
vinduet Data Analysis (Dataanalyse). En kvantifiseringskjøring kan for eksempel ikke
inneholde en standardkurve, og disse dataene vil derfor ikke vises i vinduet Data Analysis
(Dataanalyse) eller i datarapporten.

4. Endre rekkefølgen på kategoriene og elementene i en rapport. Dra alternativene til den relative
posisjonen. Rekkefølgen på elementene kan bare endres innenfor kategoriene de tilhører.

5. (Valgfritt) I ruten Report Options (Rapportalternativer) legger du inn informasjon som er relevant
for det valgte alternativet:

n Velg et delsett med informasjon som skal vises i rapporten.

n Velg spesifikke innstillinger for det valgte alternativet.

n Endre teksten som skal vises for det valgte alternativet.

6. Klikk på Update Report (Oppdater rapport) for å oppdatere Report Preview (Forhåndsvisning av
rapport) med eventuelle endringer.

7. Skriv ut eller lagre rapporten. Klikk på knappen Print Report (Skriv ut rapport) på verktøylinjen for
å skrive ut den aktuelle rapporten. Velg File > Save (Fil > Lagre) for å lagre rapporten i PDF-
format (Adobe Acrobat Reader-fil), og velg et lagringssted for filen. Velg File > Save As (Fil >
Lagre som) for å lagre rapporten med et nytt navn eller på et nytt sted.

8. (Valgfritt) Opprett en rapportmal med informasjonen du ønsker. Hvis du vil lagre de gjeldende
rapportinnstillingene i en mal, velger du Template > Save (Mal > Lagre) eller Save As (Lagre
som). Deretter laster du inn rapportmalen neste gang du vil lage en ny rapport.
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Opprette Well Group Reports (Brønngrupperapporter)
Slik oppretter du en brønngrupperapport

1. Velg Tools > Well Group Reports (Brønngrupperapporter) i vinduet Data Analysis (Dataanalyse).

2. I dialogboksenWell Group Reports (Brønngrupperapporter) velger du brønngruppene,
amplifiseringstrinnene og smeltetrinnene som skal inkluderes i rapporten.

3. Angi banen eller naviger til målmappen der rapporten skal lagres.

4. (Valgfritt) Velg Choose a Report Template (Velg en rapportmal) og naviger til mappen med
malfilen.

5. (Valgfritt) Velg Open Destination Folder (Åpne målmappe) for å åpne mappen og vise rapportene
når de har blitt generert.

6. Klikk på Create Reports (Opprett Rapporter).
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Kapittel 11 Analyse av genuttrykk
Når du bruker strengt kvalifiserte kontroller i reaksjonene, kan du brukeCFX Manager™ Dx-
programvaren til å utføre en genuttrykkskjøring til å normalisere de relative differansene i en
målkonsentrasjon blant prøver. Uttrykksnivåer for ett eller flere referansegener brukes vanligvis til å
normalisere uttrykksnivåene i et interessegen. Referansegener tar hensyn til innlastingsforskjeller
eller andre variasjoner som finnes i hver prøve, og uttrykksnivåene skal ikke bli påvirket i det
biologiske systemet som undersøkes.

Velg fanen Gene Expression (Genuttrykk) i vinduet Data Analysis (Dataanalyse) for å evaluere
relative differanser mellom PCR-reaksjoner i to eller flere brønner. Du kan for eksempel evaluere
relative antall av virale genomer eller relative antall av transfekterte sekvenser i en PCR-reaksjon. Det
vanligste bruksområdet for studier av genuttrykk er sammenligning av cDNA-konsentrasjon i mer enn
én reaksjon for å estimere nivået av messenger-RNA («budbringer-RNA») i likevektstilstand.

Programvaren beregner det relative uttrykksnivået til et mål med ett av disse scenarioene:

n Relativt uttrykksnivå for en målsekvens (mål 1) i forhold til et annet mål (mål 2), som for eksempel
mengden av ett gen i forhold til et annet gen under samme prøvebehandling.

n Relativt uttrykksnivå for én målsekvens i én prøve sammenlignet med det sammemålet under
annen prøvebehandling, som for eksempel den relative mengden av ett gen i forhold til seg selv
under andre temporale, geografiske eller utviklingsmessige forhold.

Plateoppsett for analyse av genuttrykk
For utføring av analyse av genuttrykk må innholdet i brønnene inneholde følgende:

n To eller flere mål – de to målene som representerer forskjellige amplifiserte gener eller sekvenser
i prøvene.

n Ett eller flere referansemål – minst ett mål må være et referansemål for normalisert uttrykk.
Tilordne alle referansemål i vinduet Experiment Settings (Eksperimentinnstillinger) til å analysere
dataene i modusen Normalized Expression (Normalisert uttrykk) (ΔΔCq). Kjøringer som ikke
inneholder en referanse, må analyseres ved bruk av modusen Relative Expression (Relativt
uttrykk) (ΔCq).

n Felles prøver – reaksjonene må inkludere felles prøver (minst to er obligatorisk) for å vise dataene
plottet i fanen Gene Expression (Genuttrykk). Disse prøvene skal representere ulike behandlinger
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eller betingelser for hver av målsekvensene. Tilordne en kontrollprøve (valgfritt) i vinduet
Experiment Settings (Eksperimentinnstillinger). Hvis du ikke velger en kontroll, bruker
programvaren den laveste Cq som kontrollen.

Kravene for oppsett av Gene Expression (Genuttrykk) i Plate Editor (Plateredigering) avhenger av om
reaksjonsinnholdet er enkeltpleks PCR, med ett fluorofor i reaksjonene, eller multipleks PCR, med
mer enn ett fluorofor i reaksjonene.

Veiledet plateoppsett
Hvis plateoppsettet av en datafil ikke inneholder informasjonen som trengs for analyse, og fanen Gene
Expression (Genuttrykk) velges, vil plassen som vanligvis inneholder søylediagrammet, vise
instruksjoner for å legge inn denne informasjonen. Utfør følgende trinn for normalisert genuttrykk:

1. Definer navn på Target (Mål) og Sample (Prøve) ved å bruke ett av følgende:

n Plate Setup (Plateoppsett) – åpner vinduet Plate Editor (Plateredigering).

n Replace Plate File (Erstatt platefil) – åpner dialogboksen for valg av plate, der du kan
navigere til en tidligere lagret platefil som du vil skal erstatte det gjeldende plateoppsettet.

n Replace PrimePCR File (Erstatt PrimePCR-fil) – åpner dialogboksen for valg av PrimePCR-
fil, hvor du kan navigere til en PrimePCR™-kjøringsfil og bruke den i plateoppsettet.

2. Velg ett eller flere referansemål og en kontrollprøve via dialogboksen Experiment Settings
(Eksperimentinnstillinger).

Hvis plateoppsettet allerede inneholder informasjon ommål og prøve, behøver du kun utføre det
andre trinnet, og dette er merket i oransje. Dette trinnet må utføres før analyse av normalisert
genuttrykk kan forekomme.

Merknad: Data for klyngediagram og spredningsplott vises kun dersom alle kravene for
normalisert genuttrykk er oppfylt. Disse kravene står oppført under Plate Setup
(Plateoppsett) for Gene Expression Analysis (Genuttrykksanalyse).
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Diagrammer for genuttrykk

Diagrammer for genuttrykk
CFXManager Dx-programvaren viser genuttrykksdata i flere visninger. Tabell 33 viser tilgjengelige
diagramalternativer i programvaren.

Knapp Navn Funksjon

Bar Chart (Søylediagram) Viser data for normalisert genuttrykk i
søylediagramformat.

Clustergram (Klyngediagram) Viser dataene for normalisert uttrykk i et
hierarki basert på graden av likhet i uttrykket
for ulike mål og prøver.

Scatter Plot (Spredningsplott) Viser det normaliserte måluttrykket for en
kontroll sammenlignet med en
eksperimentell prøve.

Results (Resultater) Oppsummerer dataene fra alle
diagrammene.

Tabell 33. Alternativer for diagrammer for genuttrykk
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Bar Chart (Søylediagram)

Det relative måluttrykket presenteres i disse to visningene:

n Genuttrykksdiagram – viser PCR-data i sanntid som ett av følgende:

o ΔΔCq – relativt normalisert uttrykk beregnet ved bruk av kontrollprøver og referansemål.

o ΔCq – relativ mengde av målgenet i en prøve sammenlignet med en kontrollprøve.

n Spreadsheet (Regneark) – viser et regneark med genuttrykksdataene.

Tips: Høyreklikk på et diagram eller regneark for alternativer. Velg View/Edit Plate
(Vis/rediger plate) fra rullegardinmenyen Plate Setup (Plateoppsett) for å åpne Plate Editor
(Plateredigering) og endre brønninnholdet i platen.

Tips: Velg Sort (Sorter) fra høyreklikkmenyen for å endre rekkefølgen for Target (Mål)- og
Sample (Prøve)-navn i diagrammet.
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Bar Chart (Søylediagram)

Normalisert genuttrykk

Data normaliseres ved å bruke det målte uttrykksnivået til én eller flere referansegener som
normaliseringsfaktor. Referansegener er mål som ikke er regulert i det biologiske systemet som
undersøkes, som f.eks. aktin,GAPDH eller tubulin.

Slik setter du opp analyse med normalisert genuttrykk (ΔΔCq)

1. Åpne en datafil (av filtypen .pcrd).

2. Se gjennom dataene i fanen Quantification (Kvantifisering) i vinduet Data Analysis (Dataanalyse).
Juster dataene, som f.eks. endre terskel og analysemodus.

3. Lukk fanen Gene Expression (Genuttrykk).

4. Klikk på Experiment Settings (Eksperimentinnstillinger) i fanen Gene Expression (Genuttrykk).

5. I dialogboksen Experiment Settings (Eksperimentinnstillinger) gjør du følgende:

a. Lukk fanen Samples (Prøver), og velg en kontroll. Når en kontroll tilordnes, normaliserer CFX
Manager Dx-programvaren den relative kvantiteten for alle gener til kontrollkvantiteten, som er
satt til 1.

b. Lukk fanen Target (Mål), og velg referansegener. Analyse av genuttrykk krever én referanse
blant målene i prøvene.

6. Velg Normalized Expression (Normalisert uttrykk) (ΔΔCq) hvis det ikke allerede er valgt, og vis
deretter uttrykksnivåene i fanen Gene Expression (Genuttrykk).

Relativ kvantitet

Relative kvantitetsdata (ΔCq) blir per definisjon ikke normalisert. Denne metoden brukes til å
kvantitere prøver som ikke inkluderer noen referansegener (mål). Vanligvis er forskere sikre på én av
følgende vurderinger når de setter opp kjøringen:

n Hver prøve inneholder sammemengde RNA eller cDNA i hver brønn.

n Enhver varians i mengden biologisk prøve som lastes inn, vil bli normalisert etter kjøringen med en
metode i dataanalysen utenfor programvaren. En forsker kan for eksempel velge å dividere den
relative kvantitetsverdien med normaliseringsfaktoren, muligens massen av nukleinsyre lastet inn
for hver prøve, eller antallet celler som nukleinsyren ble isolert fra.

Slik kjører du en relativ kvantitetsanalyse (ΔCq)

u I fanen Gene Expression (Genuttrykk) velger du Relative Quantity (Relativ kvantitet) (ΔCq) fra
rullegardinmenyen Mode (Modus) i høyre rute.

Tips: Hvis du vil sammenligne resultater med data fra andre genuttrykkskjøringer, åpner du
en ny genstudie eller legger til en datafil i en eksisterende genstudie.
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Sortere måldata og prøvedata
Merknad: Dette alternativet er kun tilgjengelig for genuttrykksdiagrammer.

Som standard vises listene Targets (Mål) og Samples (Prøver) i alfabetisk rekkefølge. Bruk
dialogboksen Sort (Sorter) for å sortere visningen i omvendt alfabetisk rekkefølge eller for manuelt å
flytte et begrep til en annen plassering på listen.

Slik sorterer du data for mål og prøver

1. Klikk på Sort (Sorter) i diagrammets høyreklikkmeny.

Dialogboksen Gene Expression Chart Sorting (Sortering i genuttrykksdiagram).

2. Klikk på Z-A i dialogboksen for å sortere listen i omvendt alfabetisk rekkefølge.

3. Hvis du vil flytte et begrep manuelt, velger du begrepet og klikker på den relevante knappen
mellom diagrammene:

n Klikk på pil opp eller pil ned for å flytte det valgte begrepet én posisjon.

n Klikk på pil opp- eller pil ned-rullefeltet for å flytte det valgte begrepet til øverste eller nederste
posisjon på listen.

4. Klikk på OK for å lagre endringene og gå tilbake til fanen Gene Expression (Genuttrykk).

Justere genuttrykksdata
Når du har valgt analysemodus, normalisert uttrykk (∆∆Cq) eller relativ kvantitet (∆Cq), justerer du
dataene som vises i fanen Gene Expression (Genuttrykk) ved å endre innstillingsalternativene til
høyre for diagrammet .

Tips: Du angir standard dataalternativer for Gene Expression (Genuttrykk) i dialogboksen User
Preferences (Brukerpreferanser) (se Angi standardparametere for datafil for genuttrykk på side 69).
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Diagramdata

Angi verdien for Y-aksen til Linear (Lineær) skala for å aktivere alternativer for diagramdata.
Alternativer for diagramdata gir deg mulighet til å presentere dataene i diagrammet ved bruk av ett av
disse alternativene:

n Relative to control (Relativ til kontroll) – fremstill dataene grafisk med aksen skalert fra 0 til 1. Hvis
du tilordner en kontroll i kjøringen, velger du dette alternativet for raskt å visualisere opp- og
nedregulering av målet.

n Relative to zero (Relativ til null) – fremstill dataene grafisk med origo på null.

Kontrollprøve

Bruk rullegardinmenyen Control Sample (Kontrollprøve) til å velge en prøve som skal brukes til å
normalisere Relative Quantity (Relativ kvantitet):

Diagraminnstillinger

Følgende alternativer (beskrevet under) vises når du velger avmerkingsboksen Show Chart Settings
(Vis diagraminnstillinger): X-Axis (X-akse), Y-Axis (Y-akse), Scaling (Skalering), Error Type (Feiltype)
og Chart Error Multiplier (Diagramfeilmultiplikator).

Alternativer for x-akse

Med X-Axis Option (Alternativ for x-akse) kan du velge x-aksedata for diagrammet Gene Expression
(Genuttrykk):

n Target (Mål) – plotter målnavnene på x-aksen.

n Sample (Prøve) – plotter prøvenavnene på x-aksen.

Alternativer for y-akse

Med alternativet for y-akse kan du vise diagrammet Gene Expression (Genuttrykk) i én av disse tre
skalaene:

n Linear (Lineær) – velg dette alternativet for å vise en lineær skala.

Tips: Hvis du setter y-aksen til Linear (Lineær), aktiveres rullegardinmenyen Graph Data
(Grafdata), der du kan velge å vise data i forhold til kontroll eller i forhold til null.

n Log 2 – velg dette alternativet for å evaluere prøver over et stort dynamisk område.

n Log 10 – velg dette alternativet for å evaluere prøver over et svært stort dynamisk område.
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Alternativer for skalering

Velg Normalized Gene Expression (Normalisert genuttrykk) (ΔΔCq) og still Control Sample
(Kontrollprøve) til None (Ingen) for å aktivere alternativene for skalering i diagrammet Gene
Expression (Genuttrykk). Velg ett av disse skaleringsalternativene for å beregne og presentere
dataene på en måte som best passer til kjøringens design:

n Unscaled (Ikke skalert) – viser det ikke-skalerte normaliserte genuttrykket.

n Highest (Høyest) – skalerer det normaliserte genuttrykket for hvert mål ved å dele uttrykksnivået
til hver prøve på det høyeste uttrykksnivået i alle prøvene.

Dette skaleringsalternativet bruker skalert-til-høyest-formelen.

n Lowest (Lavest) – skalerer det normaliserte genuttrykket for hvert mål ved å dele uttrykksnivået til
hver prøve på det laveste uttrykksnivået i alle prøvene.

Dette skaleringsalternativet bruker skalert-til-lavest-formelen.

n Average (Gjennomsnitt) – skalerer det normaliserte genuttrykket for hvert mål ved å dele
uttrykksnivået til hver prøve på den geometriske middelverdien til uttrykksnivåene for alle
prøvene.

Dette skaleringsalternativet bruker skalert-til-gjennomsnitt-formelen.

Error Type (Feiltype)

Velg et alternativ for typen feilberegninger (feilsøyler) i Gene Expression (Genuttrykk)-diagrammet:

n Standard error of the mean (Standardfeil av gjennomsnitt) (standard)

n Standard deviation (Standardavvik)

Multiplikator for feilsøyler i diagram

Velg en multiplikator for feilsøylene i diagrammet Gene Expression (Genuttrykk). Velg ett av disse
heltallene:
+/- 1 (standard), 2 eller 3. Typen multiplikator endres når du velger feiltype:

n SEMs for standard error of the mean (SEMs for standardfeil for gjennomsnittet)

n Std Devs for standard deviations (Std Devs for standardavvik)
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Experiment Settings (Eksperimentinnstillinger)
Tips: Denne dialogboksen er også tilgjengelig i Plate Editor (Plateredigering). Hvis du vil ha mer
informasjon, se Endre eksperimentinnstillinger på side 126.

I dialogboksen Experiment Settings (Eksperimentinnstillinger) kan du vise eller endre listen med mål
eller prøver, velge referansegener, velge kontroller eller angi genuttrykksanalyse-gruppen som skal
analyseres hvis du har lagt til biologiske settnavn for brønnene.

Slik åpner du dialogboksen Experiment Settings (Eksperimentinnstillinger)

u I fanen Bar Chart (Søylediagram) klikker du på Experiment Settings (Eksperimentinnstillinger)
nederst i høyre rute.

Dialogboksen Experiment Settings (Eksperimentinnstillinger) åpnes i fanen Targets (Mål).

Slik justerer du innstillingene for Targets (Mål)

u Velg en av følgende fremgangsmåter i fanen Targets (Mål):

n Hvis du vil velge et mål som en referanse for genuttrykksdataanalyse, velger du navnet i
kolonnen Reference (Referanse).

n Hvis du vil endre målets farge, klikker du på tilhørende celle i kolonnen Color (Farge) og
endrer fargen i dialogboksen Color (Farge) som vises.

Fargeendringen vises i diagrammene Gene Expression (Genuttrykk).
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n Hvis du vil bruke en tidligere bestemt effektivitetsverdi, fjerner du merket i målets
avmerkingsboks i kolonnen Auto Efficiency (Automatisk effektivitet) og legger inn et tall for
effektivitetsprosenten til et mål.

Programvaren beregner den relative effektiviteten for et mål ved hjelp av Auto Efficiency
(Automatisk effektivitet) hvis dataene for et mål inkluderer en standardkurve.

Slik endrer du innstillingene for Sample (Prøve)

u Velg en av følgende fremgangsmåter i fanen Samples (Prøver):

n Hvis du vil velge en prøve som kontroll for genuttrykksdataanalyse, velger du navnet i
kolonnen Control (Kontroll).

n Hvis du vil endre farge på prøvengruppen, klikker du på tilhørende celle i kolonnen Color
(Farge) og endrer fargen i dialogboksen Color (Farge) som vises.

Fargeendringen vises i diagrammene Gene Expression (Genuttrykk).

n Hvis du vil vise prøven i diagrammene Gene Expression (Genuttrykk), velger du den i
kolonnen Show Chart (Vis diagram).

n Hvis du vil fjerne prøven fra diagrammene Gene Expression (Genuttrykk), fjerner du merket i
avmerkingsboksen i kolonnen Show Chart (Vis diagram).

Tips: Data for prøvengruppen blir værende i tabellen Results (Resultater).

Slik endrer du utvalget i Biological Set Analysis Options (Alternativer for analyse av
biologiske sett)

u Hvis du har tilordnet ett eller flere biologiske sett til brønner i platen (se Tilordne biologiske sett til
brønner på side 120), vises listen Biological Set Analysis Options (Alternativer for analyse av
biologiske sett) i dialogboksen Experiment Settings (Eksperimentinnstillinger), der du kan endre
utvalget etter behov.

n Target vs. Sample (Mål kontra prøve) – Kun brønnprøvenavnet brukes i beregningene av
genuttrykk.

n Target vs. Biological Set (Mål kontra biologisk sett) – Kun det biologiske settnavnet brukes
i beregningene.
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n Target vs. Sample_Biological Set (Mål kontra prøve_biologisk sett) – Prøvenavnet og det
biologiske settnavnet kombineres til ett enkelt navn som brukes i beregningene.

n Target vs. Biological Set_Sample (Mål kontra biologisk sett_prøve) – Det biologiske
settnavnet og prøvenavnet kombineres til ett enkelt navn som brukes i beregningene.

Slik utelukker du en prøvetype fra analyseberegninger

u Merk tilhørende avmerkingsboks nederst i dialogboksen Experiment Settings
(Eksperimentinnstillinger).

Merknad: Dette vil utelukke kontroller og/eller standarder fra genuttrykksanalysen.

Verdi for målstabilitet
Verdier for målstabilitet beregnes når det brukes mer enn ett referansegen. CFX Manager Dx-
programvaren beregner to kvalitetsparametere for referansegenene:

n Coefficient Variance (CV) (Variasjonskoeffisient) for relativ kvantitet av normaliserte
referansegener. En lavere CV-verdi angir høyere stabilitet.

n M Value (M) (M-verdi) er et mål på stabiliteten til referansegenuttrykket.

Anbefalte CV- og M-verdier vises nederst i dialogboksen Stability Value (Stabilitetsverdi).

Slik viser du verdien for målstabilitet

u Klikk på Target Stability Value (Verdi for målstabilitet) nederst i høyre rute i fanen Gene
Expression Bar Chart (Søylediagram for genuttrykk).

Dialogboksen Stability Value (Stabilitetsverdi) åpnes.

Alternativer i høyreklikkmenyen
Høyreklikk på genuttrykksdiagrammet for å velge elementene vist i Tabell 34.

Element Funksjon

Copy (Kopier) Kopierer diagrammet til utklippstavlen.

Save Image As (Lagre bilde
som)

Lagrer diagrammet som en bildefil. Angi oppløsning og størrelse for
bildet, og velg deretter filtype (PNG, GIF, JPG, TIF eller BMP).

Page Setup (Sideoppsett) Velger et sideoppsett for utskrift.

Tabell 34. Elementer på høyreklikkmenyen for genuttrykk
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Element Funksjon

Print (Skriv ut) Skriver ut diagrammet.

Set Scale to Default (Angi skala
til standard)

Show All (Vis alle) viser alle data i søylediagrammet. Scroll Bar
(Rullefelt) viser et rullefelt hvis det er for mange prøver å vise
innenfor diagrammets ramme og samtidig opprettholde en
minimumsbredde på søylene.

Chart Options
(Diagramalternativer)

Åpner vinduet Chart Options (Diagramalternativer) for justering av
grafen.

Sort (Sorter) Sorterer rekkefølgen på prøvene eller målene som vises på
diagrammets X-akse.

Use Corrected Std Devs (Bruk
korrigerte standardavvik)

Beregner feilsøylene ved bruk av den korrigerte formelen for
standardavvik.

Use Solid Bar Colors (Bruk fylte
søyler med farger)

Viser fylte søyler i diagrammet.

X–Axis Labels (Etiketter på X-
akse)

Viser etiketter på X-aksen, enten horisontalt eller vinklet.

Tabell 34. Elementer på høyreklikkmenyen for genuttrykk, forts.

Dataregneark
Tabell 35 definerer dataene som vises i Gene Expression Data Table (Datatabell for genuttrykk).

Merknad: Verdiene i tabellen er beregnet basert på graftypen og preferansene som er valgt i
høyre rute.

Informasjon Beskrivelse

Target (Mål) Målnavn (amplifisert gen) valgt i vinduet Experiment Settings
(Eksperimentinnstillinger).

Sample (Prøve) Prøvenavn valgt i vinduet Experiment Settings
(Eksperimentinnstillinger).

Ctrl (Ktrl) Kontrollnavn valgt i vinduet Experiment Settings
(Eksperimentinnstillinger).

Tabell 35. Beskrivelse av informasjon i regnearket i fanen Bar Chart (Søylediagram)
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Informasjon Beskrivelse

Relative Quantity (Relativ
kvantitet) eller
Expression (Uttrykk)

Relative Quantity (Relativ kvantitet) (ΔCq) eller Normalized Gene
Expression (Normalisert genuttrykk) (ΔΔCq), avhengig av valgt
modus.

Relative Quantity (Relativ
kvantitet) eller Expression SEM
(Uttrykk-SEM) (eller SD)

Standardfeil for gjennomsnittet (SEM) eller standardavvik (SD) for
den relative kvantiteten eller det normaliserte uttrykket, avhengig av
det valgte alternativet.

Corrected Relative Quantity
(Korrigert relativ kvantitet) eller
Expression SEM (Uttrykk-SEM)
(eller SD)

Beregning av korrigert verdi for SEM eller SD for den relative
kvantiteten eller det normaliserte uttrykket, avhengig av det valgte
alternativet.

Mean Cq (Gjennomsnitt Cq) Gjennomsnitt av kvantifiseringssyklusen.

Cq SEM (eller SD) SEM eller SD for kvantifiseringssyklusen, avhengig av det valgte
alternativet.

Tabell 35. Beskrivelse av informasjon i regnearket i fanen Bar Chart (Søylediagram), forts.

Alternativet Show Details (Vis detaljer)
Tabell 36 definerer dataene som vises når Show Details (Vis detailer) er valgt fra høyreklikkmenyen i
søylediagram-regnearket.

Informasjon Beskrivelse

Data Set (Datasett) Fluorescensdata fra én fluorofor i datafilen

Relative Quantity (Relativ
kvantitet)

Beregnet relativ kvantitet for prøver

Relative Quantity SD (SD for
relativ kvantitet)

Standardavvik for beregning av relativ kvantitet

Corrected Relative Quantity SD
(Korrigert SD for relativ
kvantitet)

Beregnet standardavvik for korrigert relativ kvantitet

Relative Quantity SEM (SEM
for relativ kvantitet)

Standardfeil av gjennomsnitt for beregningen av relativ kvantitet

Tabell 36. Informasjon i søylediagram-regnearket med Show Details (Vis detaljer) valgt
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Informasjon Beskrivelse

Corrected Relative Quantity
SEM (Korrigert SEM for relativ
kvantitet)

Beregnet standardfeil av gjennomsnitt for korrigert relativ kvantitet

Relative Quantity (lg) (Relativ
kvantitet (lg))

Log2 for den relative kvantiteten som blir brukt til statistisk analyse

SD RQ (lg) Standardavvik for relativ kvantitet (log2)

SEM Expression (lg) (SEM for
uttrykk (lg))

Standardfeil av gjennomsnitt for uttrykk (log2)

Unscaled Expression (Ikke-
skalert uttrykk)

Beregnet ikke-skalert uttrykk

Unscaled Expression SD (SD
for ikke-skalert uttrykk)

Beregnet standardavvik for ikke-skalert uttrykk

Corrected Unscaled Expression
SD (Korrigert SD for ikke-
skalert uttrykk)

Beregnet standardavvik for korrigert ikke-skalert uttrykk

Unscaled Expression SEM
(SEM for ikke-skalert uttrykk)

Beregnet standardfeil av gjennomsnitt for ikke-skalert uttrykk

Corrected Unscaled Expression
SEM (Korrigert SEM for ikke-
skalert uttrykk)

Beregnet standardfeil av gjennomsnitt for korrigert ikke-skalert
uttrykk

Unscaled Expression (lg) (Ikke-
skalert uttrykk (lg))

Log2 for ikke-skalert uttrykk

SD Unscaled Expression (lg)
(SD for ikke-skalert uttrykk (lg))

Standardavvik for ikke-skalert uttrykk (log2)

SEM Unscaled Expression (lg)
(SEM for ikke-skalert uttrykk
(lg))

Standardfeil av gjennomsnitt for ikke-skalert uttrykk (log2)

Expression (Uttrykk) Normalisert genuttrykk

Tabell 36. Informasjon i søylediagram-regnearket med Show Details (Vis detaljer) valgt, forts.
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Informasjon Beskrivelse

Corrected Expression SD
(Korrigert SD for uttrykk)

Beregnet standardavvik

Expression SEM (SEM for
uttrykk)

Standardfeil av gjennomsnitt

Corrected Expression SEM
(Korrigert SEM for uttrykk)

Beregnet standardfeil av gjennomsnitt

Expression (lg) (Uttrykk (lg)) Log2 for uttrykket (normalisert uttrykk) som blir brukt til statistisk
analyse

SD Expression (lg) (SD for
uttrykk (lg))

Standardavvik for uttrykk (log2)

SEM Expression (lg) (SEM for
uttrykk (lg))

Standardfeil av gjennomsnitt for uttrykk (log2)

Mean Cq (Gjennomsnitt Cq) Gjennomsnitt av kvantifiseringssyklus

Cq SD Standardavvik for kvantifiseringssyklus

Cq SEM Standardfeil av gjennomsnitt for kvantifiseringssyklus

Tabell 36. Informasjon i søylediagram-regnearket med Show Details (Vis detaljer) valgt, forts.
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Klyngediagram
Klyngediagrammet viser dataene i et hierarki basert på graden av likhet i uttrykket for ulike mål og
prøver.

Merknad: Du må velge et referansemål for å vise andre dataplott enn relativt uttrykk for
søylediagrammer.

Klyngediagrambildet viser det relative uttrykket for et mål eller en prøve på følgende måte:

n Oppregulering (rød) – høyere uttrykk

n Nedregulering (grønn eller blå) – lavere uttrykk

n Ingen regulering (svart)

n Ingen verdi beregnet (svart med et hvitt kryss)

Dess lysere fargen er, jo høyere er differansen i det relative uttrykket. Hvis det ikke kan beregnes en
normalisert Cq-verdi, er firkanten svart med et hvitt kryss.

På dataplottets ytre kanter er det et trestrukturdiagram, som viser klyngehierarkiet. Mål eller prøver
som har lignende uttrykksmønstre, har tilgrensende grener, mens mål eller prøver med ulike mønstre
plasseres lenger fra hverandre.

Innstillinger
Du kan angi følgende alternativer:

n Cluster By (Grupper etter) – velg mellom Targets (Mål), Samples (Prøver), Both (Begge) eller
None (Ingen).

n Size (Størrelse) – justerer bildestørrelsen og endrer graden av diagramforstørrelse.

n Split Out Replicates (Skill ut replikater) – viser verdier for de individuelle replikatene.

Tips: Du kan endre fargevalget for klyngediagram og spredningsplott fra standard rød/grønn til rød/blå
ved å velge dette alternativet fra høyreklikkmenyen i begge disse diagrammene.

Alternativer i høyreklikkmenyen
Alternativene i høyreklikkmenyen for klyngediagrammet er de samme som de for søylediagrammet.
Se Tabell 34 på side 229 for tilgjengelige alternativer. I tillegg kan du velge Color scheme (Fargevalg)
for å endre nedreguleringsuttrykket fra standard rød/grønn til rød/blå i diagrammet.
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Dataregneark
Regnearket viser verdier for målet, prøven og det normaliserte uttrykket. Klikk på avmerkingsboksen
ved siden av et mål for å inkludere eller ekskludere det fra plottet.
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Scatter Plot (Spredningsplott)
Spredningsplottet viser det normaliserte måluttrykket for en kontroll sammenlignet med en eksperimentell
prøve. Linjene i plottet angir terskelen for regulering. Datapunkter mellom linjene angir at forskjellen i uttrykk
for det relevante målet (genet) er ubetydelig mellom prøvene. Datapunkter utenfor linjene overstiger
terskelen for regulering og kan være av interesse.

Plottbildet viser følgende endringer i måluttrykk basert på terskelen for regulering:

n Oppregulering (rød sirkel) – relativt høyere uttrykk

n Nedregulering (grønn eller blå sirkel) – relativt lavere uttrykk

n Ingen endring (svart sirkel)

Klikk og dra en av terskellinjene for å justere verdien for terskelen for regulering.

Innstillinger
Du kan angi følgende alternativer:

n Control Sample (Kontrollprøve)

n Experimental Sample (Eksperimentell prøve)

n Regulation Threshold (Reguleringsterskel). Etter hvert som du øker eller
redusererreguleringsverdien, flytter terskellinjene i plottet seg tilsvarende.

Alternativer i høyreklikkmenyen
Alternativene i høyreklikkmenyen for spredningsplottet er de samme som de for søylediagrammet. Se
Tabell 34 på side 229 for tilgjengelige alternativer. I tillegg kan du velge Symbol for å endre symbolet
som brukes på plottet, fra standardsirkelen til ett av følgende:

n Triangle (Trekant)

n Cross (Kryss)

n Square (Firkant)

n Diamond (Diamant)
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Dataregneark
Regnearket viser verdier for målet og det normaliserte uttrykket for kontrollprøver og eksperimentelle
prøver. Det angir også hvorvidt målene er opp- eller nedregulert sammenlignet med
reguleringsterskelen. Klikk på avmerkingsboksen ved siden av et mål for å inkludere eller ekskludere
det fra plottet.

Brukerhåndbok | 237



Kapittel 11 Analyse av genuttrykk

Regnearket Results (Resultater)
Results (Resultater)-regnearket gir et regneark som oppsummerer dataene fra alle diagrammene.
Tabell 37 definer dataene vist i Results (Resultater)-regnearket.

Informasjon Beskrivelse

Target (Mål) Målnavn (amplifisert gen)

Sample (Prøve) Prøvenavn

Mean Cq (Gj.sn. Cq) Gjennomsnitt av kvantifiseringssyklusen

Mean Efficiency Corrected Cq
(Gjennomsnittlig
effektivitetskorrigert Cq)

Gjennomsnitt av kvantifiseringssyklusen etter justering for
reaksjonseffektivitet

Normalized Expression
(Normalisert uttrykk)

Måluttrykk normalisert til et referansemål (ΔΔCq)

Relative Normalized Expression
(Relativt normalisert uttrykk)

Normalisert uttrykk i forhold til en kontrollprøve; også kalt
foldendring

Regulation (Regulering) Endring i uttrykk i forhold til en kontrollprøve

Compared to Regulation
Threshold (Sammenlignet med
reguleringsterskel)

Opp- eller nedregulering av en eksperimentell prøve basert på
terskelinnstillingen

Tabell 37. Informasjon i Results (Resultater)-fanen

Merknad: Data for replikater finnes kun i regnearkene med dataanalysefanene der Split Out
Replicates (Skill ut replikater) er valgt (dvs. Clustergram (Klyngediagram)). Det kan være et avvik
mellom uttrykksdata i genuttrykksanalyse-regnearkene hvis du velger «none» (ingen) som
kontrollprøven på søylediagrammet.
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Genstudie
Opprett en genstudie for å sammenligne genuttrykksdata fra ett eller flere sanntids-PCR-
eksperimenter ved bruk av en kalibrator mellom kjøringer for å normalisere mellom eksperimentene.
Opprett en genstudie ved å legge til data fra en eller flere datafiler (.pcrd-filtype) i genstudien.
Programvaren grupperer dem i en enkelt fil (.mgxd-filtype).

Merknad: Maksimalt antall prøver du kan analysere i en genstudie, er begrenset av
datamaskinens RAM og virtuelle minne.

Kalibrering mellom kjøringer
Kalibrering mellom kjøringer blir automatisk forsøkt utført i hver genstudie for hvert mål for å
normalisere variasjoner mellom mål som er analysert i separate sanntids PCR-kjøringer (dvs. ulike
.pcrd-filer generert fra ulike plater).

For at programvaren skal gjenkjenne en prøve som en kalibrator mellom kjøringer, må hver plate som
sammenlignes, ha sammemålnavn, prøvenavn og, hvis relevant, biologisk settnavn.

Merknad: Minst én kalibratorprøve mellom kjøringer må være til stede i genstudien for at
kalibrering mellom kjøringer skal skje. Mål uten de riktige kalibratorprøvene mellom kjøringer vil
bli prosessert uten korreksjon i genstudien (anbefales ikke).

Kalibratorer mellom kjøringer kan brukes på to måter:

n Per target (Per mål) – ulike PCR-primere kan ha ulike effektiviteter. Kalibratoren mellom kjøringer
brukes som standard på alle brønnene på samme plate som har sammemålnavn, for eksempel
Cq generert med samme analyse.

n Entire study (Hele studien) – én kalibrator mellom kjøringer velges av brukeren og brukes på hele
genstudien.

Dialogboksen Gene Study (Genstudie)
Dialogboksen Gene Study (Genstudie) har to faner:

n Fanen Study Setup (Studieoppsett) – administrerer kjøringene i genstudien.

Viktig: Tilføyelse eller fjerning av datafiler i en genstudie endrer ikke dataene i originalfilen.

n Fanen Study Analysis (Studieanalyse) – viser genuttrykksdataene for de kombinerte kjøringene.

Fanen Study Setup (Studieoppsett)
Tabell 38 definerer dataene som vises i fanen Study Setup (Studieoppsett).
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Kolonnetittel Beskrivelse

File Name (Filnavn) Navn på kjøringsdatafilen (filtype .pcrd)

File Folder (Filmappe) Katalog som inneholder datafilen for hver kjøring i genstudien

Date Created (Dato
opprettet).

Datoen da kjøringsdataene ble samlet inn

Well Group Name
(Brønngruppenavn)

Navn på brønngruppen som ble valgt da filen ble lagt til i genstudien

Tips: For å analysere en brønngruppe i genstudien må du velge
denne brønngruppen i vinduet Data Analysis (Dataanalyse) før du
importerer datafilen til genstudien.

Step (Trinn) Protokolltrinn som inkluderer plateavlesningen for å samle inn sanntids
PCR-data

Run Type (Kjøringstype) Enten brukerdefinert eller PrimePCR™-kjøring

Protocol Edited (Protokoll
redigert)

Hvis valgt, angir at protokollen som er brukt til en PrimePCR-kjøring, er
blitt redigert

View Plate (Vis plate) Åpner et kart over platen med dataene i hver av kjøringene inkludert i
genstudien

Tabell 38. Fanen Study Setup (Studieoppsett) i dialogboksen Gene Study (Genstudie)

Klargjøre en Gene Study (Genstudie)
Slik klargjør du en genstudie

1. Før du importerer data i en genstudie må du gjøre følgende i vinduet Data Analysis
(Dataanalyse):

n Bekreft at prøver med det samme innholdet, har samme navn. I en genstudie antar
programvaren at brønner med samme navn på Target (Mål) eller Sample (Prøve) inneholder
de samme prøvene.

n Juster baselinjen og terskelen (Cq) i fanen Quantification (Kvantifisering) for å optimere
dataene i hver kjøring.

n Velg brønngruppen du vil inkludere i genstudien.

Hvis du vil vise data fra én brønngruppe i genstudien, må denne gruppen velges før du
importerer datafilen.

Fanen Study Setup (Studieoppsett) viser en liste over alle kjøringer i genstudien.

2. Velg fanen Study Setup (Studieoppsett) i dialogboksen Gene Study (Genstudie).
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Genstudie

3. Klikk på Add Data Files (Legg til datafiler) for å velge en fil fra et nettleservindu.

Tips: Du kan raskt legge til kjøringer i en genstudie ved å dra datafilene (endelsen .pcrd) til
dialogboksen Study Setup (Studieoppsett).

4. CFX Manager Dx-programvaren utfører genstudieanalysen automatisk når du legger til datafiler.
Velg fanen Study Analysis (Studieanalyse) for å vise resultatene.

Slik fjerner du kjøringer fra genstudien

u Velg én eller flere filer fra listen og klikk på Remove (Fjern).

Slik legger du til merknader om genstudien

u Skriv inn merknader om filene og analysen i tekstboksen Notes (Merknader).

Fanen Study Analysis (Studieanalyse)
Fanen Study Analysis (Studieanalyse) viser dataene fra alle kjøringer i genstudien. Alternativene for
analyse av genuttrykksdata er de samme som de for en enkelt datafil med unntak av følgende:

n For søylediagram vises kalibreringsverdier mellom kjøringer (hvis beregnet) når du klikker på
Inter-run Calibration (Kalibrering mellom kjøringer).

Merknad: Kun de følgende prøvetypene kan brukes som en kalibrator mellom kjøringer:

o Unknown (Ukjent)

o Standard

o Positive Control (Positiv kontroll)

Prøvetypene Negative control (Negativ kontroll), NTC (Ikke-templatkontroll) og NRT (Ikke revers
transkriptase-kontroll) kan ikke brukes som kalibrator mellom kjøringer.
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Opprette en genstudierapport
Slik oppretter du en genstudierapport

1. Juster etter behov dataene og diagrammene for genstudierapporten før en rapport opprettes.

2. Velg Tools > Reports (Verktøy > Rapporter) i menyen Gene Study (Genstudie) for å åpne
dialogboksen Report (Rapport).

3. Velg alternativene du vil inkludere i rapporten. Rapporten åpnes med standardalternativene valgt.
Merk av eller fjern merket i avmerkingsboksene for å endre hele kategorier eller individuelle
alternativer i en kategori.

Kategorier for genstudierapport på side 242 lister opp alternativene som er tilgjengelig for visning.

4. Endre rekkefølgen på kategoriene og elementene i en rapport. Dra alternativene til ønsket
posisjon. Rekkefølgen på elementene kan bare endres innenfor kategoriene de tilhører.

5. Klikk på Update Report (Oppdater rapport) for å oppdatere Report Preview (Forhåndsvisning av
rapport) med eventuelle endringer.

6. Skriv ut eller lagre rapporten. Klikk på knappen Print Report (Skriv ut rapport) på verktøylinjen for
å skrive ut den aktuelle rapporten. Velg File > Save (Fil > Lagre) for å lagre rapporten i PDF-
format (Adobe Acrobat Reader-fil), og velg et lagringssted for filen. Velg File > Save As (Fil >
Lagre som) for å lagre rapporten med et nytt navn eller på et nytt sted.

7. (Valgfritt) Opprett en rapportmal med informasjonen du ønsker. Hvis du vil lagre de gjeldende
rapportinnstillingene i en mal, velger du Template > Save (Mal > Lagre) eller Save As (Lagre
som). Deretter laster du inn rapportmalen neste gang du vil lage en ny rapport.

Kategorier for genstudierapport
Bruk dialogboksen Gene Study Report (Genstudierapport) for å organisere genstudiedataene i en
rapport. Tabell 39 lister opp alle alternativene som er tilgjengelige for en genstudierapport.

Kategori Alternativ Beskrivelse

Overskrift

Tittel, undertittel og logo for rapporten

Report Information
(Rapportinformasjon)

Dato, brukernavn, datafilnavn, datafilbane og
valgt brønngruppe

Tabell 39. Kategorier for en Gene Study (Genstudie)-rapport
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Genstudie

Kategori Alternativ Beskrivelse

Gene Study File List (Liste
over filer i genstudie)

Liste over alle datafilene i genstudien

Notes (Merknader) Merknader om datarapporten

Study Analysis (Studieanalyse): Bar Chart (Søylediagram)

Analysis Settings
(Analyseinnstillinger)

Liste over de valgte analyseparametrene

Chart (Diagram) Søylediagram for Gene Expression (Genuttrykk)
som viser dataene

Target Names (Målnavn) Liste over mål i genstudien

Sample Names
(Prøvenavn)

Liste over prøver i genstudien

Data Regneark som viser dataene

Target Stability
(Målstabilitet)

Data for målstabilitet

Inter-run Calibration
(Kalibrering mellom
kjøringer)

Kalibreringsdata mellom kjøringer

Study Analysis (Studieanalyse): Clustergram (Klyngediagram) og Scatter Plot
(Spredningsplott)

Analysis Settings
(Analyseinnstillinger)

Innstillinger for hver diagramtype

Chart (Diagram) Diagram for genuttrykk som viser dataene

Data Regneark som lister opp dataene i hvert mål

Tabell 39. Kategorier for en Gene Study (Genstudie)-rapport, forts.
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Vedlegg A Dataanalyseberegninger
CFXManager™ Dx-programvaren beregner formler automatisk og viser resultatene i fanene i Data
Analysis (Dataanalyse). Dette vedlegget gir en detaljert beskrivelse av hvordan CFX Manager Dx-
programvaren beregner formler.

Reaksjonseffektivitet
Beviser antyder at bruk av nøyaktige mål for effektivitet for hvert primer- og probesett gir mer
nøyaktige resultater ved analysering av genuttrykksdata. Standardverdien for effektivitet som brukes i
beregninger av genuttrykket, er 100 %. For å evaluere reaksjonseffektiviteten må du generere en
standardkurve ved bruk av en rekke fortynninger av en representativ prøve over et relevant dynamisk
område, og deretter registrere effektiviteten for etterfølgende analyse av genuttrykk. Hvis kjøringen
inkluderer en standardkurve, beregner programvaren automatisk effektiviteten, og viser den under
Standard Curve (Standardkurve) i fanen Quantification (Kvantifisering) når Auto Efficiency (Auto-
effektivitet) er merket av i fanen Targets (Mål) i vinduet Experiment Settings (Eksperimentinnstillinger)

Effektiviteten (E) i effektivitetsformler henviser til «effektivitetene» som beskrevet av Pfaffl (2001) og
Vandesompele et al. (2002). I disse publikasjonene er en effektivitet på 2 (perfekt dobling i hver
syklus) tilsvarende 100 % effektivitet i denne programvaren. Du har muligheten til å konvertere
effektivitetsberegningene til de som brukes i programvaren ved å bruke følgende matematiske forhold:

n E = (% effektivitet * 0,01) + 1

n % effektivitet = (E – 1) * 100
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Relativ kvantitet
Formelen for relativ kvantitet (ΔCq) for alle prøver (GOI) er:

Merknad: Denne formelen brukes til å beregne relativ kvantitet når det ikke er definert en
kontrollprøve.

Der:

n E = Effektivitet av primer og probesett. Denne effektiviteten beregnes med formelen
(% effektivitet * 0,01) + 1, der 100 % effektivitet = 2

n C q (min) = gjennomsnittlig Cq for prøven med det laveste gjennomsnittet Cq for GOI

n C q (prøve) = gjennomsnittlig Cq for prøven

n GOI = interessegen (ett mål)

Relativ kvantitet når en kontroll er valgt
Når en kontrollprøve er tilordnet, blir den relative kvantiteten (RQ) for en prøve med et interessegen
(GOI) beregnet med denne formelen:

Der:

n E = Effektivitet av primer og probesett. Denne effektiviteten beregnes med formelen
(% effektivitet * 0,01) + 1, der 100 % effektivitet = 2

n Cq (control) = Gjennomsnittlig Cq for kontrollprøven

n Cq (sample) = Gjennomsnittlig Cq for alle prøver med et GOI

n GOI = Interessegen (ett mål)

246 | CFX96 Dx- og CFX96 DeepWell Dx-systemet



Standardavvik for Relative Quantity (Relativ kvantitet)

Standardavvik for Relative Quantity (Relativ kvantitet)
Formelen for standardavviket til den relative kvantiteten er

Der:

n SD Relative Quantity = standardavviket til den relative kvantiteten

n SA CqGOI sample = standardavviket til prøvens Cq (GOI)

n Relative Quantity = prøvens relative kvantitet

n E = Effektivitet av primer og probesett. Denne effektiviteten beregnes med formelen
(% effektivitet * 0,01) + 1, der 100 % effektivitet = 2

n GOI = interessegen (ett mål)

Efficiency Corrected Cq (CqE) (Effektivitetskorrigert Cq (CqE))
Formelen for effektivitetskorrigert Cq er

Der:

n E = Effektivitet

Mean Efficiency Corrected Cq (Gjennomsnittlig
effektivitetskorrigert Cq (MCqE))

Formelen for gjennomsnittlig effektivitetskorrigert Cq er

Der:

n CqE = Effektivitetskorrigert Cq

n n = Antall replikater
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Normaliseringsfaktor
Nevneren i ligningen for det normale uttrykket kalles normaliseringsfaktoren. Normaliseringsfaktoren
er det geometriske gjennomsnittet av de relative kvantitetene for alle referansemål (gener) for en gitt
prøve, som beskrevet i formelen:

Der:

n RQ = Relativ kvantitet

n n = Antall referansemål

n GOI = Interessegen (ett mål)

Normalisert uttrykk
Normalisert uttrykk (ΔΔCq) er den relative kvantiteten av målet (gen) normalisert til kvantitetene av
referansemålene (gener eller sekvenser) i det biologiske systemet. For å velge referansemål åpner du
vinduet Experiment Settings (Eksperimentinnstillinger) og klikker på referansekolonnen for hvert mål
som brukes som et referansegen.

Formelen for normalisert uttrykk, som bruker den beregnede relative kvantiteten (RQ), er:

Der:

n RQ = Relativ kvantitet av en prøve

n Ref = Referansemål i en kjøring som inkluderer ett eller flere referansemål i hver prøve

n GOI = Interessegen (ett mål)

Gitt at referansemål ikke endrer uttrykksnivået i det biologiske systemet, vil beregningen av
normalisert uttrykk ta høyde for innlastingsforskjeller eller variasjoner i celleantall som er representert i
hver av prøvene.
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Normalisert uttrykk når en kontroll er valgt
Når du velger en kontrollprøve i vinduet Experiment Settings (Eksperimentinnstillinger), setter
programvaren kontrollprøvens uttrykksnivå til 1. I denne situasjonen normaliserer programvaren den
relative kvantiteten av alle måluttrykk (genuttrykk) til kontrollkvantiteten (en verdi på 1). Dette
normaliserte uttrykket tilsvarer analysen av det uskalerte normaliserte uttrykket når en kontroll er valgt.

Merknad: Dette er også kjent som relativt normalisert uttrykk (RNE) og foldendring.
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Standardavvik for det normaliserte uttrykket
Reskalering av den normaliserte uttrykksverdien utføres ved å dividere standardavviket for det
normaliserte uttrykket med den normaliserte uttrykksverdien for det høyeste eller laveste individuelle
uttrykksnivået, avhengig av hvilket skaleringsalternativ du velger. Formelen for standardavvik (SD) i
normaliseringsfaktoren er

Der:

n RQ = Relativ kvantitet av en prøve

n SD = Standardavvik

n NF = Normaliseringsfaktor

n Ref = Referansemål

n n = Antall referansemål

Når en kontrollprøve er tilordnet, er det ikke nødvendig å utføre denne reskaleringsfunksjonen på
standardavviket, som vist i følgende formel:

Der:

n NE = Normalisert uttrykk

n RQ = Relativ kvantitet av en prøve

n SD = Standardavvik

n GOI = Interessegen (ett mål)
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Normalisert uttrykk skalert til høyeste uttrykksnivå

Normalisert uttrykk skalert til høyeste uttrykksnivå
Når kjøringen ikke inkluderer kontroller, skalerer du det normaliserte uttrykket (NE) for hvert mål (gen)
ved å dividere uttrykksnivået for hver prøve med det høyeste uttrykksnivået i alle prøver.
Programvaren setter det høyeste uttrykksnivået til en verdi av 1, og reskalerer alle
prøveuttrykksnivåene. Formelen for høyeste skalering er:

Der:

n GOI = Interessegen (mål)

Normalisert uttrykk skalert til laveste uttrykksnivå
Når kjøringen ikke inkluderer kontroller, skalerer du det normaliserte uttrykket (NE) for hvert mål (gen)
ved å dividere uttrykksnivået for hver prøve med det laveste uttrykksnivået i alle prøver. Programvaren
setter det laveste uttrykksnivået til en verdi av 1, og reskalerer alle prøveuttrykksnivåene. Formelen for
laveste skalering er:

Der:

n GOI = Interessegen (mål)

Normalisert uttrykk skalert til gjennomsnittlig uttrykksnivå
Når kjøringen ikke inkluderer kontroller, skalerer du det normaliserte uttrykket (NE) for hvert mål (gen)
ved å dividere uttrykksnivået for hver prøve med det geometriske gjennomsnittsnivået av uttrykk for
alle prøver. Programvaren setter det gjennomsnittlige uttrykksnivået til en verdi av 1, og reskalerer alle
prøveuttrykksnivåene. Formelen for gjennomsnittlig skalering er:

Der:

n GOI = Interessegen (mål)

n GM = Geometrisk gjennomsnitt av normalisert uttrykk for alle prøver
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Standardavvik for det skalerte normaliserte uttrykket
Verdien for det skalerte normaliserte uttrykket (NE) kan skaleres på nytt ved å dele standardavviket
(SD) til det normaliserte uttrykket på verdien for det normaliserte uttrykket for det høyeste (MAX) eller
laveste uttrykksnivået, avhengig av hvilket skaleringsalternativ du velger.

Merknad: Når en kontrollprøve er tilordnet, trenger du ikke å utføre denne funksjonen for ny
skalering på standardavviket.

Beregningen for denne formelen er

Der:

n NE = Normalisert uttrykk

n SD = Standardavvik

n GOI = Interessegen (mål)

n MAX = Høyeste uttrykksnivå

n MIN = Laveste uttrykksnivå

Regulering
Regulering er et mål på økningen eller reduksjonen i uttrykket til et mål for en eksperimentell prøve
kontra en kontrollprøve, og bestemmes på følgende måte:

Hvis uttrykk (eksperimentell) > uttrykk (kontroll):

Hvis uttrykk (eksperimentell) < uttrykk (kontroll):

Merknad: For Bar Chart (Søylediagram) er Expression (Uttrykk) basert på enten den relative
kvantiteten eller det normaliserte uttrykket, avhengig av den valgte modusen (se Bar Chart
(Søylediagram) på side 222). For Scatter Plot (Spredningsplott) og Clustergram (Klyngediagram)
beregnes imidlertid regulering alltid fra det normaliserte uttrykket.
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Formler for korrigerte verdier

Formler for korrigerte verdier
En forskjell mellom korrigerte verdier og ikke-korrigerte verdier ses kun hvis det opprettes en
standardkurve som del av sanntids PCR-kjøringen. Programvaren bruker tre formler for å bestemme
feiloverføringen:

n Standardfeil

n Standardfeil for normalisert uttrykk

n Standardfeil for normalisert interessegen (mål)

Formelen for standardfeil er

Der:

n n = Antall referansemål (gener)

n SD = Standardavvik

Standardfeilen for normaliseringsfaktoren i formelen for normalisert uttrykk er

Der:

n n = Antall referansemål

n SE = Standardfeil

n NF = Normaliseringsfaktor

n RQ = Relativ kvantitet

Standardfeilen for formelen for normalisert interessegen (GOI) er

Der:

n SE = Standardfeil

n GOI = Interessegen (ett mål)

n NF = Normaliseringsfaktor

n n = Antall referansemål
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Vedlegg B Administrere brukere og roller i CFX
Manager Dx

I CFX Manager™ Dx-programvaren kan du opprette brukere og tilordne en rolle til disse brukerne.
Roller begrenser tilgangen til funksjonene i CFX Manager Dx. Kun én rolle kan tilordnes om gangen.
En administrator for CFX Manager Dx-programvaren kan imidlertid endre brukerens rolle når som
helst.

Tips: Det er ikke nødvendig å opprette brukere for å bruke CFX Manager Dx. Hvis du ikke
oppretter brukere, utføres all aktivitet av admin (administrator) for standard brukerkontoer.

Viktig: Brukeradministrator er standardkontoen for Administrator, som du bruker når du logger på
CFX Manager Dx for første gang. Det anbefales at du oppretter et spesifikt brukernavn for
administrering av CFX Manager Dx. Tilordne Administrator-rolle til denne brukeren og bruk den til
å utføre alle administrasjonsoppgaver.

Viktig: CFXManager Dx-programvaren har ikke funksjon for avslutting av brukerøkter ved
manglende aktivitet. Derfor anbefales det at du implementerer Windows-sikkerhetstiltak eller
sikkerhetstiltak fra tredjeparter (for eksempel en skjermsparer som krever pålogging).

Administrere brukere
I standardutgaven av CFX Manager Dx-programvaren kan brukerkontoer ha et hvilket som helst navn
eller passord.

For å tilordne en rolle til hver bruker velger du fra listen over roller i vinduet User Administration
(Brukeradministrasjon). I dette eksempelet gis brukeren Guest (Gjest) den ekstra rettigheten til å lagre
filer.

Legge til og fjerne brukere
Merknad: Kun CFX Manager Dx-administratoren kan legge til og fjerne brukere.

Slik legger du til brukerkontoer i CFX Manager Dx

1. I startvinduet velger du User > User Administration (Bruker > Brukeradministrasjon).

Dialogboksen User Administration (Brukeradministrasjon) vises.
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2. I vinduet Manage Users (Administrer brukere) skriver du inn et brukernavn for brukeren.

3. Velg en brukerrolle.

Roller begrenser brukerens rettigheter. Principal (Hovedbruker) er standard.

Tips: Du kan endre rettighetene til hver rolle. Hvis du endrer rettighetene til rollen, påvirkes
alle brukere som er tilordnet den rollen. Hvis du vil ha mer informasjon, må du se
Administrere rettigheter for roller på side 257.

4. (Valgfritt) Skriv inn Full Name (Fullstendig navn) og Password (Passord) for brukeren.

5. Klikk på OK for å åpne en dialogboks og bekrefte at du vil lukke vinduet.

6. Klikk på Yes (Ja) for å lukke dialogboksen og vinduet.

Slik fjerner du en bruker

1. I vinduet Manage Users (Administrer brukere) velger du Remove (Fjern) for hver bruker du
ønsker å fjerne.

2. Klikk på OK for å åpne en dialogboks og bekrefte at du vil lukke vinduet.

3. Klikk på Yes (Ja) for å lukke dialogboksen og vinduet.

Merknad: Listen over programvarebrukere må alltid inkludere én administrator.
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Administrere brukere

Administrere rettigheter for roller
CFXManager Dx inneholder følgende fire roller:

n Administrator (påkrevd) – administratorer har alle rettigheter, og du kan ikke endre disse
rettighetene. Administratorer kan også legge til og fjerne brukere, og endre rettighetene for hver
rolle.

Merknad: Det er kun administratorer som kan endre rettighetene for en rolle.

n Principal (Hovedbruker) – hovedbrukeren har alle rettigheter som standard

n Operator (Operatør) – operatøren har alle rettigheter som standard, bortsett fra å hoppe over
sykluser

n Guest (Gjest) – gjesten kan kun lese filer som standard

Viktig: Endring av rettigheter for en rolle vil påvirke alle brukere som er tilordnet denne rollen. Du
kan ikke tilpasse en rolle for en bestemt bruker. Utvis forsiktighet når du endrer rettighetene for en
rolle.

Slik angir du rettigheter for hver rolle

1. I startvinduet velger du User > User Administration (Bruker > Brukeradministrasjon).

2. Gjør ett av følgende i ruten Manage Rights (Administrer rettigheter):

n Hvis du vil fjerne en rettighet fra en rolle, fjerner du merket i avmerkingsboksen.

n Hvis du vil legge til en rettighet til en rolle, merker du av i avmerkingsboksen.

3. Klikk på OK for å åpne en dialogboks og bekrefte at du vil lukke vinduet.

4. Klikk på Yes (Ja) for å lukke dialogboksen og vinduet.

Slik tilbakestiller du alle rettigheter for alle roller

u Klikk på Restore Default Rights (Gjenopprett standardrettigheter) i dialogboksen User
Administration (Brukeradministrasjon).
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Logge på CFX Manager Dx-programvaren
CFXManager Dx-programvaren administrerer hvem som logger seg på programvaren ved bruk av
dialogboksen Login (Logg på). Når du starter programvaren, viser CFX Manager Dx automatisk
dialogboksen Login (Logg på) når to eller flere brukere er oppført i vinduet User Administration
(Brukeradministrasjon).

CFX Manager Dx viser navnet til den påloggede brukeren øverst i startvinduet.

Slik logger du på CFX Manager Dx

1. I dialogboksen Login (Logg på) velger du navnet ditt fra rullegardinlisten User Name
(Brukernavn).

2. Skriv inn passordet.

3. Klikk på OK for å lukke dialogboksen for pålogging og åpne programvaren.

Bytte bruker
Du kan bytte bruker mens programvaren kjører.

Slik bytter du bruker

1. I startvinduet velger du User > Select User (Bruker > Velg bruker) for å åpne dialogboksen for
pålogging.

2. Velg et navn på rullegardinmenyen User Name (Brukernavn).

3. Skriv inn passordet til den nye brukeren.

4. Klikk på OK for å lukke dialogboksen for pålogging og åpne programvaren.

258 | CFX96 Dx- og CFX96 DeepWell Dx-systemet



Logge på CFX Manager Dx-programvaren

Endre brukerpassord
CFXManager Dx-brukere kan endre passordet sitt når som helst.

Endre brukerpassord

1. I startvinduet velger du User > Change Password (Bruker > Endre passord) for å åpne
dialogboksen Change Password (Endre passord).

2. I feltet Old Password (Gammelt passord) skriver du inn ditt nåværende passord.

3. I feltet New Password (Nytt passord) skriver du inn et nytt passord og gjentar dette i feltet Confirm
New Password (Bekreft nytt passord).

4. Klikk på OK for å bekrefte endringen.

Vise roller og rettigheter
Tips: Brukere som tilordnes brukerrollene Principal (Hovedbruker), Operator (Operatør) eller
Guest (Gjest), kan bare se sine brukerinnstillinger, rettigheter og roller.

Slik kan du se gjeldende brukerrolle og rettigheter

u I startvinduet velger du User > User Administration (Bruker > Brukeradministrasjon).

Kontakt CFX Manager Dx-administratoren for å modifisere brukerinnstillinger, rettigheter og roller som
vises i vinduet User Administration (Brukeradministrasjon).
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Vedlegg C LIMS-integrering
Du kan konfigurere CFX Manager™ Dx-programvaren for bruk med et
informasjonsbehandlingssystem for laboratorier (LIMS). For LIMS-integrering krever CFX Manager
Dx informasjon om plateoppsett generert av LIMS-plattformen (en LIMS-fil, *.plrn), en protokollfil
opprettet med CFX Manager Dx-programvaren (*.prcl), en definert plassering for dataeksport og et
definert eksportformat.

Etter at kjøringen er fullført, genererer CFX Manager Dx en datafil (.pcrd) og lagrer den på en definert
mappeplassering for dataeksport. CFX Manager Dx kan også opprette en LIMS-kompatibel datafil i
.csv-format og lagre den på samme plassering.

Opprette LIMS-kompatible datafiler
Dette tillegget forklarer hvordan du setter opp CFX Manager Dx-programvaren for å opprette, lagre og
eksportere LIMS-kompatible datafiler.

Sette opp LIMS-mappe og alternativer for dataeksport
CFXManager Dx lagrer som standard LIMS-protokoller, -filer og dataeksportfiler i denne mappen:
_ C:\Users\Public\Documents\Bio-Rad\CFX_Dx\LIMS

Du kan konfigurere CFX Manager Dx slik at systemet lagrer filene i en annen mappe, og du kan endre
eksportalternativene for LIMS-data.

Slik setter du opp en LIMS-mappe og alternativer for dataeksport

1. Velg Tools > Options ( Verktøy > Alternativer) i startvinduet.

2. Velg Data Export Settings (Innstillinger for dataeksport) i dialogboksen Options (Alternativer).
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3. (Valgfritt) Velg Automatically export LIMS data at end of run (Eksporter LIMS-data automatisk
etter fullført kjøring).

Programvaren vil automatisk eksportere LIMS-data etter hver kjøring og lagre dem på angitt sted.

4. Hvis du vil endre standard eksportalternativer for LIMS-data, klikker du på LIMS Data Export
Settings (Innstillinger for eksport av LIMS-data).

Viktig: Kun LIMS-data som eksporteres som en .csv-fil, kan importeres tilbake til CFX
Manager Dx.

5. I dialogboksen LIMS Data Export Format Settings (Innstillinger for eksportformat for LIMS-data)
velger du de påkrevde eksportalternativene og klikker på OK.

6. I dialogboksen Options (Alternativer) navigerer du til og velger en standardmappe der du vil lagre
LIMS-datafilene. Du kan velge forskjellig plassering for hver filtype:

n Protocol (Protokoll)

n LIMS file (LIMS-fil)

n Data export (Dataeksport)

7. Klikk på OK for å lagre endringene og lukke dialogboksen Options (Alternativer).

Opprette en LIMS-protokoll
Når du vil starte en LIMS-kjøring, må du opprette en CFX Manager Dx-protokollfil (*.prcl) og lagre den
på plasseringen for den tilordnede LIMS-protokollmappen.

Se Kapittel 6, Opprette protokoller for mer informasjon.
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Opprette en LIMS-fil
En LIMS-fil (*.plrn) inneholder detaljer om plateoppsettet og navnet på protokollfilen. Denne filen
genereres av ditt interne LIMS. CFX Manager Dx bruker LIMS-filen til å opprette en platefil som skal
brukes med en protokollfil.

CFX Manager Dx inneholder malfiler for plateimport som du kan redigere for å opprette tilpassede
LIMS-platefiler.

Tips: Denne oppgaven skal utføres av en LIMS-spesialist.

Slik oppretter du en LIMS-fil

1. I startvinduet velger du View > Show > LIMS File Folder (Visning > Vis > LIMS-filmappe).

2. Åpne mappen LIMS Templates (LIMS-maler) og velg en .csv-fil som skal importeres til ditt interne
LIMS.

3. Ved hjelp av LIMS kan du redigere malfilen ved å fylle ut de påkrevde feltene oppført i Tabell 40.

4. Lagre malen med filtypen .plrn i LIMS-filmappen.

Viktig: CFXManager Dx kan kun åpne .plrn-filen. Du må lagre .csv-filen som .plrn for å
kunne starte LIMS-kjøringen.

Kolonne Rad Beskrivelse Innhold Formål

A 1 Plate Header
(Plateoverskrift)

Skal ikke redigeres Forhåndsdefinert

A,B,C 2 Field/Data/Instruction
(Felt/data/instruksjon)

Skal ikke redigeres Forhåndsdefinert

B 3 Version (Versjon) Skal ikke redigeres Forhåndsdefinert

Tabell 40. Definisjon av innhold i LIMS .csv-filen
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Kolonne Rad Beskrivelse Innhold Formål

B 4 Plate Size
(Platestørrelse)

Skal ikke redigeres Forhåndsdefinert

B 5 Plate Type (Platetype) Legg inn “BRWhite”
(BR hvit), “BR Clear”
(BR klar) eller en
annen kalibrert
platetype

Påkrevd

B 6 Scan Mode
(Skannemodus)

Legg inn
“SYBR/FAMOnly:”
(Kun SYBR/FAM:),
“All Channels” (Alle
kanaler) eller “FRET”

Påkrevd

Tabell 40. Definisjon av innhold i LIMS .csv-filen, forts.
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Kolonne Rad Beskrivelse Innhold Formål

B 7 Units (Enheter) Legg inn ett av
følgende
alternativer: “copy
number”
(kopinummer), “fold
dilution”
(foldfortynning),
“micromoles”
(mikromol),
“nanomoles”
(nanomol),
“picomoles”
(pikomol),
“femtomoles”
(femtomol),
“attomoles”
(attomol),
“milligrams”
(milligram),
“micrograms”
(mikrogram),
“nanograms”
(nanogram),
“picograms”
(pikogram),
“femtograms”
(femtogram),
“attograms”
(attogram) eller
“percent” (prosent)

Påkrevd

Tabell 40. Definisjon av innhold i LIMS .csv-filen, forts.
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Kolonne Rad Beskrivelse Innhold Formål

B 8 Run ID (Kjørings-ID) Legg inn en kort
beskrivelse eller
strekkode som
identifiserer denne
kjøringen (maks. 30
tegn, komma ikke
tillatt)

Valgfritt

B 9 Run Note
(Kjøringsmerknad)

Legg inn
kjøringsbekrivelse

Valgfritt

B 10 Run Protocol
(Kjøringsprotokoll)

Legg inn
protokollfilnavn
nøyaktig som
oppført.

Påkrevd

A 11 Data File (Datafil) Legg inn datafilnavn Valgfritt

A 12–15 TBD/Empty (TBD/tom) Skal ikke redigeres Forhåndsdefinert

A 16 Plate Data (Platedata) Skal ikke redigeres Forhåndsdefinert

Tabell 40. Definisjon av innhold i LIMS .csv-filen, forts.
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Kolonne Rad Beskrivelse Innhold Formål

A 17–113 Well Position
(Brønnposisjon)

Skal ikke redigeres Forhåndsdefinert

B–G Ch1 Dye (Kanal1
fargestoff), Ch2 Dye
(Kanal2 fargestoff), Ch3
Dye (Kanal3 fargestoff),
Ch4 Dye (Kanal4
fargestoff), Ch5 Dye
(Kanal5 fargestoff),
FRET

Legg inn ett kalibrert
fargestoffnavn (for
eksempel “FAM”) for
hver kanal som
brukes

Påkrevd

H Sample Type
(Prøvetype)

Legg inn én av
følgende prøvetyper:
“Unknown” (Ukjent),
“Standard”, “Positive
Control” (Positiv
kontroll), “Negative
Control” (Negativ
kontroll), “NTC”
(Ikke-
templatkontroll) eller
“NRT” (Uten revers
transkriptase)

Påkrevd

Tabell 40. Definisjon av innhold i LIMS .csv-filen, forts.
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Kolonne Rad Beskrivelse Innhold Formål

I Sample Name
(Prøvenavn)

Legg inn prøvenavn Valgfritt

J–O CH1 Target (Kanal1
mål), CH2 Target
(Kanal2 mål), CH3
Target (Kanal3 mål),
CH4 Target (Kanal4
mål), CH5 Target
(Kanal5 mål), FRET
Target (FRET mål)

Legg inn målnavn for
hver kanal som
brukes

Valgfritt

P Biological Set Name
(Navn på biologisk sett)

Legg inn navn på
biologisk sett

Valgfritt

Q Replicate (Replikat) Legg inn et positivt
heltall for hvert sett
med replikater.
Verdien kan ikke
være null.

Valgfritt

R–W CH1 Quantity (Kanal1
kvantitet), CH2 Quantity
(Kanal2 kvantitet), CH3
Quantity (Kanal3
kvantitet), CH4 Quantity
(Kanal4 kvantitet), CH5
Quantity (Kanal5
kvantitet, FRET Quantity
(FRET kvantitet)

Legg inn
kvantitetsverdier for
alle standarder.
Legg inn
konsentrasjon i
desimalform.

Påkrevd for alle
standarder

Tabell 40. Definisjon av innhold i LIMS .csv-filen, forts.
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Kolonne Rad Beskrivelse Innhold Formål

X Well Note
(Brønnmerknad)

Legg inn
brønnmerknad
(maks. 20 tegn)

Valgfritt

Y–AD Ch1Well Color (Kanal1
brønnfarge), Ch2Well
Color (Kanal2
brønnfarge), Ch3Well
Color (Kanal3
brønnfarge), Ch4Well
Color (Kanal4
brønnfarge), Ch5Well
Color (Kanal5
brønnfarge), FRETWell
Color (FRET
brønnfarge)

Legg inn enhver
brukerdefinert farge
for kurvestil i et 32-
bits integer (argb)
desimalformat

Valgfritt

Tabell 40. Definisjon av innhold i LIMS .csv-filen, forts.

Starte en LIMS-kjøring
Slik starter du en LIMS-kjøring

1. Gjør ett av følgende for å åpne en LIMS .plrn-fil:

n I startvinduet velger du View > Show > LIMS File Folder (Visning > Vis > LIMS-filmappe) og
åpner .plrn-målfilen.

n I startvinduet velger du File > Open > LIMS File (Fil > Åpne >LIMS-fil) og åpner .plrn-målfilen.

Filen åpnes i fanen Start Run (Start kjøring) i veiviseren Run Setup (Kjøringsoppsett). Fanen Start
Run (Start kjøring) viser informasjon om eksperimentet som skal kjøres. Den viser også den
tilkoblede instrumentblokken eller blokker du kan kjøre eksperimentet på.
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2. I fanen Start Run (Start kjøring) velger du et instrument og klikker på Start Run (Start kjøring).

Eksportere data til et LIMS
Etter at kjøringen er fullført, genererer CFX Manager Dx en datafil (.pcrd) og lagrer den på den
definerte mappeplasseringen for dataeksport.

Slik eksporterer du datafilen til et LIMS

u Åpne .pcrd-filen, og velg Export > Export to LIMS Folder (Eksport > Eksporter til LIMS-mappe).

Tips: Hvis du velger Automatically Export Data after Run (Eksporter data automatisk etter
kjøring) i LIMS Options (Alternativer for LIMS), oppretter CFX Manager Dx en LIMS-kompatibel
datafil i .csv format og lagrer den i den sammemappen.
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Vedlegg D Feilsøking av tilkoblingsproblemer
med CFX Manager Dx-programvaren

Programvarelogg
Før du starter en ny kjøring initierer CFX96™ og CFX96 DeepWell-instrumentene en selvdiagnostisk
test for å bekrefte at den kjøres innenfor spesifikasjonene. Programvaren registrerer resultatene av
denne testen i filene Run Log (Kjøringslogg) og Application Log (Programvarelogg). Hvis du oppdager
et problem i ett eller flere eksperimenter, må du åpne kjørings- og programvareloggene for å finne ut
når problemene startet.

CFX Manager™ Dx sporer informasjon om tilstanden til et instrument under en kjøring i Application
Log (Programvarelogg). Bruk disse loggene til å spore hendelser som inntreffer på instrumentene og i
programvaren samt for feilsøking.

Slik åpner du programvareloggen

u I startvinduet velger du View > Application Log (Vis > Programvarelogg).
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Feilsøking
Du kan vanligvis løse problemer med programvare- og instrumentkommunikasjon ved å starte
datamaskinen og systemet på nytt. Det er viktig at du lagrer eventuelt pågående arbeid før du starter
på nytt.

Merknad: Kontroller at datamaskinen har nok RAM og ledig diskplass. Minimum RAM er 4 GB og
minimum ledig diskplass er 128 GB.

Strømbrudd
Ved et strømbrudd stenges instrumentet og datamaskinen ned. Hvis strømbruddet er kortvarig, vil
instrumentet gjenoppta kjøringen av en protokoll, men strømbruddet blir registrert i Application Log
(Applikasjonslogg). Avhengig av datamaskinens innstillinger og lengden på strømbruddet, vil
instrumentet og programvaren prøve å fortsette kjøringen, avhengig av protokolltrinnet:

n Hvis protokollen er i et trinn som ikke inneholder plateavlesning, fortsetter protokollen å kjøre
straks instrumentet forsynes med strøm igjen.

n Hvis protokollen er i et trinn som inneholder plateavlesning, venter instrumentet på at
programvaren skal startes på nytt og gjenopptar kommunikasjonen for innsamling av data. I
denne situasjonen fortsetter protokollen kun hvis programvaren ikke er stengt ned av
datamaskinen. Protokollen fortsetter når datamaskinen og programvaren starter opp på nytt.

Ta prøver ut av reaksjonsmodulen under et strømbrudd

Du kan åpne et motorisert lokk på en reaksjonsmodul for å ta ut prøvene under et strømbrudd.

Slik tar du av låseplaten

1. Trykk ned på låseskinnen for å ta reaksjonsmodulen av C1000™Dx-termosykleren.

2. Sett reaksjonsmodulen forsiktig på et skrivebord eller laboratoriebenken.

3. Plasser modulen slik at fronten på modulen stikker 2 tommer utover kanten.
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4. Bruk en sekskantnøkkel, og skru ut de to store skruene på undersiden av den fremre kanten av
reaksjonsmodulen (under knappen for åpning av lokket).

Du vil høre at låseklinken frigjøres fra innsiden av modulen.

Viktig: Ikke skru ut de to små skruene på den fremre kanten av modulen.

5. Skyv opp lokket på reaksjonsmodulen. Vær oppmerksom på at klinken (svart plast) ikke lenger er
montert. Ta prøvene ut av blokken.

6. Sett tilbake låseklinken og fest den med de store skruene for å montere reaksjonsmodulen igjen
med lokket åpent.
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Hente ut filer til CFX Manager Dx-datamaskinen
Du kan hente ut data og loggfiler lagret på instrumentet og overføre dem til harddisken til en tilkoblet
datamaskin.

Merknad: Alle filer i mappen for sanntidsdata på instrumentsokkelen overføres til datamaskinen.

Slik henter du ut filer fra instrumentet

1. Høyreklikk på målinstrumentet i ruten Detected Instruments (Detekterte instrumenter) i
startvinduet, og velg ett av følgende alternativer:

n Retrieve Log Files (Hent ut loggfiler)

n Retrieve Data Files (Hent ut datafiler)

2. Velg en mappe der du vil lagre filene.

3. Klikk på OK.

Installere CFX Manager Dx-programvaren manuelt
Slik installerer du CFX Manager Dx-programvaren manuelt

1. Koble fra eventuelle instrumenter som er koblet til datamaskinen.

Finn instrumentets USB-kabel påCFX Manager Dx-datamaskinen, og koble den fra. Kabelenden
som er tilkoblet instrumentet, trenger ikke kobles fra.

2. Logg på CFX Manager Dx-datamaskinen som administrator.

3. Sett inn CD-en med programvaren på.

4. ÅpneWindows Utforsker, naviger til CD-en, høyreklikk på ikonet for CD-en med programvaren på
og velg Utforsk for å åpne CD-vinduet.

5. Dobbeltklikk på mappen CFX_Manager for å åpne mappen, og dobbeltklikk deretter på setup.exe
for å starte installasjonsveiviseren for programvaren.

6. Følg instruksjonene i veiviseren for å installere programvaren, og klikk deretter på Fullfør.
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Installere driverne på nytt
Slik installerer du instrumentdriverne på nytt

u I startvinduet velger du Tools > Reinstall Instrument Drivers (Verktøy > Installer instrumentdrivere
på nytt).

Merknad: Hvis programvaren har problemer med å kommunisere med et sanntidssystem etter at
du installerer driverne på nytt og kontrollerer USB-tilkoblingen, må du kontakte teknisk støtte hos
Bio-Rad.
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sommedfølger distribueringen.

3. Eventuell sluttbrukerdokumentasjon sommedfølger redistribueringen må inneholde følgende
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